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Chapter 1: Introducing the CSx75 system

1.1 Getting started 
1.1.1 Welcome

Welcome to the CSx75 system range. We hope that you find it a useful addition to our range of products.

The CSx75 system design allows a fully loaded system to be housed in one single metal or plastic enclosure. It 
can be expanded as required with additional modules. Five different panel types are available: the CS175, 
CS275, CS375, CS575 and CS875. In this manual they are known collectively as the CSx75.

This manual describes a CSx75 installation using the CS5500, the menu driven keypad. The CS5500 allows you 
to program the system easily using a menu structure. 

1.1.2 Default country codes
Table 1-1: Default country codes lists the default codes used in each country.

< The brackets contain the additional digits for the 6-digit codes.

1.2 Keypads
1.2.1 CS5500 keypad

The CS5500 LCD keypad allows you to program the CSx75 system using a menu structure.

Table 1-1: Default country codes

Country Country 
code

User code Installer code Download access code

Baltic states 03 1122 1278 12780000

France 02 1122(56) 1278(00) 84800000

Belgium 11 1122(56) 1278(00) 12780000

Czech Republic 20 1122 1278 12780000

Denmark 07 1122(00) 1278(00) 12780000

Finland 28 1122 1278 12780000

France 02 1122(56) 1278(00) 84800000

Germany 04 1122(56) 1278(00) 12780000

Hungary 22 1122 1278 12780000

Ireland 12 1122 1278 12780000

Italy 10 7777(77) 8522(22) 84800000

Netherlands 01 1122(56) 1278(00) 12780000

Norway 05 1122(00) 1278(00) 12780000

Poland 18 1122(56) 1278(00) 84800000

Portugal 21 1122(56) 1278(00) 84800000

Slovak Republic 24 1122 1278 12780000

Spain 09 1122(56) 1278(00) 84800000

Sweden 06 1122(00) 1278(00) 12780000

UK 03 1122 1278 12780000



CS875-575-375-275-175 Installers Manual with CS5500 keypadA.1.2

Power (green)

• On if the system is connected to the mains and the battery is OK.

• Flashes if the system has no battery or a low battery.

• Off if the system is not connected to the mains.

Ready (green)

• On when the system is ready to arm.

• Flashes when the system is ready to force arm.

• Off when the system cannot be armed.

Fire (red)

• On when a fire zone has been activated.

• Flashes when there is a problem with a fire zone.

• Off when all fire zones are operating correctly.

Function keys

• Press F1 to scroll to the start of the LCD message.

• Press F3 to scroll to the end of the LCD message.

In multi-area mode, these keys have specific functions. If you select one or more areas in this mode:

• Press F1 to part arm the set of areas. 

• Press F2 to full arm the set of areas. 

• Press F3 to disarm the set of areas.

You can program these keys to perform a function when not in multi-area mode. 

No

Press No to:

• Cancel a change to the menu selection or 

• Navigate to a higher level in the menu structure or

• Cancel a sequence when entering numeric data.

OK

Press OK to:

• Activate the menu or

• Accept selection changes or 

• Move forward in the menu structure or 

• Complete a sequence when entering numeric data.

OK
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1.2.2 Other LCD and LED keypads
These are the other types of keypads that can be used with the CSx75 system. The LCD keypad can be used to 
program the system, but a menu structure is not provided.

It is recommended that you program the system using the CS550 keypad or the UDx75 upload/download 
software. 

Hash

When editing text and phone numbers:

• Press # F1 to move to the first character or number.

• Press # F3 to move to the last character or number.

• Press #È to delete from the current position to the last character or number. 

Navigation keys

Press the navigation keys to scroll through menu lists and options. 

When in multi-area mode or not in a menu:

• Press Ç to display bypassed zones.

• Press È to display problem zones. 

When editing text and telephone numbers:

• Press Ç to overwrite or insert text. 

• Press È to delete text.
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Chapter 2: Designing the CSx75 system

2.1 System versions
There are five versions of the CSx75. The following table lists the features of each version and some differences 
between them.

Table 2-1: CSx75 versions

CS175 CS275 CS375/575 CS875

Number of wired zones 
on the CSx75 

4 6 8 8

Maximum number of 
zones

8 16 24 (CS375)
48 (CS575)

168

Outputs 3 (2 open collector and 1 
fire reset)

4 on-board (open collector) 4 on-board (2 relay/2 open 
collector)

4 on-board (2 relay/2 open 
collector)

Sounder outputs Internal sounder with built–
in siren driver for the 
internal sounder

Separate on-board 
external and internal 
sounder with built–in siren 
driver for the internal 
sounder

Separate on-board 
external and internal 
sounder with built–in siren 
driver for the internal 
sounder

Separate on-board 
external and internal 
sounder with built–in siren 
driver for the internal 
sounder

Maximum number of 
partitions

1 2 4 8

Report formats Fast Format, Telim, 
Franklin 4+2, SIA, XSIA, 
Siren Tone, 200 baud FSK, 
Voice and Contact ID 
report formats 

Fast Format, Telim, 
Franklin 4+2, SIA, XSIA, 
Siren Tone, 200 baud FSK, 
Voice and Contact ID 
report formats

Fast Format, Telim, 
Franklin 4+2, SIA, XSIA, 
Siren Tone, 200 baud FSK, 
Voice and Contact ID 
report formats

Fast Format, Telim, 
Franklin 4+2, SIA, XSIA, 
Siren Tone, 200 baud FSK, 
Voice and Contact ID 
report formats

Hardware expansion 1 module
Keypads do not count as 
modules on the CS175

3 modules
Keypads do not count as 
modules on the CS275

16 modules (CS375)
32 modules (CS575)
Keypads count as modules 
when on the CS375-575

32 modules
Keypads count as modules 
when on the CS875

Maximum number of 
user codes

8 (4 or 6-digit codes) 40 (4 or 6-digit codes) 66 (6-digit codes) or 99 (4-
digit codes)

66 (6-digit codes) or 99 (4-
digit codes)

Maximum number of 
keypads (up to 8 per 
partition)

8 16 16 32

Support for Proximity 
Reader

No No Yes Yes
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2.2 Parts of the system
Table 2-2: System modules

Part number Part Purpose

CS5500 Keypad module Used to program the system. Other LCD and LED location based 
keypads can also be used.

CS208/CS208H/CS216 Input expander 
module

Expands the number of wired zones by 8 or 16 zones
The wired zone expanders can only be used with the CS375, CS575 
and CS875. You can only expand the CS175 and CS275 by using a 
wireless receiver. 

CS507 Output expander 
module

Expands the number of outputs available on the system.

CS586 Direct connect 
module

Used as: 
1. A direct connect interface between the panel and PC.
2. A storage device, when connected only to the PC. You can also 
read/write from 1 of the 4 locations via the UDx75 software.
3. A storage device, connected only to the panel. You can read/write 
from 1 of the 4 locations on the CSx75.
The CS590 RS232 direct connect cable is used with the CS275-375-
575-875 and is connected directly to the PCB. The CS586 can be 
used on any panel in the range and connected to the 3-wire keypad 
bus.

CS7002 GPRS module Allows events to be reported via a GSM network or a GPRS network. 

CS1700 Door swipe module Proximity card reader/door control module. You can program it to 
control access in any or all areas. 
The CS1700 can only be used with the CS575 and CS875.

CS320 Auxiliary power 
module

Provides additional power for modules attached to a panel.

CS535 Voice module Allows events to be reported using voice messages.
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CS534 Audio (listen-in) 
module

Two-way audio (listen-in) communicator that allows the situation on 
the premises to be monitored.

CS7050 TCP/IP Module Dual microprocessor-controlled Internet/Intranet interface used to 
connect the CSx75 control panel to the OH Network Receiver. 

CS7501 ISDN Module Integrated services digital network dialler that allows digital data to be 
sent over an ISDN line. 

Table 2-3: System equipment

Part number Purpose

AS270/271 Internal sounders

AS500 and AS290/390 External sounders

DB701 + DP721 and DB702 +DP721R Fire detector

Table 2-2: System modules

Part number Part Purpose
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Table 2-4: Wireless Equipment

Part Number 433 MHz 868 MHz Purpose

Wireless Receiver RX8I4CA-pcb
RX16I4CA-pcb
RX48I4CA-pcb

RX8W8CA-pcb 
RX16W8CA-pcb
RX32W8CA-pcb

RF 433 versions provide 
RF capability for 8, 16, or 
48 wireless/RF 
components.

RF868 versions provide 
RF capability for 8 or 16 or 
32 wireless/RF 
components.

Wireless keyfobs RF352I4   (2 button)
RF354I4   (4 button)

RF354W8 (4 button) Arms and disarms the 
system.

Micro multipurpose panic 
button

RF356I4 Not available Used for activating police, 
medical, or auxiliary 
alarms throughout the 
premises. When the panic 
button is pressed, the LED 
mounted under the front 
cover will blink and an 
alarm signal is transmitted.

Wireless water resistant 
medical pendant

RF360I4 Not available Sends an alarm signal with 
one button press to the 
panel.

Wireless fire detector RF572SI4
RF572NSTI4

RF572SW8 Battery powered fire 
detector.
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Wireless door window 
sensor

RF320I4
RF310I4

RF300W8
RF300W8B

Transmits events to the 
control panel via the RF 
receiver.

Wireless shock sensor RF620I4
RF620I4B

Not available Transmits events to the 
control panel via the RF 
receiver.

Wireless glass break 
detector

RF903I4 RF903W8 Transmits events to the 
control panel via the RF 
receiver.

Wireless motion sensor RF425I4 
RF425I4PI

RF425W8
RF425W8PI

Battery powered PIR.

Table 2-4: Wireless Equipment

Part Number 433 MHz 868 MHz Purpose
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Chapter 3: Installation guidelines

3.1 Mains power connection
Use the mains connector terminal for connecting the mains supply. You can use a fixed cable or a flexible mains 
lead to an earthed mains outlet. If fixed wiring is used, insert a dedicated circuit breaker in the power distribution 
network. In all cases, the mains connection must comply with local regulations.

IMPORTANT: Disconnect the mains power before opening the cabinet. To do this:

• Disconnect the AC mains plug from the AC mains wall socket or

• Disconnect the mains with the dedicated circuit breaker.

CAUTION: This unit can be provided with a lead battery inside. Dispose of this battery according to chemical 
waste regulations only.

3.2 Mounting
• Ensure that the unit is mounted on a flat, solid, vertical surface so that the base will not flex or warp when the 

mounting screws/bolts are tightened.

• Leave a 50 mm clearance between equipment enclosures mounted side by side and 25 mm between the 
enclosure and the walkway.

• The battery mounting facility inside the housing is only useful for steady state use of the control panel. 
Remove the battery for transport of the control panel.

• Take care that wire terminals are isolated. Use tie wraps to prevent contact with any other wires or circuits in 
case wires break.

3.3 Cabling
3.3.1 Shielded and unshielded cable

• In a clean environment, use unshielded cable. This provides the maximum cable length.

• In a harsh environment, use shielded cable. The maximum cable length is reduced as part of the signal will go 
into the shield. The amount of length lost depends on the type and quality of the shielded cable.

3.3.2 Twisted and untwisted cable
• You can use either twisted or untwisted cable for the bus. Since the bus only has 3 wires, twisted pair cable is 

not necessary.

3.4 Wiring guidelines
The CSx75 control panel has been designed, assembled and tested to meet the requirements of current relevant 
standards related to safety, emission and immunity with respect to environmental electrical and electromagnetic 
interference. Only a qualified electrician or other suitable trained and qualified person should attempt to wire this 
system to the mains or to the public telephone network.

1. Ensure that there is a good earth for the alarm system. A good earth is essential for effective resistance to 
electrical interference. Do not forget to provide a (network) earth for the telephone dialler.

2. Maintain a good separation between low voltage and mains supply cables. Use separate points of cable entry 
to the control panel cabinet.

• If the entry cable holes are used to route wiring into the control panel, always use a proper pipe fitting system 
by means of an appropriate conduit and junction box. For this purpose, use only materials of suitable 
flammability class (HB or better).

• Avoid cable ducts and cableways that contain mains power cables. This is particularly important when such 
ducts contain cables supplying electric motors, fluorescent lights or 3-phase power. If this is not possible, 
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shielded cable should be used and the cable should be connected to a GND terminal at the control panel end 
only.

3. The remote bus cable is used for communication between the control panel and the keypads/expanders. The 
greatest care should be taken when installing this cable. Never split it into separate cables. Do not use cables 
with wires that are used for telephone connections or for switching, for example, flashing lights, sirens or 
relays.

4. For mains power connection, use the mains connector terminal either through a permanent wiring or a 
flexible mains cable to an earthed mains outlet. Always use cable ties to fix the mains cable, at the dedicated 
fixing point provided near the mains terminal connector.

• In case of permanent fixed wiring, insert an easily accessible, dedicated bipolar circuit breaker in the power 
distribution network.

• Never attempt to solder a mains connection wire’s end where they will be wired to the terminal connectors.

5. Avoid loops of wire inside the control panel and route cables so they do not lie on top or underneath the 
printed circuit board. The use of cable ties is recommended and improves neatness within the box.

6. The battery used with this unit, must be made of materials of suitable flammability class (HB or better).

7. Any circuit connected either directly to the on-board relay’s contact or to the external relay’s contact 
through the on-board electronic output, must be of SELV (Safety extra-low voltage) operating circuit.

• The mains switching relay must not be fitted inside the control panel cabinet.

• Always place a suppression diode (for example, a 1N4001) across the relay coil.

• Use only a relay with good insulation between the contacts and the coil.

8. The minimum clearance between equipment closures is 50 mm between equipment vents.

9. Only use units in a clean environment and not in humid air.

3.5 Defaulting the panel
IMPORTANT: Before installing and programming the system, default the panel to ensure that you have the 
correct country defaults according to your local regulations.

3.6 Using the DIP switch diagrams
• When the DIP switch is set to the ON position, the switch is 

at the top. This is illustrated in the DIP switch diagrams as
  ON

• When the DIP switch is set to OFF, the switch is at the 
bottom. This is illustrated in the DIP switch diagram as  

 OFF

• In this example the first, third and sixth DIP switches are ON 
and the second, fourth and fifth DIP switches are OFF.

• The DIP switch diagram demonstrates this as shown.
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Chapter 4: Installing a basic system

4.1 Wiring zones
4.1.1 General

The control unit inputs are set up as standard EOL (4K7) freely programmable zones. However, by programming 
the zones as dual loop, all control unit zone inputs can be programmed to give alarm and tamper indication on the 
same zone.

4.1.2 Dual wiring
One zone includes both alarm and tamper wiring.

The alarm devices are wired in series and a 4K7 resistor is fitted in parallel across the closed circuit contacts.

The tamper contacts are wired in series with a 4K7 EOL resistor.

• All devices closed - loop resistance is 4K7.

• Tamper device open - loop is an open or short circuit.

• Alarm device open - loop resistance is 9K4 (i.e. EOL resistor PLUS parallel resistor).

4.1.3 Single wiring
Two zones are required, one zone for alarm and one zone for tamper. The tamper contacts are wired in series with 
a 4K7 EOL resistor.

Information on programming the zones can be found in chapter B-2 Programming the control panel.

4.2 Installing the control unit
The control panel is available in three separate housings. The method of installation and the positioning of 
expander modules vary depending on the housing used.

1 Zone terminal 3 Alarm contact

2 Sensor 4 Tamper contact

1 Zone terminal 3 Alarm contact

2 Sensor 4 Tamper contact

4K7

4K7
E.O.L.

Z1

COM

Z2

1

2 2 2

3

4 4 4

3 3

Z1

COM

Z2

1

2 2 2

3 33

4 44 4K7
E.O.L.

4K7
E.O.L.
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The instructions below show the details for installing a basic system. For details on installing the CS7050, 
CS7501 and CS7002, see the relevant chapters.

<The housing/enclosures covered in this manual are not suitable for every CSx75 model and may not be 
available in your country. Contact your local supplier to get more information on availability.

4.2.1 CS575M/CS875M (large metal housing)
This large metal housing can be used with the CS375, CS575 and CS875. 

1. Open the box. 

2. Wire the panel.

3. If you are using a CS534 listen-in module, a CS535 voice module and a CS7002 GPRS module, complete 
the following steps:

- Attach a ribbon cable to the CS7002 GPRS module.

- Attach a ribbon cable to the CS534 listen-in module.

- Connect the CS7002 GPRS module and CS535 voice module with the ribbon cable. 

- Connect the CS534 listen-in module and CS535 voice module with the ribbon cable. 

- Add the pillars for the CS7002 GPRS module to the board.

- Attach the CS7002 GPRS module to the main board via the jumpers and pillars.

- Place the CS534 listen-in module and CS535 voice module on top of the CS7002 GPRS module in the 
box.

4. If you are using a CS534 and a CS535 without a CS7002 complete the following steps:

- Attach the ribbon cable to the CS534 listen-in module.

- Connect the CS534 listen-in module and CS535 voice module with the ribbon cable. 

- Add the pillars for the CS535 voice module to the board.

- Attach the CS535 voice module to the board via the jumpers and pillars.

CS375/575/875
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- Attach the pillars for the CS534 listen-in module to the box.

- Insert the CS534 listen-in module in the box. 

5. Add the pillars for the CS507 output module or CS208 / CS216 input expander or CS7002 GSM module to 
the box.

6. Mount the CS507 output module or CS208 / CS216 input expander or CS7002 GSM module.

7. Mount the pillars for a CS208 / CS216 input expander on the CS575/875 board.

8. Mount the CS208 / CS216 input expander on the CS575/875 board.

9. Wire the keypad bus for all modules. Check the relevant module chapter for wiring information. For 
information on mounting the CS7501 ISDN dialler, see chapter B-16 Setting up the CS7501.

10. Connect the battery and power up the panel.

CS7002

CS507 CS216

CS216 CS216

CS507

CS216

CS375/575/875

)

a

b

c c c

d

eb b

a a

) )
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4.2.2 CS275/CS375/CS575/CS875 (polycarbonate housing) 
This polycarbonate housing can be used with the CS275, CS375, CS575and CS875. 

1. Unscrew the holding screw in the polycarbonate housing.

2. Open the box. 

3. Lift off the lid of the box.

4. Flip up the PCB mounting tray.

5. If you are using a CS534 listen-in module, a CS535 voice module and a CS7002 GPRS module, complete 
the following steps:

- Attach the ribbon cable to the CS7002 GPRS module.

- Attach the ribbon cable to the CS534 listen-in module.

- Remove the sticky pads and insert the pillars for the CS7002 GPRS module in the box. 

- Connect the CS7002 GPRS module to the main board. 

- Flip down the PCB mounting tray.

- Attach the pillars for the CS535 voice module to the board.

- Attach the CS535 voice module to the board via the jumpers and pillars.

- Connect the CS7002 GPRS module and CS535 voice module with the ribbon cable.

- Connect the CS535 voice module and CS534 listen-in module with the ribbon cable.

6. If you are using a CS534 and a CS535 without a CS7002 complete the following steps:

- Attach the ribbon cable to the CS534 listen-in module.

- Remove the sticky pads and insert the pillars for the CS534 listen-in module in the box. 

CS275/375/575/875

CS534
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- Connect the CS534 listen-in module to the box. 

- Flip down the PCB mounting tray.

- Attach the pillars for the CS535 voice module to the board.

- Attach the CS535 voice module to the board via the jumpers and pillars.

- Connect the CS534 listen-in module and CS535 voice module with the ribbon cable.

7. Attach the pillars for the CS208 / CS216 input expander or CS507 output module to the board.

8. Mount the CS208 / CS216 input expander or CS507 output module on the board.

9. Drill 0.3 mm holes for the card guides in the box.

10. Place the card guide (NX-CA-SL) in the box.

CS275/375/575/875

CS275/375/575/875 CS275/375/575/875

CS275/375/575/875

CS275/375/575/875

CS534

CS535

CS535

CS507CS216

CS535

CS216

CS507
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11. Screw in the card guides.

12. Use the card guides to mount up to 3 further pre-wired modules. Check the relevant module chapter for 
wiring information. For information on mounting the CS7501 ISDN dialler, chapter B-16 Setting up the 
CS7501.

13. Connect the control panel battery leads to the module.

14. Mount the RF receiver in the lid of the box. This facility is not available in every country.

15. If you are installing an RX8I4, RX16I4 or RX48I4 CA series receiver, you must insert the antennae through 
the lid.

16. Wire the keypad bus for any other modules that are not in the card guides. 

17. Connect the battery and power up the panel.

4.2.3 CS175M/CS275M/CS375M/CS575SM (small metal housing)
This is a small metal housing that can be used with the CS175, CS275, CS375 and CS575.

1. Open the box.

2. Wire the panel.

3. If you are using a CS534 listen-in module, a CS535 voice module and a CS7002 GPRS module, complete 
the following steps:

- Attach the pillars for the CS7002 GPRS module to the main board.

CS175/275/375/575 CS175/275/375/575

CS175/275/375/575CS175/275/375/575

CS535
CS535

CS534

CS534
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- Mount the CS535 voice module to the extension gate (jumper).

- Attach a ribbon cable to the CS534 listen-in module.

- Connect the CS534 listen-in module and CS535 voice module with the ribbon cable. 

- Mount the CS7002 GPRS module on the pillars to the main board. 

4. If you are using a CS534 and a CS535 without a CS7002 complete the following steps:

- Attach the pillars for the CS534 listen-in module or CS535 voice module to the main board.

- Mount the CS534 listen-in module or CS535 voice module to the extension gate (jumper).

- Mount the CS534 listen-in module or CS535 voice module on the pillars to the main board. 

5. Add the pillars for the CS208 / CS216 input expander or CS507 output expander to the main board.

6. Mount the CS208 / CS216 input expander or CS507 output expander.

7. Wire the keypad bus for all modules. Check the relevant module chapter for wiring information. For 
information on mounting the CS7501 ISDN dialler, see chapter B-16 Setting up the CS7501.

8. Connect the battery and power up the panel.

CS216 CS507

CS507CS216

CS175/275/375/575

CS175/275/375/575CS175/275/375/575

CS575/875
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4.3 Installing the keypad
               

1. Remove the keypad door.

2. Remove the bottom screw if fitted.

3. Place a short length of the shaft of the screwdriver in the hollow of the door hinge.

4. Twist the screwdriver carefully. 

5. The two parts of the keypad should separate. Lift up the lid.

6. Mount the keypad on the wall using the mounting holes C.

7. Use the wire trunking B or wire cutout hole D to place the wires in the keypad.

8. Re-attach the base and lid.

9. Attach the pry-off tamper screw if desired. 

4.3.1 Wiring the keypad
The keypad should be wired to the control unit as follows.

CSx75 CS5500

Aux +

COM

Data 13.8V

0101
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4.3.2 Wiring several keypads together
The total cable length of wiring is restricted to 800 m. The chart below shows the wire gauge that should be used. 
These numbers are for one keypad at the end of the wire. When connecting more than one keypad to the end of the 
wire, a higher gauge wire is required.

4.3.2.1 Multidrop network
In a multidrop network, keypads are chained together. Each keypad is connected in parallel to the one before it. 

4.3.2.2 Star network 
In a star network, each keypad is wired back separately to the control unit terminals.

Table 4-1: Keypad bus length

Length Connected to CSx75

Length in Metres Wire mm²

110 0.50

200 0.75

333 1.00

500 1.50

800 2.50
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4.3.2.3 Star and multidrop network
You can create a combination of a star and multidrop network. The following diagram shows how four keypads 
can be connected using both methods.



CS875-575-375-275-175 Installers Manual with CS5500 keypadA.4.11

4.4 Wiring sounders
4.4.1 Wiring a sounder with EOL protection

Any zone can be used. It should be programmed as tamper and single EOL. 

4.4.1.1 AS500

" Tn all cases, select negative hold-off on the sounder.

1 Beacon - hold off 5 Tamper 9 Piezo

2 Siren - hold off 6 Tamper A Piezo

3 +13.8 V 7 Beacon B Piezo

4 GND 8 Beacon
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4.4.1.2 AS271

" A resistor should be added between the COM and the Ext on the panel PCB. This resistor prevents the 
panel being constantly in a trouble condition. Both the internal and external sirens are supervised.

" This wiring configuration for the AS271 allows the beacon to follow the internal sounder.

1 Tamper 4 0 V speaker

2 Tamper 5 0 V beacon (AS271 only)

3 +13.8 V

CSX75

AS271
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AU
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4.4.1.3 AS290/390

" Cut jumpers 5 and 7 for negative hold-off on the sounder.

Information on programming the sounders can be found in chapter B-2 Programming the control panel.

4.5 Wiring fire detectors
In a 4-wire configuration, you can connect as many fire detectors, as long as you do not exceed the AUX power 
capacity of the panel. 

In a 2-wire configuration, you can connect a maximum of three fire detectors on the same loop.

1 Piezo 4 Beacon 7 GND

2 Piezo 5 Tamper 8 +13.8 V

3 Beacon 6 Tamper 9 Siren - hold off

A Beacon - hold off
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4.5.1 4-wire fire detector (CS275-375-575-875)

4.5.2 2-wire fire detector (CS275-375-575-875)

" A  fire alarm is activated as an alarm on zone 8 for the CS375-575-875 and as an alarm on zone 7 on the 
CS275. The fire detector power is connected to Aux and Output. 

If you are using a 2-wire fire detector you must change the menu option for 2-wire fire detector to On.

The CS175 does not support a 2-wire fire detector. A fire alarm activates the zone connected to the 4-wire fire 
detector.

1 + Line in 4 NC (normally closed)

2 + Line out 5 COM

3 -  Line 6 NO (normally open)

1 + Line in

2 + Line out

3 -  Line 

CS275

CS375

CS575

CS875

DB702 +DB721R DB702 +DB721R

COM

Z4

AUX+

COM

OUT4

1 1

2 2

3 3

4 4

5 5

6
6

CS275

CS375
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CS875
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AUX+AUX+

COMCOM

OUT4OUT4

1 1

2 2

3 3
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4.5.3 4-wire fire detector (CS175)

If you are using a CS175, you must program output 3 for the fire detector. 

1. Select Installer Menu>Control Panel>Outputs>Prog Outputs>Output 3>Event>Alarms>Fire Reset. 

2. Make sure that the option to follow the event is 0. To do this, select Installer Menu>Control 
Panel>Outputs>Prog Outputs>Output 3>Time and set the time to 0.

1 + Line in 4 NC (normally closed)

2 + Line out 5 COM

3 -  Line 6 NO (normally open)

CS175

DB702 +DB721R DB702 +DB721R

COM

Z1

AUX+

COM

SMOKE

1 1

2 2

3 3

4 4

5 5

6
6
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4.6 Wiring the outputs

Information on programming the outputs can be found in chapter B-2 Programming the control panel.

1 1A rated contacts. Relays are powered and switched from the panel. No external power is needed to switch the relays.

2 Digital outputs limited to 40 mA.

1
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2
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4.7 Control unit wiring diagrams
4.7.1  CS175

4.7.1.1 Inputs and outputs

1 Zones 1-4 6 External sounder B Serial expansion

2 Box tamper input 7 Keypad bus C Phone line connector

3 Fire detector reset output 8 Additional keypad bus connection D Phone line communication LED

4 Open collector 2 9 Lid tamper

5 Open collector 1 A Bus supervision LED 

DATA Communication/Expander data (0101) (including keypad) COM Ground

AUX + Communication/Expander power (including keypad) TAMPER Tamper loop

COM Communication/Expander ground (including keypad) Z1 Zone 1

EXT External bell return COM Ground

COM Ground Z2 Zone 2

OUT 1 Output 1 Z3 Zone 3

OUT 2 Output 2 COM Ground

SMOKE Fire detector reset output Z4 Zone 4

AUX + Power
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4.7.2  CS275

4.7.2.1  Inputs and outputs

1 Zones 1-6 7 Open collector 1 C Serial expansion

2 Lid tamper 8 External sounder D Bus supervision LED 

3 Box tamper input 9 Internal sounder E Full expansion port

4 Open collector 4 (2 wire smoke) A Keypad bus F Phone line connector

5 Open collector 3 B Additional keypad bus connection G Phone line communication LED 3

6 Open collector 2 C Serial expansion

DATA Communication/Expander data (0101) (including keypad) OUT 4 Output 4
AUX + Communication/Expander power (including keypad) TAMPER Tamper loop
COM Communication/Expander ground (including keypad) Z1 Zone 1
INT Internal bell return COM Ground
COM Ground Z2 Zone 2
EXT External bell return Z3 Zone 3
OUT1 Output 1 COM Ground
AUX + Power Z4 Zone 4
OUT 2 Output 2 Z5 Zone 5
OUT 3 Output 3 COM Ground
AUX + Power Z6 Zone 6
COM Ground
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4.7.3 CS375, CS575 and CS875

" *Always use in parallel. Only one or the other can be used.

1 Zones 1-8 7 Relay 1 D Bus supervision LED 

2 Lid tamper * 8 External sounder E Full expansion port

3 Box tamper input * 9 Internal sounder F Phone line connector

4 Open collector 4 (2 wire smoke) A Keypad bus G Phone line communication LED 

5 Relay 3 B Additional keypad bus connection

6  Open collector 2 C Serial expansion
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4.7.3.1 Inputs and outputs

DATA Communication/Expander data (0101) (including keypad)
AUX + Communication/Expander power (including keypad)
COM Communication/Expander ground (including keypad)
INT Internal bell power
COM Ground
EXT External bell return
R1NC Relay 1 (normally closed)
R1NO Relay 1 (normally open)
R1C Relay 1 (ground) 
AUX + Power
OUT 2 Output 2
COM Ground
R3NC Relay 3 (normally closed)
R3NO Relay 3 (normally open)
R3C Relay 3 (ground)
AUX + Power
COM Ground
OUT 4 Output 4
TAMPER Tamper loop
Z1 Zone 1
COM Ground
Z2 Zone 2
Z3 Zone 3
COM Ground
Z4 Zone 4
Z5 Zone 5
COM Ground
Z6 Zone 6
Z7 Zone 7
COM Ground
Z8 Zone 8
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Chapter 5: Programming the system

5.1 Powering up the system
When the CS5500 if powered up for the first time, the language, keypad defaults, partition and keypad must be 
set. These options must also be set each time a keypad is defaulted. 

• The language option sets the first language of the keypad. 

• The keypad defaults option sets the country specific keypad defaults. It does not default the keypad. 

• The partition and keypad options set the keypad address. 

Use the navigation keys to scroll between the different options and press OK to select an option. See Navigating 
the menus for more information.

5.2 Entering programming mode
Your installer code allows you to program the system through the installer menu. There are two levels in the 
installer menu. The light menu contains the most important options and the advanced menu contains additional 
options. The system cannot be armed while in programming mode on the current keypad or another keypad.

1. Press OK at the system prompt and enter your installer code. For a list of default codes, see chapter A-1 
Introducing the CSx75 system.

2. Use the  keys to navigate the menu. The full menu map can be found in the Menu Structure included in 
your language kit. The light menu is in green text and the advanced menu is in black text.

3. Select OK to select an option or use the numerical/character keys to edit the existing option.

< 'To switch to 'Advanced menu', navigate to Commands>Advanced and select Enabled. The keypad displays 
the advanced menu until this option is disabled.

5.2.1 Changing the user interface language

1. Press OK at the system prompt.

2. Press OK again to display the system prompt in a different language.

3. Press OK until you find the language you require.

4. Continue using the keypad as normal.

For more information on setting languages, see chapter B-3 Programming the current keypads.

5.3 Navigating the menus
• Press the  keys to scroll through menu lists and options. 

• Press #  to move to the same menu item for the previous option. For example, if you are in a submenu for 
zone 2, press #  to move to the same submenu for zone 1. 

• Press #  to move to the same menu item for the next option. For example, if you are in a submenu for zone 
2, press #  to move to the same submenu for zone 3.

< The keypad may timeout from the menu system and return to the default display.

5.3.1 Command menu
You can access a limited number of menu options without entering your installer code. This opens the command 
menu. 

1. Press OK at the system prompt.

2. Press the  keys to enter and navigate the command menu.
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5.4 Selecting a menu option 
• Press OK to select a menu option and move forward in the menu structure. 

• Press NO to reject a menu option and move backwards in the menu structure. 

• Press F1 to move through the second line of the LCD display, one word at a time, from right to left. 

• Press F3 to move through the second line of the LCD display, one word at a time, from left to right. 

5.5 Changing a menu option
The CSx75 has several editors that you can use to change the value of certain programmable menu options. You 
can change selection list entries, binary entries, phone numbers and text. This section describes how to change 
selection list entries, binary entries, numeric entries and phone numbers. For information on changing text, see 
Editing text. 

5.5.1 Changing selection list entries

1. Navigate with the  keys to the relevant menu option and press OK. 

2. The current value for the menu option is displayed, for example, Enabled. 

3. Press the  keys to change the value, for example, change Enabled to Disabled. 

4. Press OK to accept the change. 

- If the new value is valid, the keypad beeps once to confirm the change and returns to the menu option. 

- If the new value is invalid, the keypad beeps three times to reject the change and returns to the menu 
option.

5. Press NO to cancel the change and return to the menu option. 

5.5.2 Changing binary entries

1. Navigate with the  keys to the relevant menu option and press OK. 

2. The current value for the menu option is displayed, for example, 1 2 3 - - - - 8 means that 1, 2, 3 and 8 are on 
(included) while 4, 5, 6 and 7 are off (excluded). 

3. Press the corresponding numerical key to change a value, for example, press 1 to change the state of 1 to off 
and press 4 to change the state of 4 to on. The display changes to - 2 3 4 - - - 8. 

4. Press OK to accept the changes. 

- If the new values are valid, the keypad beeps once to confirm the change and returns to the menu option.

- If the new value is invalid, the keypad beeps three times to reject the change and returns to the menu 
option.

5. Press NO to cancel the changes and return to the menu option.

5.5.3 Changing numeric entries

1. Navigate with the  keys to the relevant menu option and press OK. 

2. The current value for the menu option is displayed, for example, 55.

3. Do one of the following:

- Press a number key to clear the current value and display the value of the key pressed.

- Press  to increase the current value by one.
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- Press  to decrease the current value by one.

- Press ## to clear the current value to 0.

4. Press the number keys to enter the value. 

5. Press OK to accept the changes.

- If the new value is valid, the keypad beeps once to confirm the change and returns to the menu option.

- If the new value is invalid, the keypad beeps three times to reject the change and returns to the menu 
option.

6. Press NO to cancel the changes and return to the menu option.

5.5.4 Changing phone numbers and phone prefixes

1. Navigate with the  keys to the relevant menu option and press OK. 

2. The current value for the menu option is displayed, for example, 4567999.

3. Do one of the following:

- Press  to toggle between insert mode and overwrite mode (insert mode allows you to insert new 
numbers and overwrite mode allows you to overwrite existing numbers).

- Press  to delete the number at the cursor position.

- Press #  to delete all the numbers from the number at the cursor position to the end of the string.

4. Do one of the following:

- Press the keys 0 to 9 to insert new numbers.

- Press #0 to insert G.

- Press #1 to insert a star.

- Press #2 to insert #.

- Press #3 to insert a four-second delay when programming numbers on the control panel.

- Press #3 to insert + when programming numbers on the CS7002 GPRS module. 

- Press #4 to insert P (this enables pulse dialing). 

5. Press OK to accept the changes.

- If the new number is valid, the keypad beeps once to confirm the change and returns to the menu option.

- If the new number is invalid, the keypad beeps three times to reject the change and returns to the menu 
option.

6. Press NO to cancel the changes and return to the menu option.

5.6 Exiting the menu system
1. Press ## to display the OK to Exit prompt.

2. Press OK at this prompt to exit the menu system. 

5.7 Editing text
5.7.1 Overview

The CSx75 has a text editor that includes a word library. You can use this editor to change the text of certain 
programmable text options.
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1. Navigate with the  keys to the relevant menu option and press OK. 

2. Press OK to select the language you want to edit.

3. The current text for the menu option is displayed, for example, Zone 2.

4. Do one of the following:

• Press  to toggle between insert mode and overwrite mode (insert mode allows you to insert new text and 
overwrite mode allows you to overwrite existing text).

• Press  to delete the character at the cursor position.

• Press #  to delete all the characters from the character at the cursor position to the end of the string.

5. Press the keys 0 to 9 to insert new characters. Each key cycles through lower case and then upper case 
characters.

6. Press OK to accept the changes. The keypad beeps once to confirm the change and returns to the menu 
option.

7. Press NO to cancel the changes and return to the menu option.

< A flashing cursor highlights the character you are editing. Press F2 to toggle flashing on the current word.

5.7.2 Example
To change a zone name from Zone 2 to Upstairs: 

1. Navigate to Zone 2 and press OK.

2. Press #F1 to go to the start of the zone name.

3. Press #  to delete all the characters.

4. Press 8 four times to enter the upper case letter ‘U’.

5. Press 7 once to enter the lower case letter ‘p’. Continue until you have entered the new zone name.

6. Press OK to save your changes. 

< Each character key cycles through lower and upper case letters and language specific characters. 

5.7.3 Word library
The word library is a predefined collection of words that speeds up text editing. As you type a character, the 
keypad automatically displays a matching word. The word library is enabled by default. For a complete list of 
words in the word library, see chapter C-1 Appendix 6: Word library words.

• To accept the word, press F3. The cursor moves to the end of the new word and you can continue to enter 
text. 

• To accept a shortened version of the word, press F3 to accept the word. Then move the cursor to the 
unnecessary characters and press  to delete them. 

• To reject the word, continue entering text as normal.

• Press the  keys to scroll through the list of word library words. 

• To disable the word library:

1. Navigate with the  keys to Word Library and press OK. 

2. The current state of the word library is displayed. In this case, it is enabled. 

3. Use the  keys to change the state to disabled and press OK.
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4. The keypad beeps once to accept the change and returns to Word Library.   

5.7.4 Installer message
Up to four messages can be displayed on the LCD when the keypad is idle or when it times out from a menu. If 
you enable more than one message, the messages are shown in a continuous cycle. 

• Installer message

• Date and time

• Service required

• System ready/not ready

To enable the installer message:

1. Navigate with the  keys to This Keypad and press OK.

2. Select Keypad Features>Display and press OK. 

3. Scroll to Custom Message and press OK. The current status of the installer message is displayed. In this case, 
it is disabled.

4. Use the  keys to change the status to enabled and press OK. 

5. The keypad beeps once to accept the change and returns to Custom Message.
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Chapter 6: Setting up a communicator 

6.1 Reporting
The CSx75 supports different modes of reporting events to multiple central stations. There are six phone 
numbers - each phone number has it own account code, protocol and events. The configured prefix is common to 
all six phone numbers. If a four-second delay is specified in the prefix, the panel does not look for a dial tone, but 
performs blind-dialling. The following scenarios are examples of how to set different modes of reporting.

6.1.1 Reporting to one phone number 
The control panel reports events to one central station only. You specify settings for phone number 1. Events for 
phone number 1 are enabled by default.

< The characters B, C, D, E, F can be used in control panel account codes. The letter ‘A’ cannot be used as 
part of the code as it is a termination digit.

6.1.2 Backup reporting 
Backup reporting configures the control panel to report to two or more central stations. The first phone number 
belongs to the main central station and all other phone numbers belong to the backup central stations. Events are 
reported to the first number but, if the panel cannot reach this number, it dials the backup number(s). The control 
panel makes two calls to each number in sequence. It performs the sequence for the number of times specified in 
ARC Dial Attempts or until it receives a kiss off. The same account code is used to report to all numbers. Events 
for phone number 1 are enabled by default and events for phone numbers 2 - 6 are disabled by default. If phone 
number 1 and phone number 2 are programmed, the default sequence is 1,1 2,2 1,1,2,2 for a total of eight calls to 
each number.

Level 1 Level 2 Value State

Phone Number Phone Number 1 123456

Phone Number 2

Account Code Phone Number 1 BE5566

Phone Number 2

Protocol Phone Number 1 SIA 

Phone Number 2

Events Phone Number 1 – Alarms Enabled

Phone Number 1 – Alarm Restores Enabled

Phone Number 1 – Tampers and Restores Enabled

Phone Number 2 – Alarms

Phone Number 2 – Alarm Restores

Phone Number 2 – Tampers and Restores

Level 1 Level 2 Value State

Phone Number Phone Number 1 123456

Phone Number 2 456789

Account Code Phone Number 1 BE5566

Phone Number 2 445566

Protocol Phone Number 1 SIA

Phone Number 2 SIA
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6.1.3 Dual reporting
Dual reporting configures the control panel to report to two different central stations. Events must be reported to 
both phone numbers. The control panel dials the first number twice. If it cannot reach this number, it dials the 
second number twice. It performs this sequence for the number of times specified in ARC Dial Attempts or until it 
reports the events to both numbers. The same account code is used to report to both numbers. Events for phone 
number 1 are enabled by default and events for phone number 2 are disabled by default. 

6.1.4 Split reporting
Split reporting configures the control panel to report to two different central stations. Some events must be 
reported to phone number 1 and others to phone number 2. The control panel dials the first number twice. If it 
cannot reach this number, it dials the second number twice. It performs this sequence for the number of times 
specified in ARC Dial Attempts or until it reports the relevant event to each number. The same account code is 
used to report to both numbers. Events for phone number 1 are enabled by default and events for phone numbers 
2 are disabled by default. 

Events Phone Number 1 – Alarms Enabled

Phone Number 1 – Alarm Restores Enabled

Phone Number 1 – Tampers and Restores Enabled

Phone Number 2 – Alarms Disabled

Phone Number 2 – Alarm Restores Disabled

Phone Number 2 – Tampers and Restores Disabled

Level 1 Level 2 Value State

Phone Number Phone Number 1 123456

Phone Number 2 456789

Account Code Phone Number 1 BE5566

Phone Number 2 445566

Protocol Phone Number 1 SIA

Phone Number 2 SIA

Events Phone Number 1 – Alarms Enabled

Phone Number 1 – Alarm Restores Enabled

Phone Number 1 – Tampers and Restores Enabled

Phone Number 2 – Alarms Enabled

Phone Number 2 – Alarm Restores Enabled

Phone Number 2 – Tampers and Restores Enabled

Level 1 Level 2 Value State

Phone Number Phone Number 1 123456

Phone Number 2 456789

Account Code Phone Number 1 BE5566

Phone Number 2 445566

Protocol Phone Number 1 SIA

Phone Number 2 SIA

Level 1 Level 2 Value State
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Events Phone Number 1 – Alarms Enabled

Phone Number 1 – Alarm Restores Enabled

Phone Number 1 – Tampers Disabled

Phone Number 2 – Alarms Disabled

Phone Number 2 – Alarm Restores Disabled

Phone Number 2 – Tampers and Restores Enabled

Level 1 Level 2 Value State



Section B
Installing and programming the 
modules

1 Enrolling modules ...........................................................................................................................................................B-1-1

2 Programming the control panel ..............................................................................................................................B-2-1

3 Programming the current keypads .......................................................................................................................B-3-1

4 Programming the other keypads............................................................................................................................B-4-1

5 Setting up the RF receivers ........................................................................................................................................B-5-1

6 Setting up the CS208H / CS208 / CS216..............................................................................................................B-6-1

7 Setting up the CS507.....................................................................................................................................................B-7-1

8 Setting up the CS586.....................................................................................................................................................B-8-1

9 Setting up the CS534.....................................................................................................................................................B-9-1

10 Setting up the CS320...............................................................................................................................................B-10-1

11 Setting up the CS535...............................................................................................................................................B-11-1

12 Setting up the CS1700 ............................................................................................................................................B-12-1

13 Setting up the CS7002 ............................................................................................................................................B-13-1

14 Reserved ......................................................................................................................................................................B-14-1

15 Setting up the CS7050 ............................................................................................................................................B-15-1

16 Setting up the CS7501 ............................................................................................................................................B-16-1

17 Reading the event log.............................................................................................................................................B-17-1

18 Programming with the UDx75 software ........................................................................................................B-18-1



CS875-575-375-275-175 Installers Manual with CS5500 keypad B.1.1

Chapter 1: Enrolling modules

To enroll and default the system modules, you must enable the advanced menu. Select Commands>Advanced 
Menu>Enabled and press OK. 

1.1 Enrolling the system modules
When you select the enrol modules process, new modules are enrolled on both the control panel and the keypad. 
The keypad must enrol modules in order to display the relevant menu options.

1. Press OK at the system prompt and enter your installer code. 

2. Navigate with the  keys to Enrol Modules>Enrol and press OK. 

3. The keypad starts enrolling the modules. The Enrolling message is displayed while enrolment is taking 
place (approximately 12 seconds). When the modules have been enrolled, a beep sounds and the message 
disappears. 

4. When the modules have been enrolled, the keypad returns to Enrol.

5. Verify the enrolled modules. Navigate with the  keys to Commands and press OK.

6. Scroll to Event Log and press OK. When the control panel enrols a module, it adds an enrol event to the 
event log. This event contains the module number. Scroll through the event log to verify that each module 
has been enrolled.

< The modules are enrolled each time you leave programming mode. In this case, the Enrolling message is 
displayed but no beep sounds.

1.2 Defaulting the modules
Each module can be defaulted. It is recommended that you default each module before modifying its settings. 

1. Navigate with the  keys to Default Settings in the relevant module menu and press OK. In this case, 
select Control Panel>Default Settings to restore the default control panel settings.

2. A confirmation message is displayed. Press OK to accept the default settings.

3. The keypad sounder beeps once to confirm the reset.

1.3 Glossary

Location Term Definition

1 Enrol Modules A menu option that activates the process by which the control makes an internal list of all 
keypads and modules connected to the system.

1.1 Enrol A menu entry that groups enrolled module information.

1.2 Number of Modules A menu option that displays the total number of installed modules.

Enrol
Number of Modules

1.1

1.2
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Chapter 2: Programming the control panel

2.1 Overview
You must enroll and default the control panel before you begin to program the system. For more information on 
enrolling and defaulting, see chapter B-1 Enrolling modules.

2.2 Programming inputs

An input is any zone that is set up on the system. A zone is an area guarded by a group of one or more detection 
devices. It represents a single input in the system.

A zone may reside in any combination of partitions. A zone that resides in more than one partition becomes a 
common zone and is reported to its lowest partition number. A common zone is armed only when all the partitions 
that it belongs to are armed. It is immediately disarmed when one of the partitions it belongs to is disarmed.

The control panel can have a maximum of eight on-board inputs. RF receivers and CS208H / CS208 / CS216 
input expanders can be used to increase the number of inputs to a maximum total of 168 depending on the model 
of the control panel. For more information on the maximum number of zones per model, see chapter A-2 
Designing the CSx75 system. For information on RF receivers, see chapter B-5 Setting up the RF receivers. For 
information on CS208H / CS208 / CS216 input expanders, see chapter B-2 Programming the control panel. To 
program on-board inputs, select Installer Menu>Control Panel>Inputs.

*Enabled according to 
Keyswitch zone option

Zone Type Name

End of Line Resistor
Loop Response
Double Knock
Swinger Shutdown
Bypassable
Force Armable
Group Bypass
Zone Inactivity Monitor
Pulsed Keyswitch*
No Keypad Display** 

Attributes 

Fire
24-hour
Keyswitch
Follower/Access*
Delay 1
Delay 2
Interior
Entry Guard
Final Set Door
Roller Shutter
B-Alarm Trip
Trouble

Local Only
Restore Reporting*
Dialler Delay
Listen-in

Copy Zone Type

(1) Zone 1 Zone Type

Zone Name <Language 1>

Partitions
Copy Zone

Input Type(1) Burglary

2.1.1.1.1

2.1.1.1.2

2.1.1.1.3

2.1.1.1.2.1

2.1.3.1.1 2.1.3.1.1.1

2.1.3.1.2

2.1.3.1.3

2.1.3.1.1.2

2.1.3.1.1.3

2.1.3.1.1.4

2.1.3.1.1.5

2.1.3.1.1.6

2.1.3.1.1.7

2.1.3.1.1.8
2.1.3.1.1.9

2.1.3.1.1.10

2.1.3.1.1.11

2.1.3.1.1.12

2.1.3.1.3.10

2.1.3.1.6

2.1.3.1.3.9

2.1.3.1.3.8

2.1.3.1.3.7

2.1.3.1.3.6

2.1.3.1.3.5

2.1.3.1.3.4

2.1.3.1.3.3

2.1.3.1.3.2

2.1.3.1.3.1

2.1.1.1.4

Zones

Swinger Shutdown

Zone Types

2.1.1 2.1.1.1

2.1.2

2.1.3 2.1.3.1

Zones 2 - 168
Same as above
If more than 16 zones, 
zones are first displayed  
in groups and then as 
above.

Languages 2 - 4
Same as above

Zone Types 2 - 20 
Same as above

* Enabled according to Keyswitch 
zone option
** Enabled according to 24-hour 
zone option

*Enabled according to  
24-hour zone option

Sound Yelping Siren - Burglary
Temporal Siren - Fire
Keypad Beeping
Chime 

Reporting2.1.3.1.5

2.1.3.1.4 2.1.3.1.4.1

2.1.3.1.4.4

2.1.3.1.4.3

2.1.3.1.4.2

2.1.3.1.5.1

2.1.3.1.5.4
2.1.3.1.5.3

2.1.3.1.5.2

(1) Burglary2.1.3.1.6.1

* Enabled according to Keyswitch 
zone option
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2.2.1 Defining a zone 
You must select the language in which to program the new name and also assign partitions to the zone. You can 
select the zone type and zone name for each new zone. The following steps explain how to select the zone type 
and zone name for a new zone.

1. Navigate with the  keys to Control Panel>Inputs>Zones and press OK.

2. Select the zone number of the new zone to be configured and press OK.

3. Select Zone Type and press OK. 

4. Scroll to the relevant zone type and press OK.

5. Select Zone Name and press OK.

6. Scroll to the relevant language and press OK. The current name for zone is displayed, for example, Zone 1.

7. Press  to enter overwrite mode and press the keys 0 to 9 to insert new characters. 

8. Press OK to accept the changes.

9. The keypad beeps once to confirm the change and returns to Zone Name.

10. Scroll to Partitions and press OK. The current partitions for that zone are displayed, for example, 1 2 3 - - - 
- 8 means that 1, 2, 3 and 8 are included in the zone definition while 4, 5, 6 and 7 are excluded.

11. Press the corresponding numerical key to include or exclude a partition, for example, press 1 to exclude 
partition 1 and press 4 to include partition 4. The display changes to - 2 3 4 - - - 8.

12. Press OK to accept the changes. 

13. The keypad beeps once to confirm the change and returns to Partitions.

2.2.2 Copying zone settings 
You can copy the settings for the current zone to another zone or a set of other zones. All the zone settings 
(except the user defined zone name and RF settings) are copied to the target zones. The following steps explain 
how to copy the settings from one zone to another. 

1. Navigate with the  keys to Control Panel>Inputs>Zones and press OK.

2. Select the relevant zone number and press OK.

3. Scroll to Copy Zone and press OK.

4. The keypad prompts you to enter the start zone. 

5. Enter the number of the first zone to which the settings will be copied and press OK. 

6. The keypad prompts you to enter the end zone. 

7. Enter the number of the last zone to which the settings will be copied and press OK.

8. The keypad prompts you to confirm your selection.

9. Press OK.

10. Copying message is displayed while the zone settings are copied. When copying is complete, the keypad 
beeps once and returns to Copy Zone.
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2.2.3 Editing a zone type 
A zone type is a collection of characteristics. All the zones included in a particular zone type share the same 
characteristics. Each zone must belong to a zone type. There are 20 pre-defined zone types which you can edit. To 
edit a zone type, you must enable the advanced menu. The following example edits a burglary zone type so that 
the input type is 24-hour and it can be automatically bypassed after five alarms within one arm period. 

1. Ensure the advanced menu is enabled. See chapter 20 for more information.

2. Navigate with the  keys to Control Panel>Inputs>Zone Types and press OK.

3. Select Burglary>Input Type>24-hour>Yes and press OK.

4. The keypad beeps once to confirm the change and returns to 24-hour.

5. Scroll to Attributes>Swinger Shutdown>Yes and press OK.

6. The keypad beeps once to confirm the change and returns to Swinger Shutdown.

7. Set the value of Inputs>Swinger Shutdown to 5. For more information see Setting swinger shutdown below. 

2.2.4 Setting swinger shutdown 
Swinger shutdown allows the selected zone to be automatically bypassed after a specified number of alarms. To 
configure swinger shutdown, you must enable the advanced menu. The following example sets swinger shutdown 
to 5. This means that any zone for which swinger shutdown is enabled can be activated five times within one arm 
period before it is automatically bypassed. 

1. Ensure the advanced menu is enabled. See chapter 20 for more information.

2. Navigate with the  keys to Control Panel>Inputs>Swinger Shutdown and press OK.

3. Enter 5 and press OK.

4. The keypad beeps once to confirm the change and returns to Swinger Shutdown.
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2.3 Programming outputs

The control panel includes up to four on-board auxiliary outputs. CS507 output expander modules and CS320 
power modules can be used to increase the number of outputs. For more information on the CS507 output 
expander, see chapter 11. For information on the CS320 power module, see chapter 15. 

To program on-board outputs, select Installer Menu>Control Panel>Outputs. 

2.3.1 Configuring an output
You can change the characteristics of each output. You must specify the events and/or partitions that activate an 
output and the length of time for which the output is activated. The events are grouped in the programming tree. 
A full list of all possible selectable events can be found in Table 2-1: Control panel output events. The following 
example configures output 1 to activate for 15 minutes when a burglary alarm occurs. 

1. Navigate with the  keys to Control Panel>Outputs>Prog Outputs>Output 1 and press OK.

2. Scroll to Event>Alarms>Burglary Alarm and press OK.

3. The keypad beeps once to confirm the change and returns to Alarms.

4. Scroll to Time Unit>Minutes and press OK. 

5. The keypad beeps once to confirm the change and returns to Time Unit.

6. Scroll to Time and press OK. 

7. Select 15 min. and press OK to accept the changes.

8. The keypad beeps once to confirm the change and returns to Time.

1 (<Event>) Event Alarms
Arm/Disarm
Communications
Keypads
Sirens
Tamper/Trouble
Tests
Miscellaneous

2.2.1.1.1 2.2.1.1.1.1

2.2.1.1.1.8

2.2.1.1.1.7

2.2.1.1.1.6

2.2.1.1.1.5

2.2.1.1.1.4

2.2.1.1.1.3
2.2.1.1.1.2

Prog Outputs2.2.1 2.2.1.1

Outputs 2 - 4
Same as above

Sounds On 

Short Blast On

Output Signal Type

Sound On 

Time Unit
Time
Partitions

Attributes

Phone Line Cut

Tampers
Expander Trouble

Arming
Exit Expiry
Closing Kissoff
Keyswitch Arming

Phone Line Cut

Mains Failure
Low Battery
B-Alarm Trip
Tampers
Expander Trouble

Latched
Code Stops Timer
Only if Closed
Only if Open
Inverted

When Armed
When Disarmed

When Armed
When Disarmed

2.2.1.1.2

2.2.1.1.5

2.2.1.1.4

2.2.1.1.3

2.2.2.1.1

2.2.2.2.1

2.2.2.2.4

2.2.2.2.3

2.2.2.2.2

2.2.3.1.1

2.2.3.1.6
2.2.3.1.5

2.2.3.1.4

2.2.3.1.3

2.2.3.1.2

2.2.3.1.1.1

2.2.1.1.5.1

2.2.1.1.5.5

2.2.1.1.5.4

2.2.1.1.5.3
2.2.1.1.5.2

2.2.2.1.1.1

2.2.2.1.3

2.2.2.1.2

2.2.2.1.1.2

2.2.3.1.1.2

Internal Siren

Keypads

2.2.2

2.2.3

2.2.2.1

2.2.2.2

2.2.2.3

2.2.3.1
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< 1. When Event 48 is programmed, it is possible to program a user code's authorization to select which 
output(s) a particular code activates.

< 2. Always program Event 39, Fire alarm reset, to follow the event.

2.3.2 Configuring the internal siren
You can specify conditions and/or events that activate the internal siren. To configure the internal siren, you must 
enable the advanced menu. The following example configures a short blast of the internal siren when the system 
is armed using a keyswitch. 

1. Ensure the advanced menu is enabled.

2. Navigate with the  keys to Control Panel>Outputs>Internal Siren>Short Blast On and press OK.

Table 2-1: Control panel output events

# Event # Event # Event

Misc Keypads Alarms

8 Any Bypass 12 Keypad Fire 0  9 Burglary Alarm

11 9 Duress 13 9 Keypad Medical 1  9 Fire Alarm

48 9 Code Entry (Note 1) 14 9 Keypad Panic 2  9 24-hour Alarm

37 Program Mode 15 Keypad Tamper 3  9 Trouble Alarm

49 * 9 Keyfob Funct 1 27 Chime 4  9 Tamper Alarm

50 * 9 Keyfob Funct 2 47 Keypad Beeping 46 9 Any Alarm

Tests 56 Audible Panic 17 Alarm Memory

29 Dyn Battery Test 57 Silent Panic Sirens

52 Manual Test Tampers and faults 5 Burglary Siren

16 9 Automatic Test 25 Fire LED 6 Fire Siren

59 Walktest Mode 39 Smoke Det Reset (Note 2) 7 Any Siren

Arm/Disarm 40 Over-current 60 External Siren

21 Armed 41 Box Tamper 61 Internal Siren

22 Disarmed 42 Siren Tamper Communications 

23 Ready to Arm 43 Any Open Circuit 32 Listen-in 

24 Not Ready to Arm 44 Any Short Circ’t 33 Line Seizure

53 Armed Away 45 Any Open/Short 35 Fail to Comm’ate

54 Armed Stay 26 Fire Trouble 36 Phone Line Fault

30 Open Period 28 9 Expander Trouble 38 Downloading

31 Closed Period 9 Mains Failure 55 Aux Comm Fail

18 Entry 10 Low Battery

19 Exit

20 Entry or Exit

* Events 49 and 50 require RX8w8, RX16w8, RX32w8, RX8i4, RX16i4, or RX48i4 wireless receivers to operate.
9 If set to latched condition, these events are one second.



CS875-575-375-275-175 Installers Manual with CS5500 keypad B.2.6

3. Scroll to Keyswitch Arming>Yes and press OK.

4. The keypad beeps once to confirm the change and returns to Keyswitch Arming.

2.3.3 Programming the keypad sounder
You can specify conditions and/or events that activate the keypad sounder. To configure the sounder, you must 
enable the advanced menu. The following example programs the keypad sounder to activate when an expander 
trouble condition occurs. 

1. Ensure the advanced menu is enabled. 

2. Navigate with the  keys to Control Panel>Outputs>Keypads>Sound On and press OK.

3. Scroll to Expander Trouble>Enabled and press OK. 

4. The keypad beeps once to confirm the change and returns to Expander Trouble.

2.4 Assigning codes

System codes can be either four or six digits long. There are two types of programmable code; an installer code 
and a duress code. A duress code disarms the system and activates a duress alarm. This is a silent alarm that 
sends a special report to the central station. To program codes, select Installer Menu>Control Panel>Codes.

2.4.1 Setting up the installer code
An installer code has associated arming options and access rights. To set the authority and access rights, you 
must enable the advanced menu. The following example assign partitions 1 and 2 to a new installer code that can 
be used only to arm the system. 

1. Ensure the advanced menu is enabled. 

2. Navigate with the  keys to Control Panel>Codes>Installer Code and press OK twice.

3. Enter the new code and press OK. 

4. Enter the new code and press OK.

5. The keypad beeps once to confirm the change and returns to Code.

6. Scroll to Authority>Arm Only>Yes and press OK.

7. The keypad beeps once to confirm the change and returns to Arm Only.

8. Navigate with the  keys to Partitions and press OK.

9. Press the corresponding numerical key to include partitions 1 and 4 and to exclude all other partitions and 
press OK. 

10. The keypad beeps once to confirm the change and returns to Partitions.

Duress Code

Code

Arm Only After Closing
Arm Only
Arm/Disarm
Master Code
Bypass Zones
Reports Open/Close

Installer Code

4/6 Digit Codes

Authority

2.3.1

2.3.2 2.3.2.1

2.3.2.2 2.3.2.2.1

2.3.2.2.2

2.3.2.2.3

2.3.2.2.4

2.3.2.2.5

2.3.2.2.6Partitions2.3.2.3

2.3.3
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2.5 Setting communication options

Channels 1 - 8
Channels 9 - 16

Fast Format Channels

Communications

Program/Download
Zone Inactivity Monitor

Power Power Trouble and Restores
Aux Overcurrent and Restores

Fail to Communicate
Test Reports

Miscellaneous

2.4.1.2.1.4.4

2.4.1.2.1.4.5

2.4.1.2.1.5.1

2.4.1.2.1.5.2

2.4.1.2.1.4.3.2

2.4.1.2.1.4.4.1

2.4.1.2.1.4.4.2

2.4.1.2.1.4.5.1

2.4.1.2.1.4.5.2

At Disarm
For Zones On Siren Timeout

Send Restores

2.4.1.2.1.5

Phone Number
Account Code
Protocol

Phone Number 1

Phone PrefixCentral Station

Events Alarms
Alarm Restores
Opening/Closings
Zone Bypass and Restores

Arm/Disarm/Alarm

Phone Numbers

Tamper/Trouble Tampers and Restores
Zone Trouble and Restores
Expander Trouble and Restores
Siren/Phone Faults and Restores
RF Sensor Lost and Restores
RF Low Battery and Restores

2.4.1 2.4.1.1

2.4.1.2.1 2.4.1.2.1.12.4.1.2

2.4.1.2.1.3

2.4.1.2.1.2

2.4.1.2.1.4 2.4.1.2.1.4.1

2.4.1.2.1.4.2

2.4.1.2.1.4.3

2.4.1.2.1.4.1.1

2.4.1.2.1.4.1.2
2.4.1.2.1.4.1.3

2.4.1.2.1.4.1.4

2.4.1.2.1.4.2.1

2.4.1.2.1.4.2.2

2.4.1.2.1.4.2.3

2.4.1.2.1.4.2.4

2.4.1.2.1.4.2.5

2.4.1.2.1.4.2.6

2.4.1.2.1.4.3.1

Phone Numbers 2 - 6
Same as above

(1) Partition 1

Dial Attempts

Partition Account Codes

Dialler Output Level
Dialler Abort Delay
Listen-in Time

ARC Dial Attempts
FTC Dial Attempts
Voice/Siren Dial Attempts

2.4.1.3

2.4.1.4

2.4.1.5

2.4.1.7

2.4.1.6

2.4.1.8

2.4.1.3.1

2.4.1.4.1

2.4.1.4.2

2.4.1.4.3

2.4.1.8.1

2.4.1.8.2

Partitions 2 - 8
Same as above

Call Back Number
Access Code
Call Back Reqd
Rings to Answer
Answer Machine Defeat
Call PC on Autotest
Require Code for Download

Up/Download

System Shutdown
Local Programming
Comms Settings
Download Settings

Autotest Autotest Control
Interval
Hour
Minute
Time Since Test

Lockout

2.4.2

2.4.3

2.4.2.1

2.4.2.8

2.4.2.7

2.4.2.6

2.4.2.5

2.4.2.4

2.4.2.3
2.4.2.2

2.4.3.1

2.4.3.5

2.4.3.4
2.4.3.3

2.4.3.2

2.4.2.8.1

2.4.2.8.2

2.3.2.8.3
2.4.2.8.4

Box Tamper
Expander Trouble
Siren Supervision
RF Sensor Lost
RF Low Battery

Mains Failure
Low Battery
Aux Overcurrent

Log Full
Start/End Programming
End Download

Phone Line Cut
Fail to Communicate
Autotest
Autotest Disarmed No Call

(1) Burglary SIA Code*
Contact ID Code*
FF Channel*
FF Restore Channel

4+2 Restore Code*
200Bd FSK Channel*
200Bd FSK Restore Channel
Voice Channel*

*
TELIM Channel*
TELIM Code*
4+2 Code*

*

2.4.4.3.1.1.1

2.4.4.3.1.1.2

2.4.4.3.1.1.3
2.4.4.3.1.1.4

2.4.4.3.1.1.5

2.4.4.3.1.1.6

2.4.4.3.1.1.7

Partition ReportsReporting Opening/Closings
Zone Bypass
Zone Restore
Zone Trouble
Zone Tamper
Cancel
Recent Closing
Exit Error

Tamper/TroubleSystem Reports

Communications

Miscellaneous

Power

Zone TypesReport Codes

Bypass on Force Arm
First to Open/Last to Close

2.4.4 2.4.4.1

2.4.4.2

2.4.4.3

2.4.4.1.1

2.4.4.1.2

2.4.4.1.3

2.4.4.1.4
2.4.4.1.5

2.4.4.1.6

2.4.4.1.7

2.4.4.1.8

2.4.4.2.1

2.4.4.2.2

2.4.4.2.3

2.4.4.2.4

2.4.4.2.5

2.4.4.2.6

2.4.4.3.1

2.4.4.2.1.1

2.4.4.2.1.2

2.4.4.2.1.3

2.4.4.2.1.4

2.4.4.2.1.5

2.4.4.2.2.1
2.4.4.2.2.2

2.4.4.2.2.3

2.4.4.2.3.1

2.4.4.2.3.2

2.4.4.2.3.3

2.4.4.2.3.4

2.4.4.2.4.1

2.4.4.2.4.2

2.4.4.2.4.3

2.4.4.3.1.1

Zone Types 2 - 20
Same as above

2.4.4.3.1.1.8

2.4.4.3.1.1.9

2.4.4.3.1.1.10

Opening
Closing
Partarm
Recent Closing
Exit Error
Cancel

FF Channel*
TELIM Channel*
4+2 Code*
200Bd FSK Channel*
Voice Channel*

Zone Tamper
Zone Trouble
Siren Tamper
Box Trouble
Expander Trouble
RF Sensor Lost
RF Low Battery

FF Channel*
FF Restore Channel

4+2 Restore Code*
200Bd FSK Channel*
200Bd FSK Restore Channel
Voice Channel*

*
TELIM Channel*
4+2 Code*

*

FF Channel*
TELIM Channel*
4+2 Code*
200Bd FSK Channel*
Voice Channel*

B-Alarm Trip

2.4.4.3.2.1.1

2.4.4.3.2.1.2

2.4.4.3.2.1.3
2.4.4.3.2.1.4

2.4.4.3.2.1.5

2.4.4.3.3.1.1

2.4.4.3.3.1.2

2.4.4.3.3.1.3
2.4.4.3.3.1.4

2.4.4.3.3.1.5

2.4.4.3.3.2.1

2.4.4.3.3.2.2

2.4.4.3.3.2.3

2.4.4.3.3.2.4

2.4.4.3.3.2.5

2.4.4.3.3.2.6

Open/Close/Cancel

Tamper/Trouble

2.4.4.3.2

2.4.4.3.3

2.4.4.3.2.1

2.4.4.3.2.2

2.4.4.3.2.3

2.4.4.3.2.4

2.4.4.3.2.5

2.4.4.3.2.6

2.4.4.3.3.1

2.4.4.3.3.2

2.4.4.3.3.3

2.4.4.3.3.4

2.4.4.3.3.5

2.4.4.3.3.6

2.4.4.3.3.7

2.4.4.3.3.8 2.4.4.3.3.2.7

Format Override2.4.5 Features 1
Features 2

2.4.5.1

2.4.5.2

Mains Failure
Low Battery
Aux Overcurrent

Duress
Keypad Tamper
Keypad Panic
Keypad Aux 1 (Fire)
Keypad Aux 2 (Medical)

FF Channel*
FF Restore Channel

4+2 Code*
4+2 Restore Code*
200Bd FSK Channel*

*
TELIM Channel*

200Bd FSK Restore Channel*
Voice Channel*

FF Channel*
TELIM Channel*
4+2 Code*
200Bd FSK Channel*
Voice Channel*

2.4.4.3.4.1.1

2.4.4.3.4.1.2

2.4.4.3.4.1.3

2.4.4.3.4.1.4

2.4.4.3.4.1.5

2.4.4.3.5.1.1

2.4.4.3.5.1.2

2.4.4.3.5.1.3

2.4.4.3.5.1.4

2.4.4.3.5.1.5

2.4.4.3.5.1.6

Keypad

Power

2.4.4.3.4

2.4.4.3.5

2.4.4.3.4.1

2.4.4.3.4.2

2.4.4.3.4.3
2.4.4.3.4.4

2.4.4.3.4.5

2.4.4.3.5.1

2.4.4.3.5.2

2.4.4.3.5.3

2.4.4.3.5.1.7

FF Channel*
FF Restore Channel
TELIM Channel*
4+2 Code*
4+2 Restore Code*
200Bd FSK Channel*

Voice Channel*

*

200Bd FSK Restore Channel*

Phone Line Cut 2.4.4.3.6.1.1

2.4.4.3.6.1.2

2.4.4.3.6.1.3

2.4.4.3.6.1.4
2.4.4.3.6.1.5

2.4.4.3.6.1.6

Communications2.4.4.3.6 2.4.4.3.6.1

Log Full
Start Programming
End Programming
End Download

Fail to Communicate
Autotest

FF Channel*
TELIM Channel*
4+2 Code*
200Bd FSK Channel*
Voice Channel*

(1) Zone 1

2.4.4.3.6.2.1

2.4.4.3.6.2.2
2.4.4.3.6.2.3

2.4.4.3.6.2.4
2.4.4.3.6.2.5

200Bd FSK Channel*

FF Channel*
TELIM Channel*
4+2 Code*
200Bd FSK Channel*
Voice Channel*

2.4.4.3.7.1.1

2.4.4.3.7.1.2

2.4.4.3.7.1.3

2.4.4.3.7.1.4

2.4.4.3.7.1.5

2.4.4.3.8.1.1

Miscellaneous

Zones 200Bd FSK

2.4.4.3.7

2.4.4.3.8

2.4.4.3.6.2

2.4.4.3.6.3

2.4.4.3.7.1

2.4.4.3.7.2

2.4.4.3.7.3

2.4.4.3.7.4

2.4.4.3.8.1

Zones 2 - 99 same as above.
If more than 16 zones, zones are first displayed 
in groups and then displayed as above.

*If relevant protocol set in Phone Numbers

2.4.4.3.6.1.7

2.4.4.3.1.1.11

2.4.4.3.3.2.8

2.4.4.3.5.1.8

2.4.4.3.6.1.8
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The control panel can report to a central station after all or specified events. Communication between the control 
panel and the central station is monitored to ensure against damage or faults. The control panel can also 
communicate with up/download software when a download session has been established. To program control 
panel communciation options, select Installer Menu>Control Panel>Communications.

2.5.1 Defining communication with a central station
You can specify up to six central stations to which the control panel reports events. You can also select the 
events to be reported to each station. For more information on setting up a communicator, see chapter 21. For an 
example of how to program phone settings, see chapter 5.

You can set a number of conditions that must be met before a communication session is established between the 
control panel and the central station. To enable restore report options, you must enable the advanced menu. The 
following example configures the control panel to ring the central station three times before a fail to 
communicate condition occurs. It also enables a restore report to be sent at the moment the system is disarmed. 

1. Ensure the advanced menu is enabled. 

2. Navigate with the  keys to Control Panel>Communications>Central Station and press OK.

3. Scroll to Dial Attempts>FTC Dial Attempts and press OK. 

4. Select 3 and press OK.

5. The keypad beeps once to confirm the change and returns to FTC Dial Attempts.

6. Navigate with the  keys to Send Restores>At Disarm>Yes At Disarm and press OK.

7. The keypad beeps once to confirm the change and returns to At Disarm.

2.5.2 Defining communication with upload/download software
You can set up a number of conditions that must be met before a communication session is established between 
the control panel and the up/download software. For more information on programming using the upload/
download software, see chapter 22.

2.5.3 Configuring the system autotest
The autotest is run at configured intervals to ensure communication between the control panel and central station 
or the control panel and up/download software is functioning correctly. The following example sets the system 
autotest to run every Friday at 12.45, assuming that today is Wednesday. 

1. Navigate with the  keys to Control Panel>Communications>Autotest>Autotest Control>Days and 
press OK.

2. Scroll to Interval>7 days and press OK.

3. The keypad beeps once to confirm the change and returns to Autotest Control.

4. Scroll to Hour>12 and press OK.

5. The keypad beeps once to confirm the change and returns to Hour.

6. Scroll to Minutes>45 and press OK.

7. The keypad beeps once to confirm the change and returns to Minutes.

8. Scroll to Time Since Test>5 Days and press OK.

9. The keypad beeps once to confirm the change and returns to Time Since Test.
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2.5.4 Enabling reporting
You must enable event reporting in the control panel and program the events and zone types for which reports are 
sent. You must specify the format of the report and, in the case of voice reports, you must map each event to a 
recorded message. You can map one message to a number of events. The following example enables voice 
reporting to phone number 2 for a phone line cut event and assigns a voice message to this event. 

1. Navigate with the  keys to Control Panel>Communications>Central Station and press OK.

2. Scroll to Phone Numbers>Phone Number 2>Protocol>Voice and press OK. 

3. The keypad beeps once to confirm the change and returns to Protocol.

4. Navigate with the  keys to Reporting>Report Codes>Communications and press OK. 

5. Scroll to Phone Line Cut>Voice Channel and press OK. 

6. Scroll to the number of the message that you want to map to that zone and press OK.

7. The keypad beeps once to confirm the change and returns to Voice Channel.

2.6 Configuring partitions

A partition is a group of zones which operate as a unit and can be armed and disarmed independently of other 
partitions in the system. A partition is also known as an area. The control panel can be divided into separate 
partitions with distinct zones, keypad and user codes for each partition. Arming and bypass options can be set for 
each partition. To program partition settings, select Installer Menu>Control Panel>Partition Settings.

2.6.1 Setting timers
You can specify the time in which a user must disarm or arm a system before a full alarm occurs. The following 
example sets time within which the user must leave the protected zone after arming the system (12 seconds). It also 
sets the time within which the user must disarm the system (10 seconds). 

1. Navigate with the  keys to Control Panel>Partition Settings>Timers >Entry 1 and press OK.

2. Enter 12 and press OK.

3. The keypad beeps once to confirm the change and returns to Entry 1.

4. Scroll to Exit 1 and press OK.

5. Enter 10 and press OK.

Entry 1
Exit 1
Entry 2
Exit 2

Arming Quick Arm
Re-exit
Silent Auto Arm
Silent Exit Always
Arming with Zone Lost

Miscellaneous

Silent PA (7+9)
Audible PA (7+9)
Fire/Aux 1 (1+3)
Medical/Aux 2 (4+6)
Multi Code Tamper
LED Extinguish

Bypass Auto Bypass
Code Required
Sounder Alert
Bypass Toggle

Mains/Batt Sounder Alert
Zone Lost Gives Tamper

Timers

Feature Select

2.5.1

2.5.2

2.5.1.1

2.5.1.2

2.5.1.3

2.5.1.4

2.5.2.1

2.5.2.2

2.5.2.3

2.5.2.4

2.5.2.1.1

2.5.2.1.2

2.5.2.1.3

2.5.2.1.4

2.5.2.1.5

2.5.2.2.1
2.5.2.2.2

2.5.2.2.3

2.5.2.2.4

2.5.2.2.5

2.5.2.2.6

2.5.2.3.1

2.5.2.3.2

2.5.2.3.3

2.5.2.3.4

2.5.2.4.1

2.5.2.4.2

Keypads
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6. The keypad beeps once to confirm the change and returns to Exit 1.

2.6.2 Configuring a partition
You can set partition features including arming and bypassing options. You can also enable life safety keys for 
the partition keypads. The following example allows the system to be armed with a lost zone and enables the 
personal alarm combination keys so they activate a personal attack alarm when pressed.  

1. Ensure the advanced menu is enabled. 

2. Navigate with the  keys to Control Panel>Partition Settings>Feature Select>Arming and press OK.

3. Scroll to Arming with Zone Lost>Yes and press OK.

4. The keypad beeps once to confirm the change and returns to Arming with Zone Lost.

5. Navigate with the  keys to Keypads>Silent PA (7+9)>Yes and press OK.

6. The keypad beeps once to confirm the change and returns to Silent PA (7+9).

< When the Arming with Zone Lost option is enabled, the user is always allowed to arm the system even if the 
PIR or door/window sensor does not report within the short window. For more information on short windows, 
see chapter 9. 

2.7 Configuring the system

Configurable system settings include timers, input features, the system clock and serial port and various tests that 
can be performed on the control panel. To program system settings, select Installer Menu>Control 
Panel>System Settings.

Sounders

Batt Dynamic Test Duration
Mains Report Delay
Power Up Delay

Inputs

Power

Communications

Internal Siren Timeout
External Siren Timeout
Chime Time

Phone Line Cut Delay

Inputs On-board 8 zones
Box Tamper
2-wire Smoke Detectors
Force Default Zone Types

Batt Presence Test
Dynamic Batt Test at Arming
Manual Siren Test
Manual Dialler Test
Walktest

Diagnostics

Fire Verification Time
Zone Inact. Unit
Zone Inactivity Monitor
Double Knock Time
Double Knock Open Time
B-Alarm Timer

Timers

Feature Select

Mains Frequency
Lost Clock Indication
Summer/Winter Time

Fire Siren
Master Code Resets Tamper Memory
Transformer Size
All Abort
Blank Keypads
Reset Tamper Before Arming

Clock

Miscellaneous

2.6.1

2.6.2

2.6.1.1

2.6.1.2

2.6.1.3

2.6.1.4

2.6.2.1

2.6.2.2

2.6.2.3

2.6.2.4

2.6.1.1.1

2.6.1.1.2

2.6.1.1.3

2.6.1.1.4

2.6.1.1.5

2.6.1.1.6

2.6.1.2.1

2.6.1.2.2

2.6.1.2.3

2.6.1.3.1

2.6.1.3.2

2.6.1.3.3

2.6.1.4.1

2.6.2.1.1

2.6.2.1.2

2.6.2.1.3

2.6.2.1.4

2.6.2.2.1

2.6.2.2.2

2.6.2.2.3

2.6.2.2.4

2.6.2.2.5

2.6.2.3.1

2.6.2.3.2

2.6.2.3.3

2.6.2.4.1

2.6.2.4.2

2.6.2.4.3

2.6.2.4.4

2.6.2.4.5

2.6.3 Serial Port Connection Type
Speed

2.6.3.1

2.6.3.2

2.6.2.4.6



CS875-575-375-275-175 Installers Manual with CS5500 keypadB.2.11

2.7.1 Setting timers
You can set timers to control the duration of various system functions. The following example sets the internal 
siren timer to five minutes. When the siren starts ringing, the timer starts counting down. When the timer is 
finished, the siren automatically cuts out. 

1. Ensure the advanced menu is enabled. See chapter 20 for more information.

2. Navigate with the  keys to Control Panel>System Settings and press OK.

3. Scroll to Timers>Sounders>Internal Siren Timeout and press OK.

4. Enter 5 and press OK.

5. The keypad beeps once to confirm the change and returns to Internal Siren Timeout.

2.7.2 Configuring system features
You can specify various system features, enable the tests that can be performed on the control panel and set clock 
options. The following example programs the control panel to activate the siren and make a manual test call to the 
central station during the do self tests.

1. Ensure the advanced menu is enabled. See chapter 20 for more information.

2. Navigate with the  keys to Control Panel>System Settings>Feature Select and press OK.

3. Scroll to Diagnostics>Manual Siren Test>Enabled and press OK.

4. The keypad beeps once to confirm the change and returns to Manual Siren Test.

5. Scroll to Manual Dialler Test>Enabled and press OK.

6. The keypad beeps once to confirm the change and returns to Manual Dialler Test.

2.8 Setting arm schedules

The control panel can be programmed to automatically open and close partitions at specified times on specified 
days. To program schedules, you must enable the advanced menu. Select Installer Menu>Commands>Advanced 
Menu>Enabled and press OK. Then select Installer Menu>Control Panel>Arm Schedules.

2.8.1 Setting up schedules
You can set up a schedule to control the opening and autoarming events for each partition. The following example 
sets a schedule for partition 1 so that it is automatically closed at 18.00 on a Monday if there is no activity in the 
building. If there is activity at closing time, the control panel will try to arm after every 45 minutes of inactivity 
until the next opening time, or until the system is armed manually. 

Partitions Opening (1) Partition 1

Schedule Times

Partitions Autoarming

Closing/Autoarm

Opening

(1) Partition 1

2.7.1

2.7.2

2.7.3

2.7.1.1

2.7.2.1

2.7.3.1

2.7.3.2

2.7.1.1.1

2.7.1.1.2

2.7.1.1.3

2.7.1.1.4

2.7.1.1.5

2.7.1.1.6

2.7.1.1.7

2.7.2.1.1

2.7.2.1.2

2.7.2.1.3

2.7.2.1.4
2.7.2.1.5

2.7.2.1.6

2.7.2.1.7

2.7.2.1.8

2.7.3.1.1

2.7.3.1.2

2.7.3.2.1

2.7.3.2.2

Hour
Minute

Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

Hour
Minute

Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday
45 Minute Retry

Partitions 2 - 8
Same as above

Partitions 2 - 8
Same as above
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1. Ensure the advanced menu is enabled. See chapter 20 for more information.

2. Navigate with the  keys to Control Panel>Arm Schedules and press OK.

3. Scroll to Partitions Autoarming>Partition 1>Sunday>Yes and press OK.  

4. The keypad beeps once to accept the change and returns to Sunday.

5. Scroll to 45 Minute Retry>Enabled and press OK.  

6. The keypad beeps once to accept the change and returns to 45 Minute Retry.

7. Navigate with the  keys to Schedule Times>Closing/Autoarm>Hour and press OK.

8. Enter 18 and press OK.

9. The keypad beeps once to confirm the change and returns to Hour.

10. Scroll to Minute and press OK. 

11. Enter 0 and press OK.

12. The keypad beeps once to confirm the change and returns to Minute.

2.9 Programming the system to work with a home automation system

The control panel can communicate to home automation protocols such as the X-10 protocol. The connection 
between the control panel and the X-10 home automation module is made through the CS507 output expander or 
the CS534 listen-in module RJ11 connectors. The on-board RS232 connector on the CS275, CS375, CS575 and 

Interface Configuration
Zone Name
Zone Status
Zone Snapshot
Partition Status
Partition Snapshot
System Status
Log Event

Interface Configuration
Zone Status
Zone Snapshot
Partition Status
Partition Snapshot
System Status
X-10 Message
Log Event
Keypad Message

Transition Broadcasts

Protocol

Commands/Requests Misc Requests

Programming Program Data Request
Program Data Command

Misc Commands X-10 Message
Store Comms Event
Zone Bypass Toggle

User Info Request
Set User Code
Set User Authority

Keypad Functions 1st Keypad Function

2nd Keypad Function
Send Keypad Text
Keypad Terminal Mode

Set Date/Time

2.8.2.1

2.8.2.2

2.8.2.3

2.8.2.4

2.8.2.5

2.8.2.6

2.8.2.7

2.8.2.8

2.8.2.9

2.8.3.1

2.8.3.2

2.8.3.3

2.8.3.4

2.8.3.1.1

2.8.3.1.2
2.8.3.1.3

2.8.3.1.4

2.8.3.1.5

2.8.3.1.6

2.8.3.1.7

2.8.3.1.8

2.8.3.2.1

2.8.3.2.2

2.8.3.2.3

2.8.3.3.1

2.8.3.3.2

2.8.3.3.3

2.8.3.3.4

2.8.3.3.5

2.8.3.3.6

2.8.3.4.1

2.8.3.4.2

2.8.3.4.3

2.8.3.4.4

2.8.1

2.8.2

2.8.3

With PIN
Without PIN

With PIN
Without PIN

2.8.3.3.3.1

2.8.3.3.3.2

2.8.3.4.1.1

2.8.3.4.1.2

LCD Keypad Address2.8.4
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CS875 can be used to connect to other home automation systems. Consult your local Aritech Support to obtain 
more information.

Updated system information can be sent from the control panel to the home automation system in binary or ASCII 
format. The control panel can respond to requests sent by the home automation system and in turn can send 
commands to the home automation system. To program home automation options, you must enable the advanced 
menu. Select Installer Menu>Commands>Advanced Menu>Enabled and press OK. Then select Installer 
Menu>Control Panel>Home Automation.

2.9.1 Enabling broadcasts
You can specify how updated information is sent to the home automation system from the RS232 interface. The 
following example enables the home automation protocol to send different end-user messages to the keypad 
display.

1. Ensure the advanced menu is enabled. See chapter 20 for more information.

2. Navigate with the  keys to Control Panel>Home Automation and press OK.

3. Scroll to Transition Broadcasts>Keypad Message>Enabled and press OK.  

4. The keypad beeps once to accept the change and returns to Keypad Message.

2.9.2 Enabling commands and requests
You can specify which commands can be sent to the serial port by the home automation system. These include 
arming and disarming, programming and bypassing zones. The following example enables primary keypad 
functions that are sent by the home automation system with a valid user code.  

1. Ensure the advanced menu is enabled. See chapter 20 for more information.

2. Navigate with the  keys to Control Panel>Home Automation and press OK.

3. Scroll to Commands/Requests>Keypad Functions>1st Keyad Function>With PIN>Enabled and press OK.

4. The keypad beeps once to confirm the change and returns to With PIN.
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2.10 Glossary

Location Term Definition

2 Control Panel This groups all options relating to the central processing unit of the alarm 
system. The control panel monitors the detection devices and activates any 
number of signalling devices.

2.1 Inputs A menu entry that groups options relating to all zones. 

2.1.1 Zones An  menu entry that groups zone options. 

2.1.1.1.1 Zone Type An  menu option that specifies the zone type of a particular zone. 

2.1.1.1.2 Zone Name An  menu option that allows the installer to define names for each installed 
zone. For example, Zone 1 can be named Living Room PIR. 

2.1.1.1.3 Partitions A  menu entry that lists the partitions assigned to the selected zone. The 
selected zone can trigger an event on these partitions.
A zone may reside in any combination of partitions. A zone that resides in 
more than one partition becomes a common zone and is reported to its lowest 
partition number. A common zone is armed only when all the partitions that it 
belongs to are armed. It is disarmed the moment one of the partitions it 
belongs to is disarmed. 

2.1.1.1.4 Copy Zone A menu option that copies the settings for an individual zone to a contiguous 
set of other zones. 

2.1.2 Swinger Shutdown A  zone characteristic that allows the selected zone to be automatically 
bypassed after a specified number of alarms. 
An Inputs menu entry that contains the swinger count. 

2.1.3 Zone Types A menu entry that groups zone type characteristics and allows the installer to 
select a pre-defined zone type. There are 20 pre-defined zone types. The 
characteristics of each zone can be changed. For example, if a keypad beeps, 
if the zone is a delay 1 or delay 2 zone, a 24-hour zone and so on.

2.1.3.1.1 Input Type A menu entry that groups options that determine the basic features of the 
selected zone type.

2.1.3.1.1.1 Fire A zone type that reports a fire alarm when activated. 

2.1.3.1.1.2 24-hour A zone type where reaction is not dependent on the arm/disarm state of the 
system. It is permanently active 24 hours a day unless bypassed by forced 
arming. An example of a 24-hour zone is a fire, panic or glassbreak zone.

2.1.3.1.1.3 Keyswitch A zone type that can be used to arm or disarm a partition using a switch 
connected to a zone instead of a code. Both pulsed and maintained 
keyswitches can be used.

2.1.3.1.1.4 Follower/Access A zone type that acts like a normal burglary zone except during entry and exit 
times when it is inhibited. The entry time is started when a Delay zone is 
opened. The zone is instant when the system is armed and no entry or exit 
delay is timed. 

2.1.3.1.1.5 Delay 1 A zone type whose events can be delayed for a specified interval before a 
zone creates an alarm. This type of zone is usually used to allow exit and entry 
to a building. The time intervals for a Delay 1 zone are defined in Entry 1 and 
Exit 1. 

2.1.3.1.1.6 Delay 2 A zone type whose events can be delayed for a specified interval before a 
zone creates an alarm. This type of zone is usually used to allow exit and entry 
to a building. The time intervals for a Delay 2 zone are defined in Entry 2 and 
Exit 2.



CS875-575-375-275-175 Installers Manual with CS5500 keypadB.2.15

2.1.3.1.1.7 Interior A zone type within the building that is bypassed when the system is armed in 
stay mode. 

2.1.3.1.1.8 Entry Guard A zone type that reduces false alarms. If an armed entry guard zone is 
opened, the keypad sounder activates and the entry delay starts before 
creating an alarm. This can be programmed as a zone type.

2.1.3.1.1.9 Final Set Door A zone type that arms the system the moment the exit door is closed. It differs 
from an exit terminator zone in that it is available in the standard CSx75 and is 
attached to a zone that can also create alarms and so on. 

2.1.3.1.1.10 Roller Shutter A zone type used with roller shutter blinds. These zones can be used only on 
the control panel. They cannot be used on a CS208/CS216 input expander.

2.1.3.1.1.11 B-Alarm Trip A zone type that generates a B-alarm trip event. The event is reported to the 
central station using the codes set in the B-Alarm Trip report codes menu. 
Typically, all alarms are A-alarms. Both A-alarms and B-alarms activate sirens 
and keypad buzzers. However, the central station reacts differently to A and B-
alarm trip events. A police patrol is sent when an A-alarm trip event is reported 
(full alarm), whereas a guard from the security company is sent when a B-
alarm trip event is reported (near alarm). 
If two B-alarm trip events occur within the pre-set B-alarm time, the second B-
alarm trip event is treated as an A-alarm trip event. 

2.1.3.1.1.12 Trouble A zone type that sends an alarm when the system is armed and trouble when 
the system is disarmed.

2.1.3.1.2 Zone Type Name A menu option that specifies the name of a particular zone type. This option 
also allows the name to be edited. 

2.1.3.1.3 Attributes A menu entry that groups the additional characteristics of the selected zone 
type. 

2.1.3.1.3.1 End of Line Resistor A zone characteristic that specifies that two 4K7 end of line resistors are used. 
An end of line resistor (EOL) is a resistor that is placed on the line to stop the 
signal being bounced back. 

2.1.3.1.3.2 Loop Response A zone characteristic of on-board control panel zones that specifies the 
response rate. This can be either 500 ms or 50 ms. 

2.1.3.1.3.3 Double Knock A zone characteristic that causes an event only if the zone is activated twice 
within a specified time. This is to prevent false alarms on PIRs.

2.1.3.1.3.4 Swinger Shutdown A zone characteristic that allows the selected zone to be automatically 
bypassed after a specified number of alarms. 
An Inputs menu entry that contains the swinger count. 

2.1.3.1.3.5 Bypassable A zone characteristic that allows the zone to be bypassed. 

2.1.3.1.3.6 Force Armable A zone characteristic that allows the zone to be force armed.

2.1.3.1.3.7 Group Bypass A zone characteristic that allows the user to bypass multiple zones with a 
single operation. 

2.1.3.1.3.8 Zone Inactivity Monitor A zone characteristic that sends a report to the central station when the zone 
does not change conditions within a specified time period. 

2.1.3.1.3.9 Pulsed Keyswitch A zone characteristic that allows a zone input to be used with a momentary 
keyswitch. Each activation of the keyswitch toggles the armed state of the 
control.

2.1.3.1.3.10 No Keypad Display A zone characteristic that blanks the zone status when armed.

2.1.3.1.4 Sound A menu entry that groups sounder characteristics for a particular zone type. 
These characteristics determine the sounds produced by the sirens and 
keypads when the selected zone is activated. 
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2.1.3.1.4.1 Yelping Siren - Burglary A menu option that sounds a yelping siren when a burglary zone is activated.

2.1.3.1.4.2 Temporal Siren - Fire A menu option that sets whether a zone type activates a fire or a burglary 
siren.

2.1.3.1.4.3 Keypad Beeping A menu option that activates the keypad buzzer when an alarm occurs.

2.1.3.1.4.4 Chime A menu option that sets whether a zone type activates a chime.
A chime is generally a single stroke signal and is often used as an indication 
on a shop door. This can be set as a zone type. There is a beep on chime 
activation and no beep on deactivation.

2.1.3.1.5 Reporting A menu entry that groups reporting options for the selected zone type. 

2.1.3.1.5.1 Local Only A zone characteristic that causes that zone not to report alarms to the central 
station. Locally, the sirens are activated according to the other zone type 
characteristics. 

2.1.3.1.5.2 Restore Reporting A menu option that causes restore events to be reported to the central station.

2.1.3.1.5.3 Dialler Delay A menu option that sets the length of time (in seconds) the dialler waits before 
reporting an abortable alarm. If the system is disarmed during this time, the 
abortable alarm is not sent to the central station. The delay can be from 0-255 
seconds. A value of 0 means that there is no abort delay.

2.1.3.1.5.4 Listen-in A menu option that sends a report to the central station indicating that a listen-
in session must be started. 
In order to use listen-in, a CS534 listen-in module must be installed and a 
microphone must be connected. When an alarm is generated and reported, 
the central station can listen to what is happening on the premises. 
Certain protocols (such as SIA, Contact ID and 200Bd FSK) have ‘listen-in 
blocks’ that are communicated with the alarm code and indicate that a listen-in 
session must be started.

2.1.3.1.6 Copy Zone Type A menu option that copies the settings for a zone type to a new zone type. 

2.2 Outputs A  menu entry that groups options relating to programmable outputs.

2.2.1 Prog Outputs A menu entry that groups options that configure outputs. 

2.2.1.1.1 Event Any occurrence such as system arming, faults and alarms.
A menu option that specifies which event activates an output. 

2.2.1.1.1.1 Alarms A menu option that groups together the alarm events that can be selected to 
trigger an output. 

2.2.1.1.1.2 Arm/Disarm A menu option that groups the events that can be used to trigger outputs. The 
entry is available to make selection of output events more convenient. 

2.2.1.1.1.3 Communications A menu option that groups together the communication events that can be 
selected to trigger an output. 

2.2.1.1.1.4 Keypads A menu option that groups the keypad events that trigger an output. 

2.2.1.1.1.5 Sirens A menu option that groups together the siren events that can be selected to 
trigger an output. 

2.2.1.1.1.6 Tamper/Trouble A menu option that groups together the tamper and trouble events that can be 
selected to trigger an output. 

2.2.1.1.1.7 Tests A menu option that groups settings related to different tests. These include 
tests such as automatic test calls, dynamic battery tests and so on. 
should this be changed to:
An Outputs menu option that groups together the test events that can be 
selected to trigger an output.  
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2.2.1.1.2 Time Unit A menu option that specifies whether the outputs are timed in minutes or 
seconds.

2.2.1.1.3 Time A menu option that sets the length of time for which an output is activated. If it 
is set to 0, the output follows the event. 

2.2.1.1.4 Partitions A menu entry that lists the partitions assigned to the selected output. The 
selected output can be triggered by an event on these partitions.
A zone may reside in any combination of partitions. A zone that resides in 
more than one partition becomes a common zone and is reported to its lowest 
partition number. A common zone is armed only when all the partitions that it 
belongs to are armed. It is disarmed the moment one of the partitions it 
belongs to is disarmed. 

2.2.1.1.5 Attributes A menu entry that groups the programmable attributes of the selected output. 

2.2.1.1.5.1 Latched A menu option that causes an output to remain activated until a code is 
entered at the keypad.

2.2.1.1.5.2 Code Stops Timer A menu entry that allows the timer used on programmable outputs to be reset 
by entering a valid user code. 

2.2.1.1.5.3 Only if Closed A menu option that activates an output after closing time and before opening 
time. During these times, codes can be used to arm/disarm the system. A 
timer is used to set these times.

2.2.1.1.5.4 Only if Open A menu option that activates an output between opening time and closing 
time.

2.2.1.1.5.5 Inverted A menu option that enables a mode that inverts the state of an output 
(normally activated and then deactivated when an event occurs). 

2.2.2 Internal Siren A menu entry that groups options that set the conditions/events that activate 
the internal siren. This is a siren which sounds within the building.

2.2.2.1 Sounds On A menu entry that groups events that activate the internal siren. 

2.2.2.1.1 Phone Line Cut A menu entry that groups options that activate the internal siren when a phone 
line cut event occurs.  

2.2.2.1.1.1 When Armed A menu option that activates the internal siren if a phone line cut event occurs 
while the system is armed. 

2.2.2.1.1.2 When Disarmed A menu option that activates the internal siren if a phone line cut event occurs 
while the system is disarmed. 

2.2.2.1.2 Tampers A menu option that activates the internal siren when a tamper occurs. 

2.2.2.1.3 Expander Trouble A menu option that activates the internal sound when an expander trouble 
condition occurs. 

2.2.2.2 Short Blast On A menu entry that groups internal sounder options. Each option specifies a 
time at which the sounder blasts. These options are: Arming, Exit Expiry, 
Closing Kissoff and Keyswitch Arming.

2.2.2.2.1 Arming A menu option that causes the internal sounder to blast when the system 
arms. 

2.2.2.2.2 Exit Expiry A menu option that causes the internal sounder to blast when the exit time 
expires.

2.2.2.2.3 Closing Kissoff A menu option that causes the internal sounder to blast when the central 
station receives a closing report.

2.2.2.2.4 Keyswitch Arming A menu option that causes the internal sounder to blast when the system is 
armed by keyswitch or armed and disarmed by keyswitch. There is one blast 
for arming and two blasts for disarming.
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2.2.2.3 Output Signal Type A menu option that converts the internal siren to accept a speaker. The built-in 
112db siren driver can be converted to a 1-amp voltage output. The siren can 
be 15 or 30 Watt maximum, with an impedance of 4, 8 or 16 ohms. 

2.2.3 Keypads A menu option that groups keypad buzzer options. 

2.2.3.1 Sound On A menu entry that groups events that activate the keypad buzzer. 

2.2.3.1.1 Phone Line Cut A menu entry that groups options that activate the keypad buzzer when a 
phone line cut event occurs.  

2.2.3.1.1.1 When Armed A menu option that activates the keypad buzzer if a phone line cut event 
occurs while the system is armed. 

2.2.3.1.1.2 When Disarmed A menu option that activates the keypad buzzer if a phone line cut event 
occurs while the system is disarmed. 

2.2.3.1.2 Mains Failure Amenu option that activates the keypad buzzer when the mains power supply 
fails. 

2.2.3.1.3 Low Battery A menu option that activates the keypad buzzer when a low battery event 
occurs. 

2.2.3.1.4 B-Alarm Trip A menu option that activates the keypad buzzer when a B-Alarm Trip event 
occurs. 

2.2.3.1.5 Tampers A menu option that activates the keypad buzzer when a tamper occurs. 

2.2.3.1.6 Expander Trouble A menu option that activates the keypad buzzer when an expander trouble 
condition occurs. 

2.3 Codes A menu entry that groups user code options. 

2.3.1 4/6 Digit Codes A  menu option that specifies whether a four or six digit code is used.

2.3.2 Installer Code A four or six-digit code used to program the system. It specifies the partitions 
and parts of the system the installer can access. It can also be used as a 
standard arm/disarm code, in which case it becomes user 255. 
A Codes menu entry that groups installer code options.

2.3.2.1 Code A  menu option that sets the user code. This is a series of four or six numbers 
that allows access to the system.

2.3.2.2 Authority A menu entry that groups access options. These options specify the level of 
access an individual has when using the control panel. 

2.3.2.2.1 Arm Only After Closing A menu option that specifies a code that arms the system during the close 
window only (when the system is scheduled to be armed). If entered during the 
open window when the system is turned off, the code does not arm the 
system. 

2.3.2.2.2 Arm Only A menu option that specifies a code that arms the system and does not 
perform any other function. For example, the code issued to service staff.  

2.3.2.2.3 Arm/Disarm A menu option that specifies a four-digit or six-digit code that arms or disarms 
the system depending on its current status. 

2.3.2.2.4 Master Code A menu option that specifies a code that can program other user codes 
provided it has access to the same partitions as the user code. The user 1 
code is the default master code.

2.3.2.2.5 Bypass Zones A menu option that allows the selected code to bypass zones. 

2.3.2.2.6 Reports Open/Close A menu option that specifies a code that reports arms (close) and disarms 
(open) to the central station.
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2.3.2.3 Partitions A Codes menu entry that lists the partitions assigned to the selected code. The 
selected code can trigger an event on these partitions. 

2.3.3 Duress Code A menu option that sets the duress code. A duress code disarms the system 
and activates a duress alarm. This is a silent alarm that sends a special report 
to the central station.

2.4 Communications A menu entry that groups options for communication between the control 
panel and the up/download software or central stations. 

2.4.1 Central Station A menu entry that groups options relating to the central station. This is a 
remote location that is designed to monitor signals and reports from alarm 
systems and summon assistance if necessary. This is also known as a control 
station or ARC.

2.4.1.1 Phone Prefix A menu option that specifics the phone prefix. This is a four-digit telephone 
prefix that is used to select tone and pulse dialing and enter a delay to wait for 
a dial tone. This sequence is pre-dialled by each of the telephone numbers.
- Press #0 to insert G.
- Press #1 to insert a star.
- Press #2 to insert #.
- Press #3 to insert a four-second delay.
- Press #4 to insert P (this enables pulse dialing).
If a four-second delay is programmed at the first digit, the panel does not wait 
for a dial tone before starting to dial the number. Select this option when the 
phone system has a poor quality dial tone or does not generate a dial tone.

2.4.1.2 Phone Numbers A menu entry that groups phone number reporting options. 

2.4.1.2.1.1 Phone Number A menu option that sets the phone number to which events are reported. The 
control panel can report to up to six phone numbers.

2.4.1.2.1.2 Account Code A menu option that specifies the unique code sent from the modem in the 
control panel to the selected phone number. This code is used to identify and 
charge the user. Separate account codes can be set up for each phone 
number and each partition. This is also known as the account number. The 
letters B, C, D, E and F can be included in control panel account codes. 

2.4.1.2.1.3 Protocol A menu option that sets the communicator format used to transmit to the 
receiver connected to a phone. Up to six phones can be set up. Multiple 
formats are available, such as Contact ID, SIA, 4+2 and pager format. Contact 
ID and SIA are the recommended formats. 
Consult the instructions for your central station receiver to determine which 
format is compatible.

2.4.1.2.1.4 Events A menu entry that groups settings that control which events are reported for 
phone communication.

2.4.1.2.1.4.1 Arm/Disarm/Alarm A menu entry that groups the events that are reported to the selected phone 
number. 

2.4.1.2.1.4.1.1 Alarms A menu option that sends a report to the selected phone number when an 
alarm occurs. 

2.4.1.2.1.4.1.2 Alarm Restores A menu option that sends a report to the selected phone number when the 
alarm has been restored after an alarm. 

2.4.1.2.1.4.1.3 Opening/Closings A menu option that sends a report to the selected phone number stating when 
the system is opened (disarmed) and closed (armed).  

2.4.1.2.1.4.1.4 Zone Bypass and Restores A menu option that sends a report to the selected phone number when a zone 
is bypassed. A report is also sent when the zone is restored (un-bypassed). 

2.4.1.2.1.4.2 Tamper/Trouble A menu entry that groups together the tamper and trouble events that are 
reported to the selected phone number.
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2.4.1.2.1.4.2.1 Tampers and Restores A menu option that sends a report to the selected phone number when a 
tamper occurs. A report is also sent when the tamper is no longer active. 

2.4.1.2.1.4.2.2 Zone Trouble and Restores A menu option that sends a report to the selected phone number when a zone 
trouble condition occurs. A report is also sent when the trouble condition is no 
longer active. 

2.4.1.2.1.4.2.3 Expander Trouble and Restores A menu option that sends an expander trouble and restore report to the 
selected phone number.

2.4.1.2.1.4.2.4 Siren/Phone Faults and Restores A menu option that sends a report to the selected phone number when a siren 
or phone fault occurs. A restore report is sent when the fault is fixed. 

2.4.1.2.1.4.2.5 RF Sensor Lost and Restores A menu option that sends a report to the selected phone number when an RF 
sensor is missing.  A restore report is sent to the central station when the 
receiver receives a valid signal from the lost transmitter. 

2.4.1.2.1.4.2.6 RF Low Battery and Restores A menu option that sends a report to the selected phone number when a low 
battery condition occurs in an RF sensor. A restore report is also sent when 
the low battery condition is no longer active.

2.4.1.2.1.4.3 Power A menu entry that groups the power events that are reported to the selected 
phone number.

2.4.1.2.1.4.3.1 Power Trouble and Restores A menu option menu option that reports mains failure, mains restore, low 
battery and low battery restore events to the selected phone number. 

2.4.1.2.1.4.3.2 Aux Overcurrent and Restores A menu option that sends a report to the selected phone number when too 
much current is detected. A restore report is also sent when the overcurrent 
condition is fixed. 

2.4.1.2.1.4.4 Communications A menu entry that groups together the communication events that are reported 
to the selected phone number.

2.4.1.2.1.4.4.1 Fail to Communicate A menu option that reports a fail to communicate event to the selected phone 
number.  

2.4.1.2.1.4.4.2 Test Reports A menu option that sends a test report to the selected phone number at pre-
programmed intervals. The units can be set in days or hours.  

2.4.1.2.1.4.5.1 Program/Download A  menu option that reports programming and up/download events to the 
selected phone number.

2.4.1.2.1.4.5.2 Zone Inactivity Monitor A menu option that sends a report to the selected phone number  when a zone 
inactivity event occurs.

2.4.1.2.1.5 Fast Format Channels A menu option that specifies which Fast Format channels are enabled. These 
are grouped as Channels 1 – 8 and Channels 9 – 16. 

2.4.1.3 Partition Account Codes A menu option that lists the account codes for each partition. The account 
code is sent when the relevant partition is reported. 

2.4.1.4 Dial Attempts A menu entry that groups dialling options.

2.4.1.4.1 ARC Dial Attempts A menu option that specifies the number of dial attempts (1 to 15 attempts) 
that the communicator makes when reporting to the central station. 

2.4.1.4.2 FTC Dial Attempts A menu entry that groups options related to the number of attempts that are 
made to a specified phone number, before the Fail To Communicate condition 
appears. 

2.4.1.4.3 Voice/Siren Dial Attempts A menu option that specifies the number of dial attempts (1 to 15) that the 
communicator makes for voice dialing, pager or Siren Tone formats.
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2.4.1.5 Dialler Output Level A menu option that sets the volume of the output tone. The Dialler Output 
Level can only be used in combination with the stand-alone ISDN dialler 
TDA2001.

2.4.1.6 Dialler Abort Delay A menu option that creates a delay, programmed in seconds, in reporting an 
alarm to the central station. 

2.4.1.7 Listen-in Time A menu option that sets the length of time the central station can listen for 
sounds of intrusion by means of microphones at the alarm site. 

2.4.1.8 Send Restores A menu entry that groups restore report options. Each option specifies a time 
at which the restore report is sent to the central station. Restores can be sent 
As They Occur, At Disarm or For Zones On Siren Timeout. 

2.4.1.8.1 At Disarm A menu option that sends a restore report to the central station when a code is 
entered to disarm the system. 

2.4.1.8.2 For Zones On Siren Timeout A menu option that sends a restore report to the central station when the siren 
times out.

2.4.2 Up/Download A menu entry that groups options used to control download sessions between 
the up/download software and the control panel. 

2.4.2.1 Call Back Number A menu option that specifies the telephone number that the control panel dials 
if the Call Back Req’d option is enabled.

2.4.2.2 Access Code A menu option that specifies the eight-digit access code sent by the up/
download software to the control panel. The panel permits downloading to 
occur when it receives this code. 

2.4.2.3 Call Back Reqd A menu option that controls access of the up/download software to the control 
panel. When the software calls the control panel, the panel answers the call 
and then hangs up. After approximately 36 seconds, the panel calls the 
software back.

2.4.2.4 Rings to Answer A menu option that sets the number of rings that must occur before the panel 
answers to start a download session. If the value is 0, the panel will never pick 
up the phone line. 

2.4.2.5 Answer Machine Defeat A menu entry used to defeat an answering machine. If two-call Answer 
Machine Defeat AMD is enabled, two telephone calls are required to defeat 
the answering machine. On the first call, the phone rings once or twice. The 
control panel detects the rings and starts a 45-second timer. During this timer, 
the control panel answers the next call on the first ring. This is not 
recommended for commercial applications.

2.4.2.6 Call PC on Autotest A menu option that allows the panel to use call back when the central station 
performs an autotest. After the test report is delivered to the central station, the 
panel calls the up/download software using the call back phone number. 
Actions, such as upload event log and download phone numbers, can be 
selected in the up/download software. 

2.4.2.7 Require Code for Download A menu option that requires a user code to be entered before downloading can 
start.

2.4.2.8 Lockout A menu entry that groups options that lock certain system functions. 

2.4.2.8.1 System Shutdown A menu option that allows the up/download software to shutdown the control 
panel. This option can be set only from the up/download software. The 
shutdown LCD message is shown to explain the reason for the shutdown. 
During shutdown the system is completely inactive. It is not possible to arm/
disarm the system and no reports or sirens are activated. 

2.4.2.8.2 Local Programming A Communications menu option that disables the installer menu. This option 
can be set only through the up/download software. 
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2.3.2.8.3 Comms Settings A menu option that prevents the installer changing the communication settings 
(telephone numbers, account codes and so on). This option must be set using 
the up/download software.

2.4.2.8.4 Download Settings A menu option that prevents the installer changing the following download 
settings: 
Answer Machine Defeat
Call Back Req’d
Lockout>System Shutdown
Lockout>Local Programming
Lockout>Comms Settings
Lockout>Download Settings
Call PC on Autotest
This option must be set through the up/download software. 

2.4.3 Autotest A menu entry that groups options that configure the automatic test run by the 
system. 

2.4.3.1 Autotest Control A menu option that specifies whether the autotest occurs after a specified 
number of days or hours. The autotest can be suppressed if another report 
has been sent.

2.4.3.2 Interval A menu option that sets the length of time between autotests. The unit is set in 
autotest control. The Hour and Minute options set the time at which the test is 
performed. 

2.4.3.5 Time Since Test A menu option that sets the length of time since the last autotest. It controls 
when the next autotest report is sent to the central station.

2.4.4 Reporting A menu entry that groups reporting options.

2.4.4.1 Partition Reports A menu option that specifies the events that are enabled for each partition. 
Events specified in this option are related to all partitions in the system. 

2.4.4.1.1 Opening/Closings A menu option that enables opening/closings reporting. 

2.4.4.1.2 Zone Bypass A menu option that that sends a report to the central station when zones are 
bypassed.

2.4.4.1.3 Zone Restore A menu option that sends a report to the central station when zones are 
restored.

2.4.4.1.4 Zone Trouble A menu option that sends a report to the central station when a zone trouble 
condition occurs. 

2.4.4.1.5 Zone Tamper A menu option that sends a report to the central station when a zone tamper 
occurs. 

2.4.4.1.6 Cancel A menu option that enables cancel reporting. A cancel report is sent to the 
central station when the system is disarmed (within the time specified by the 
dialler delay) after an alarm. 

2.4.4.1.7 Recent Closing A menu option that sends a report to the central station if an alarm occurs 
within five minutes after the panel has been armed. The user number that 
armed the system is also sent.

2.4.4.1.8 Exit Error A menu option that specifies that the control panel sends an exit error report if 
an entry/exit zone is faulted when the exit delay expires. This report is sent 
along with the user number that armed the system, if the panel is not disarmed 
before the entry delay expires. The alarm report is also sent. Even if this 
feature is not enabled, the siren sounds if any entry/exit zone is faulted when 
the exit delay expires.  

2.4.4.2 System Reports A menu entry that groups options relating to system reports. 
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2.4.4.2.1 Tamper/Trouble A  menu entry that groups together the tamper and trouble events that are 
reported to the central station.

2.4.4.2.1.1 Box Tamper A menu option that enables the box tamper switch on the control panel. The 
CSx75 has an input for a normally closed tamper switch. When opened, a box 
tamper is reported as an event.

2.4.4.2.1.2 Expander Trouble A menu option that sends a report to the central station when an expander 
trouble condition occurs. 

2.4.4.2.1.3 Siren Supervision A menu option that monitors the siren to detect cut wires. If the wires are cut, 
the control panel sends a report to the central station.

2.4.4.2.1.4 RF Sensor Lost A menu option that sends a report to the central station, when an RF sensor is 
missing. 
RF sensors send out supervision signals every 15 or 64 minutes, depending 
on the frequency. An RF receiver must receive these signals within a specified 
time window. This window is set by the Supervision timer. If the RF receiver 
does not receive these signals during the time window, the RF sensor is 
considered missing.

2.4.4.2.1.5 RF Low Battery A menu option that sends a report to the central station when a low battery 
condition occurs in an RF sensor. 

2.4.4.2.2 Power A menu entry that groups the power events that are reported to the central 
station. 

2.4.4.2.2.1 Mains Failure A menu option that sends a report to the central station when the mains power 
supply fails. A delay time can be set for this report. 

2.4.4.2.2.2 Low Battery A menu option that enables low battery reporting on the control panel.

2.4.4.2.2.3 Aux Overcurrent A menu option that enables overcurrent reporting. A report is sent to the 
selected central station when too much current is drawn from a device 
powered by the system. 

2.4.4.2.3 Communications A menu entry that groups together the communication events that are reported 
to the central station.

2.4.4.2.3.1 Phone Line Cut A menu option that sends a report is sent to the central station the moment the 
phone line cut is restored. 

2.4.4.2.3.2 Fail to Communicate A menu option that sends a report to the central station when the system has 
failed to communicate with the central station after the number of attempts set 
in FTC Dialler Attempts. The report is sent when communication with the 
central station has been restored.

2.4.4.2.3.3 Autotest A menu option that enables reporting of autotest events to the central station 
at a specified interval. 

2.4.4.2.3.4 Autotest Disarmed No Call A menu option that allows test calls to be made only when the system is 
armed.

2.4.4.2.4.1 Log Full A menu option that sends a report to the central station when the event log is 
full. 

2.4.4.2.4.2 Start/End Programming A menu option that causes reports to be sent to a specified phone number. A 
report is sent when local programming begins and ends. 

2.4.4.2.4.3 End Download A menu option that sends a report to the central station when downloading 
from the up/download software to the control panel is complete. 

2.4.4.2.5 Bypass on Force Arm A menu option that enables bypass reporting when a zone is force armed. 
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2.4.4.2.6 First to Open/Last to Close A menu option that sends a report to the central station stating when the 
system opened and closed. This option can only be used in a multi-partitioned 
system.
A report is sent stating the first area opened. A log is then kept recording when 
the other areas opened and when they closed. This information is sent in a 
second report when the last open area closes. 

2.4.4.3 Report Codes A menu option that groups codes that are sent to the central station when a 
particular event occurs.

2.4.4.3.1 Zone Types A menu entry that groups all reporting codes for the selected zone type. 

2.4.4.3.1.1.1 SIA Code A menu option that sets the SIA code reported for the selected zone type. 

2.4.4.3.1.1.2 Contact ID Code A menu option that specifies the contact ID code to be used when reporting 
the selected zone type. 

2.4.4.3.1.1.3 
2.4.4.3.2.1.1
2.4.4.3.2.1.1
2.4.4.3.3.1.1
2.4.4.3.3.2.1
2.4.4.3.4.1.1
2.4.4.3.5.1.1
2.4.4.3.6.1.1
2.4.4.3.6.2.1
2.4.4.3.7.1.1

FF Channel A menu option that specifies that the Fast Format channel format is used to 
report the selected zone, zone type or event.
Other options with this definition include:

2.4.4.3.1.1.4
2.4.4.3.3.2.2
2.4.4.3.5.1.2
2.4.4.3.6.1.2

FF Restore Channel A menu option that sets the channel used by the selected zone, zone type or 
event for FF channel restore events.

2.4.4.3.1.1.5
2.4.4.3.2.1.2
2.4.4.3.3.1.2
2.4.4.3.3.2.3
2.4.4.3.4.1.2
2.4.4.3.5.1.3
2.4.4.3.6.1.3
2.4.4.3.6.2.2
2.4.4.3.7.1.2

TELIM Channel A menu option that specifies that the TELIM channel format is used to report 
the selected zone, zone type or event. 

2.4.4.3.1.1.6 TELIM Code A menu option that specifies the text message that is sent to the receiver with 
the TELIM channel. This message provides extra information.

2.4.4.3.1.1.7
2.4.4.3.2.1.3
2.4.4.3.3.1.3
2.4.4.3.3.2.4
2.4.4.3.4.1.3
2.4.4.3.5.1.4
2.4.4.3.6.1.4
2.4.4.3.6.2.3
2.4.4.3.7.1.3

4+2 Code A menu option that specifies the event code sent to the central station 
indicating a 4+2 alarm. 

2.4.4.3.1.1.8
2.4.4.3.3.2.5
2.4.4.3.5.1.5
2.4.4.3.6.1.5

4+2 Restore Code A menu option that specifies the event code sent to the central station 
indicating a 4+2 restore. 
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2.4.4.3.1.1.9
2.4.4.3.2.1.4
2.4.4.3.3.1.4
2.4.4.3.3.2.6
2.4.4.3.4.1.4
2.4.4.3.5.1.6
2.4.4.3.6.1.6
2.4.4.3.6.2.4
2.4.4.3.7.1.4
2.4.4.3.8.1.1

200Bd FSK Channel A menu option that sets the channel used by the selected zone, zone type or 
event for 200Bd FSK protocol. The zones between 1 and 99 can be directed to 
separate channels. The zones between 100 and 168 follow the 200Bd FSK 
Channel as specified on the zone type. 

2.4.4.3.1.1.10
2.4.4.3.5.1.7
2.4.4.3.3.2.7
2.4.4.3.6.1.7

200Bd FSK Restore Channel A menu option that sets the channel used by the selected zone, zone type or 
event for 200Bd FSK protocol restore events.

2.4.4.3.1.1.11
2.4.4.3.2.1.5
2.4.4.3.3.1.5
2.4.4.3.3.2.8
2.4.4.3.4.1.5
2.4.4.3.5.1.8
2.4.4.3.6.1.8
2.4.4.3.6.2.5
2.4.4.3.7.1.5

Voice Channel A menu option that sets the voice message to be reported for the selected 
zone type or event. The channel corresponds to one of the 15 pre-recorded 
voice messages. 

2.4.4.3.2 Open/Close/Cancel A menu entry that groups all reporting codes for opening, closing and cancel 
events.

2.4.4.3.2.1 Opening A menu entry that groups the codes reported on an opening (disarm) event.  

2.4.4.3.2.2 Closing A menu entry that groups the report codes sent to the central station when the 
system arms. 

2.4.4.3.2.3 Partarm A menu option that groups the report codes sent to the central station when 
the system is part armed. 

2.4.4.3.2.4 Recent Closing A menu entry that specifies the code (SIA/ContactID/FastFormat/200Bd FSK) 
or voice channel to be used for recent closings events. 

2.4.4.3.2.5 Exit Error A menu entry that groups the report codes sent to the central station if an 
alarm is created during the exit time. 

2.4.4.3.2.6 Cancel A menu entry that groups the report codes sent to the central station when a 
Cancel event occurs. 

2.4.4.3.3 Tamper/Trouble A menu entry that groups together the codes used to report tamper and 
trouble events to the central station.

2.4.4.3.3.1 B-Alarm Trip A menu entry that groups the report codes sent to the central station when a 
B-Alarm Trip event occurs. 

2.4.4.3.3.2 Zone Tamper A menu entry that groups report codes that are sent to the central station when 
a zone tamper event occurs. 

2.4.4.3.3.3 Zone Trouble A menu entry that groups report codes that are sent to the central station when 
a zone trouble condition occurs. 

2.4.4.3.3.4 Siren Tamper A menu entry that groups report codes sent to the central station when a siren 
tamper has occurred. 

2.4.4.3.3.5 Box Trouble A menu entry that groups the report codes sent to the central station when a 
Box Trouble condition is activated. 

2.4.4.3.3.6 Expander Trouble A menu entry that groups report codes sent to the central station when an 
expander trouble event occurs. 
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2.4.4.3.3.7 RF Sensor Lost A menu entry that groups report codes sent to the central station when an RF 
sensor lost event occurs. 

2.4.4.3.3.8 RF Low Battery A menu entry that specifies the code (SIA/ContactID/FastFormat/200Bd FSK) 
or voice channel to be used for RF Low Battery events. 

2.4.4.3.4 Keypad A menu entry that groups the report codes sent to the central station for 
keypad related events. 

2.4.4.3.4.1 Duress A menu entry that groups the report codes sent for a duress event.
A duress situation is one in which a user is being threatened and forced to 
disarm the system. A duress code is entered to disarm the system as normal 
and a duress alarm is activated.

2.4.4.3.4.2 Keypad Tamper A menu entry that groups the report codes sent for the keypad tamper event.

2.4.4.3.4.3 Keypad Panic A menu entry that groups the report codes sent for the keypad panic event.

2.4.4.3.4.4 Keypad Aux 1 (Fire) A menu entry that groups the report codes sent for the keypad aux 1 (fire) 
event.

2.4.4.3.4.5 Keypad Aux 2 (Medical) A menu entry that groups the report codes sent for the keypad aux 2 (medical) 
event.

2.4.4.3.5 Power A menu entry that groups report codes that are sent to the central station when 
power related events occur. 

2.4.4.3.5.1 Mains Failure A menu entry that groups the codes used to report a mains failure event. 

2.4.4.3.5.2 Low Battery A menu entry that groups report codes sent to the central station for a low 
battery event. A restore report is sent to the central station when this condition 
is no longer active. 

2.4.4.3.5.3 Aux Overcurrent A menu entry that groups the report codes sent to the central station when an 
overcurrent event occurs. 

2.4.4.3.6 Communications A menu entry that groups together the codes used to report communication 
events to the central station.

2.4.4.3.6.1 Phone Line Cut A menu entry that groups the report codes sent when a phone line is cut. 

2.4.4.3.6.2 Fail to Communicate A menu entry that groups the report codes sent to the central station when a 
fail to communicate event occurs. 

2.4.4.3.6.3 Autotest A menu entry that groups the report codes sent to the central station when an 
autotest is performed. 

2.4.4.3.7.1 Log Full A menu entry that groups the report codes sent to the central station when the 
event log is full. 

2.4.4.3.7.2 Start Programming A menu entry that groups the reporting codes sent to the central station when 
programming starts.

2.4.4.3.7.3 End Programming A menu entry that groups the report codes that are sent to the central station 
when the installer leaves programming mode.

2.4.4.3.7.4 End Download A menu entry that groups the report codes sent to the central station when 
downloading is complete. 

2.4.4.3.8 Zones 200Bd FSK A menu entry that groups 200Bd FSK protocol options.

2.4.5 Format Override A menu option that allows you to build communication formats if using a non-
standard central station. Consult technical support before using this option.  

2.4.5.1 Features 1 A menu option that allows you to configure your own reporting protocol based 
on the options enabled.
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2.4.5.2 Features 2 A menu option that allows you to configure your own reporting protocol based 
on the options enabled.

2.5 Partition Settings A  menu entry that groups all partition settings. These settings include partition 
features, partition timers and so on. 

2.5.1 Timers A  menu entry that groups timer options. 

2.5.1.1 Entry 1 A menu option that sets the time within which the user must disarm the system 
before a full alarm occurs. This time can be between 10 and 255 seconds. 

2.5.1.2 Exit 1 A menu option that sets the time within which the user must leave the 
protected zone after arming the system before a full alarm occurs. This time 
can be between 10 and 255 seconds.

2.5.1.3 Entry 2 A menu option that sets the time within which the user must disarm the system 
before a full alarm occurs. This time can be between 10 and 255 seconds. 

2.5.1.4 Exit 2 A menu option that sets the time within which the user must leave the 
protected zone after arming the system before a full alarm occurs. This time 
can be between 10 and 255 seconds. 

2.5.2 Feature Select A menu entry that groups all optional features relating to partitions. 

2.5.2.1 Arming A menu entry that groups the arming characteristics of the selected partition. 

2.5.2.1.1 Quick Arm A menu option that enables the function keys for part arming and for full 
arming. These options work on a single-area keypad only. 

2.5.2.1.2 Re-exit A menu option that enables the exit delay without disarming the system. 
The exit delay can be restarted if in arm stay mode by using the Arm Away 
command in the user menu or by pressing a function key programmed by the 
installer to activate arm away. 

2.5.2.1.3 Silent Auto Arm A menu option that arms the system automatically at a preset time without the 
keypad buzzer sounding.

2.5.2.1.4 Silent Exit Always A menu option that prevents the exit time buzzer activating whenever the 
system is armed or during the re-exit time.

2.5.2.1.5 Arming with Zone Lost A menu option that allows the system to be armed when RF zones have not 
reported to the RF receiver for a period longer than the normal supervision 
window. When this option is disabled, the system cannot be armed when an 
RF zone is lost. 

2.5.2.2 Keypads A menu entry that groups keypad options. 

2.5.2.2.1 Silent PA (7+9) A menu option that prevents all audible and visual indications when a personal 
attack alarm occurs.

2.5.2.2.2 Audible PA (7+9) A menu entry that causes the keypad to beep and sounds the internal and 
external sirens when a PA alarm is activated. 

2.5.2.2.3 Fire/Aux 1 (1+3) A menu option that activates keys 1 and 3 as the fire alarm combination keys. 
When this option is enabled and these keys are pressed at the same time, a 
fire alarm is generated. 

2.5.2.2.4 Medical/Aux 2 (4+6) A menu option that activates keys 4 and 6 as the medical alarm combination 
keys. When this option is enabled and these keys are pressed at the same 
time, a medical alarm is generated.

2.5.2.2.5 Multi Code Tamper A menu option that disables the keypad for 60 seconds and sends a tamper 
signal to the central station if 30 key presses are entered without producing a 
valid code.  

2.5.2.2.6 LED Extinguish A menu option that enables or disables LED Extinguish for all partitions. 
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2.5.2.3 Bypass To temporarily remove a zone from operation when arming the system. 
A menu entry that groups bypass options.

2.5.2.3.1 Auto Bypass A menu option that automatically bypasses interior follower zones if no exit is 
detected during the exit delay time. The exit is detected by the opening and 
closing of an entry/exit zone.

2.5.2.3.2 Code Required A menu option that specifies whether a user code is required for bypassing 
zones. 

2.5.2.3.3 Sounder Alert A menu option that activates the keypad buzzer when a user arms the system 
with one or more zones bypassed.

2.5.2.3.4 Bypass Toggle A menu option that allows an interior zone be bypassed or included while the 
system is armed.

2.5.2.4.1 Mains/Batt Sounder Alert A menu option that causes the keypad sounder to beep upon arming or 
disarming if the mains power is missing or a low battery is detected.

2.5.2.4.2 Zone Lost Gives Tamper A menu option that sends a report to the central station when a wireless zone 
sensor is lost and activates a tamper alarm. Different reports are sent 
depending on the system status. When armed the tamper and the lost report 
are sent. When disarmed only the lost report is sent. 

2.6 System Settings A menu entry that groups programmable system features and reporting 
options. 

2.6.1 Timers A menu entry that groups timer options. 

2.6.1.1 Inputs A menu entry that groups time settings relating to inputs.   

2.6.1.1.1 Fire Verification Time A menu option that sets the amount of time within which a second trip must 
occur on a smoke detector in order to generate an alarm.

2.6.1.1.2 Zone Inact. Unit A menu option that allows the zone inactivity option to be configured in hours 
or days. 

2.6.1.1.3 Zone Inactivity Monitor A menu option that sets the zone inactivity time. It is possible to specify this 
time in minutes or hours. 

2.6.1.1.4 Double Knock Time A menu option that sets the double knock time. If a double knock zone is 
opened twice within this time, an alarm is activated. 

2.6.1.1.5 Double Knock Open Time A menu option that sets the double knock open time. If a double knock zone 
remains open longer than this time, an alarm is activated. 

2.6.1.1.6 B-Alarm Timer A menu option that sets the time during which a second B-Alarm Trip event is 
treated as a full burglary alarm. 

2.6.1.2 Power A menu entry that groups the timer options relating to power events. 

2.6.1.2.1 Batt Dynamic Test Duration A menu option that sets the length of time that the control panel performs the 
Dynamic Battery test. This can be between 0 to 255 minutes where 0 is no 
test. 

2.6.1.2.2 Mains Report Delay A menu option that sets the length of time between detecting a mains failure 
on the control panel and sending a report to the central station. The restore 
event is sent four minutes after the mains is restored. 

2.6.1.2.3 Power Up Delay A menu option that sets the time between mains restore after a power failure 
and the system powering up again. This can be set from 0-60 seconds. 0 
means no power up delay.

2.6.1.3 Sounders A menu entry that groups timers for the internal siren, external siren and chime 
duration on the keypad. 
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2.6.1.3.1 Internal Siren Timeout A menu option that sets the length of time the internal siren rings before 
automatically cutting out. This time can be between 0 and 255 minutes. When 
set to 0, the siren is active until a valid code is entered on the keypad.

2.6.1.3.2 External Siren Timeout A menu option that sets the length of time an external sounder/siren rings 
before automatically cutting out. A new alarm trip reactivates the external 
sounder for the length of time specified in this option. This time can be 
between 0 and 255 minutes. When set to 0, the siren is active until a valid 
code is entered on the keypad.

2.6.1.3.3 Chime Time A menu option that sets the length of time that the chime operates. This time 
can be set in 50 ms (1/20th second) increments from 0-12 seconds. 0 = 
follows zone.

2.6.1.4 Communications A menu option that groups timers for communication events.

2.6.1.4.1 Phone Line Cut Delay A menu option that sets the length of time before a phone line cut is signalled 
after a phone line cut is detected. 
A phone line fault is displayed in Service Check>Reset when Phone Line Cut 
Delay = 0.

2.6.2 Feature Select A menu entry that groups all optional features relating to control panel system 
settings. 

2.6.2.1 Inputs A menu entry that groups options that enable features relating to inputs. 

2.6.2.1.1 On-board 8 zones A menu option that disables the zones on the control panel. This provides a 
completely wireless alarm system.

2.6.2.1.2 Box Tamper A menu option that enables the box tamper switch on the control panel. The 
CSx75 has an input for a normally closed tamper switch. When opened, a box 
tamper is reported as an event.

2.6.2.1.3 2-wire Smoke Detectors A menu option that enables the 2-wire smoke detector in the control panel. A 
2-wire smoke detector is connected to the control panel with two wires instead 
of four. A maximum number of three 2-wire smoke detectors can be 
connected. 

2.6.2.1.4 Force Default Zone Types A menu option that uses the default zone types in the country defaults for the 
selected country rather than configured zone types. 

2.6.2.2 Diagnostics A menu entry that groups test options. These options specify the tests that can 
be performed on the control panel. 

2.6.2.2.1 Batt Presence Test A menu option that enables a test to determine whether the battery is 
connected to the system. This test is usually performed automatically when 
the system is first powered up and periodically thereafter. 

2.6.2.2.2 Dynamic Batt Test at Arming A menu option that enables a dynamic battery test at arming. This is an 
automatic test carried out by the control panel at the moment of arming to 
ensure the battery is working properly. The panel lowers the battery charging 
voltage in order to draw current from the battery. If the system is not armed 
between 00:01 and 23:59, the test is performed at 00:00.

2.6.2.2.3 Manual Siren Test A menu option that activates the siren test when the Do Self Test command is 
selected from the user menu. 

2.6.2.2.4 Manual Dialler Test A menu option that includes a dialler test in the user’s manual test. A manual 
test call is made to the central station and the corresponding signal is 
transmitted.

2.6.2.2.5 Walktest A menu option that enables walktest mode. This mode allows an authorised 
user to test the detection devices and to verify that all zone inputs operate 
correctly. 

2.6.2.3 Clock A menu entry that groups options that configure the clock. 
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2.6.2.3.1 Mains Frequency A menu option that provides an accurate clock in situations where different 
mains frequencies are used: 50 Hz or 60 Hz are possible selections. 

2.6.2.3.2 Lost Clock Indication A menu option that enables the service message ‘Control Loss of time'. 

2.6.2.3.3 Summer/Winter Time A menu option that allows automatic switching of summer and winter time.

2.6.2.4.1 Fire Siren A menu option that sets the type of siren activated when a fire alarm occurs. 
This can be either yelping or temporal. 

2.6.2.4.2 Master Code Resets Tamper Memory A menu option that allows a master user to reset the system after a tamper 
alarm. If this option is disabled, an installer must reset the system each time a 
tamper occurs. The user should identify the cause of the alarm before arming 
the system and contact the installer if necessary.

2.6.2.4.3 Transformer Size A menu option that specifies the size of the transformer that is used. There are 
two possibilities: 25 VA or 40/50 VA. Depending on the setting, the power 
supply of the CS275, CS375, CS575 and CS875 can deliver 0.5 A (25 VA 
setting) or 1 A (40/50VA setting) on the AUX terminals. If this is not sufficient, 
additional CS320 power modules can be used. 

2.6.2.4.4 All Abort A menu option that aborts all on-board communications. Any alarms in the 
dialler buffer waiting to be sent to the central station are cancelled. 

2.6.2.4.5 Blank Keypads A menu option that allows an authorised user to turn off all LEDs (except the 
Power LED) on the keypad and to lock the keypad so that it does not accept 
key presses.

2.6.2.4.6 Reset Tamper Before Arming A menu option that requires you to reset the tamper message after a tamper 
event has occured so that the user can arm the system. To do this, you must 
enter and then leave programming mode. 

2.6.3 Serial Port A menu entry that groups the settings of the on-board Serial RS232 port. 

2.6.3.1 Connection Type A menu option on the serial port that specifies what the serial port is used for. 
It can be set to Serial printer or Home Automation Protocol. 

2.6.3.2 Speed A menu option that sets the data communications speed from the computer to 
the control panel. This can be set from 600 baud to 76.8k baud. It is 
recommended to use the default setting of 9600 baud. 

2.7 Arm Schedules A menu entry that groups scheduling options. These options configure the 
schedules used by the control panel for auto arming. 

2.7.1 Partitions Opening A menu option that specifies the days of the week that each partition is open. 

2.7.2 Partitions Autoarming A menu option that allows the control panel to auto arm at a specified time. At 
this time, the keypad beeps for 50 seconds before the panel arms. The arming 
process is stopped if a code is entered on the keypad. 

2.7.2.1.8 45 Minute Retry A menu option that causes the panel to try to arm after every 45 minutes of 
inactivity until the next opening time, or until the system is armed. The 45-
minute timer is extended when there is activity in the building. This causes the 
Ready LED to turn off and on. If closing reports are sent, the user code is 97.

2.7.3 Schedule Times A menu entry that groups entries related to automatic arming, opening and 
closing schedules.

2.7.3.1 Opening A menu option that sets the time at which the selected schedule enters the 
open state. At this time, the control panel enables codes designated as ‘arm 
only after closing’. 
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2.7.3.2 Closing/Autoarm A menu option that sets the time after which the partitions selected in 
Partitions Autoarming start to arm automatically. Users with arm only after 
closing rights can arm the partitions selected in Partitions Opening only after 
this time. 

2.8 Home Automation A menu entry that groups options relating to the home automation system.

2.8.1 Protocol A menu option that sets the home automation protocol to binary or ASCII. 

2.8.2 Transition Broadcasts A menu entry that groups methods of sending updated information to the 
home automation system from the RS232 interface. 

2.8.2.1 Interface Configuration A menu option that enables interface configuration transition broadcasts. 
These broadcasts transmit changes to zones, partitions and so on to the home 
automation system. 

2.8.2.2 Zone Status A menu option that sends the entire status for one zone. 

2.8.2.3 Zone Snapshot A menu option that allows the control panel to send a snapshot of the current 
status of the zones. A snapshot sends the tripped, bypassed, trouble/tamper 
and alarm memory state for sixteen zones. This is done on a zone-by-zone 
basis. 

2.8.2.4 Partition Status A menu option that enables partition status transition broadcasts. 

2.8.2.5 Partition Snapshot A menu option that enables partition snapshot transition broadcasts. 

2.8.2.6 System Status A menu command request sent by the home automation system to the CS586 
direct connect module to transmit the system status. 

2.8.2.7 X-10 Message A menu option that enables X-10 message transition broadcasts. 

2.8.2.8 Log Event A menu option that enables log event transition broadcasts. 

2.8.2.9 Keypad Message A menu option that allows the home automation protocol to send different end-
user messages to the keypad display. 

2.8.3 Commands/Requests A menu option that performs commands sent to the serial port module by the 
home automation system. 

2.8.3.1 Misc Requests A menu entry that groups home automation requests. 

2.8.3.1.1 Interface Configuration A menu option that enables the control panel to respond to interface 
configuration requests sent by the home automation system. 

2.8.3.1.2 Zone Name A menu option that enables the home automation system to change zone 
names on the control panel. 

2.8.3.1.3 Zone Status A menu option that enables the control panel to respond to zone status 
requests sent by the home automation system. 

2.8.3.1.4 Zone Snapshot A menu option that enables the control panel to respond to zone snapshot 
requests sent by the home automation system.  

2.8.3.1.5 Partition Status A menu option that enables the control panel to respond to partition status 
requests sent by the home automation system. 

2.8.3.1.6 Partition Snapshot A menu option that enables the control panel to respond to partition snapshot 
requests sent by the home automation system. 

2.8.3.1.7 System Status A menu request sent by the home automation system to the CS586 direct 
connect module to view the system status of the entire system. 

2.8.3.1.8 Log Event A menu option that causes the control panel to log an event each time an 
output on the CS507 output expander module trips and each time an output 
restores. 
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2.8.3.2 Misc Commands A menu entry that groups home automation commands. 

2.8.3.2.1 X-10 Message A menu option that enables the control panel to respond to X-10 message 
commands sent by the home automation system. 

2.8.3.2.2 Store Comms Event A menu command that allows a device connected to the serial port to send 
reports to the central station using the controls modem.

2.8.3.2.3 Zone Bypass Toggle A menu option that enables the control panel to respond to zone bypass toggle 
commands sent by the home automation system. 

2.8.3.3 Programming A menu entry that groups home automation commands. 

2.8.3.3.1 Program Data Request A menu command request sent by the home automation system to the CS586 
Direct Connect module. It is used to read configuration data from the control 
panel through the serial port.

2.8.3.3.2 Program Data Command A menu command request sent by the home automation system to the CS586 
Direct Connect module. It is used to configure the system through the serial 
port.

2.8.3.3.3 User Info Request A menu command that allows the device connected to the serial port to read 
out the programmed settings for a particular user. This can be activated with a 
PIN or without a PIN. 

2.8.3.3.4 Set User Code A menu entry that groups home automation commands. The home automation 
protocol allows new users to be defined in the control panel. These commands 
specify the user’s code.

2.8.3.3.5 Set User Authority A menu entry that groups home automation commands. The home automation 
protocol allows new users to be defined in the control panel. These commands 
specify the user’s authority, for example, and arm/disarm. 

2.8.3.3.3.1 With PIN A menu command request sent by the home automation system to the CS586 
direct connect module to grant user access with a PIN number only. 

2.8.3.3.3.2 Without PIN A menu command request sent by the home automation system to the CS586 
direct connect module to grant user access without a PIN number.

2.8.3.3.6 Set Date/Time A menu command request sent by the home automation system to the CS586 
direct connect module to set the time and date.

2.8.3.4 Keypad Functions A menu entry that groups settings that enable home automation commands 
related to keypads. 

2.8.3.4.1 1st Keypad Function A menu entry that groups keypad options that enable home automation 
commands. The commands activate the primary function of a keypad. These 
options are With PIN and Without PIN. 

2.8.3.4.1.1 With PIN A menu command request sent by the home automation system to the CS586 
direct connect module to grant user access with a PIN number only. 

2.8.3.4.1.2 Without PIN A menu command request sent by the home automation system to the CS586 
direct connect module to grant user access without a PIN number.

2.8.3.4.2 2nd Keypad Function A menu option that enables the home automation command that activates the 
secondary function of a keypad.

2.8.3.4.3 Send Keypad Text A menu command request sent by the home automation system to the control 
panel. It is used in terminal mode to allow the device connected to the serial 
port to put text on the keypad.

2.8.3.4.4 Keypad Terminal Mode A menu option that makes the keypad a home automation terminal when 
requested by the CS586 direct connect module.

Location Term Definition
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2.11 Technical Specifications

2.8.4 LCD Keypad Address A  menu option that uses the programmed keypad address as the keypad 
terminal mode and keypad text. 

Mains power specifications

Mains Input Voltage (25VA Transfo) 230V  - 50Hz - 25VA

Mains Input Voltage (40VA Transfo) 230V  - 50Hz - 40VA

Current consumption at  230V~ (25 VA) 0.108 A

Current consumption at  230V~ (40 VA) 0.173 A

Main board supply voltage 16.5 V ~  typical

Power supply specifications

Power supply voltage 13.8V   ± 2%  

Power supply current (CS275-375 -575-875) 2.0 A max. at 13.8V  ± 2%  

Power supply current (CS175) 1.0 A max. at 13.8V  ± 2%  

Auxiliary Power output (CS275-375 -575-875) 1.2 A max at 13.8V  ± 2%  

Auxiliary Power output (CS175)
Note: maximum permanent current to power devices external to the control 
equipment in the absence of alarm conditions.

0.5 A max at 13.8V  ± 2%  

Battery Power output (CS275-375 -575-875) 0.800 A max at 13.8V  ± 2%  

Battery Power output (CS175) 0.500 A max at 13.8V  ± 2%  

Battery Type and max. capacity (Large Metal Housing for CS575M-CS875M) Lead acid rechargeable 16 Ah 12 V nom.

Battery Type and max. capacity (Polycarbonate Housing for CS275– CS375-
CS575-CS875)

Lead acid rechargeable 10 Ah 12 V nom.

Battery Type and max. capacity (Small Metal Housing for  CS175M–
CS275M-CS575M)

Lead acid rechargeable 7.2 Ah 12 V nom.

Main board consumption (No EOL) 60 mA at 13.8V  ± 2%  

Main board consumption (With EOL on zones, smoke and supervised siren) 91 mA at 13.8V  ± 2%  

Main board consumption (With EOL on zones, smoke and supervised siren) 
and dialer active

105 mA at 13.8V  ± 2%  

Location Term Definition
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General feature specifications

Nr. of combination of codes From 9.999 (4 digits) to 99.999 (6 digits)

End of line resistor (standard) 4,7 KOhm, 2% 0.25W

End of line resistor (2 wire smoke) 560 Ohm, 2% 0.25W

Loop Response Selectable 50 msec or 500 msec

Built-in Siren Driver 2 tone ( Temporal and Yelp)

On-board Outputs 
Note: see general installation guidelines

Aux Outputs (Relay) NC/NO Relay Rating: 1 A at 13.8 V 

Aux Outputs (OC) Electronic output Rating: 40 mA at 13.8 V 

External siren Electronic output Rating: 1 A at 13.8 V 

Internal siren Electronic output Rating: 1 A at 13.8 V 

Environmental (Housing) IP protection grade IP30

Large metal housing Dimensions 315x447x80 mm Colour Beige

Small metal housing Dimensions 250x250x80 mm Colour Beige

Large polycarbonate housing Dimensions 257x400x112 mm Colour Grey

Small polycarbonate housing Dimensions 257x228x112 mm Colour Grey

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 4.500 Kg

Fuses

* Mains fuse F315 mA L 20x5 F1 Battery T 5 A  L      20x5
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Chapter 3: Programming the current keypads

3.1 Overview
Each keypad has a sounder and an LCD display that displays messages in a number of possible languages. 

Each keypad must be enrolled, defaulted to the country settings for the selected country and defaulted to the 
factory defaults before starting to program the system. For more information on enrolling and defaulting, see 
chapter B-1 Enrolling modules. 

To program the current keypad, select Installer Menu>This Keypad.

3.2 Configuring keypad features
You can configure the LCD display, the keypad sounder and combination keys. The following example 
configures the keypad so that all codes are displayed as stars rather than in digits. It also configures the keypad 
sounder to beep when a wireless receiver does not report within the supervision window. For more information on 
supervision, see chapter 9.

1. Navigate with the  keys to This Keypad>Keypad Features and press OK.

2. Scroll to Display>Hide PINs>Yes and press OK.

3. The keypad beeps once to confirm the change and returns to Hide PINs.

Armed Zone Info
Service Message
Custom Message
Clock
24-hour Clock
Type OK for Menu
Custom Message Lock
LED Extinguish
Hide PINs
Always Multi-Area

DisplayKeypad Features3.1 3.1.1 3.1.1.1

3.1.1.2

3.1.1.3

3.1.1.4

3.1.1.5

3.1.1.6

3.1.1.7

3.1.1.8

3.1.1.9

Silent Keypad
Ding Dong Chime
5 sec silence
Beep on Panics
Beep on RF loss

Module Number
House Code

(1) Partition 1 Keypad 1

<Language 1>

(1) Zone 1

Custom Message
Shutdown Message

Line 1
Line 2

Zone Names

Partition Names

Copy Language

Language 1

(1) User Name 1

(1) Burglary

(1) Partition 1

3.4.1.1.1

3.5.2.1.4

3.5.2.1.2

3.5.2.1.3

3.5.2.1.5

3.5.2.1.1 3.5.2.1.1.1

3.5.2.1.1.2

3.5.2.1.3.1

3.5.2.1.4.1

Sounds

F1 FunctionFunction Keys

X-10 Devices Device 1

To One Keypad

To All Keypads

Copy Keypad

Text Set Languages

Language Text

User Names

Zone Type Names

Word Library

Partition
Keypad Number
Keypad Defaults
Model
Version
Default Settings

3.2

3.3

3.4

3.5

3.8

3.9

3.1.2

3.1.3
3.1.4

3.1.5

3.1.6

3.2.1

3.3.1

3.4.1

3.4.2

3.5.1

3.5.2

3.5.3

3.5.4

3.5.5

3.1.2.1

3.1.2.2

3.1.2.3

3.1.2.4

3.1.2.5

3.3.1.1

3.3.1.2

3.4.1.1

3.5.1.1

3.5.2.1

3.5.3.1

3.5.4.1

Partitions 2 - 8
Same as above

Keypads 2 - 8
Same as above

Languages 2 - 4
Same as above

Languages 2 - 4
Same as above

Zones 2 - 168
Same as above

Partitions 2 - 8
Same as above

User Names 2 - 99
Same as above

Zone Type Names 2 - 20
Same as above

Devices 2 - 10
Same as above

F2 - F3 Functions
Same as above

Case Tamper
Multi-Area Keypad
Panic Keys
User Phone Editing

3.10

3.1.1.10

3.5.2.1.5.1 Language 1

3.11

3.7

3.6
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4. Navigate with the  keys to Sounds>Beep on RF loss>Yes and press OK.

5. The keypad beeps once to confirm the change and returns to Beep on RF loss.

3.3 Multi-area mode
You can program a keypad to act as a single-area keypad or a multi-area keypad by default. A single-area keypad 
allows the user to arm one area only while a multi-area keypad allows the user to arm one or more areas. A user 
with rights can change a single-area keypad to a multi-area keypad and vice versa. 

1. Navigate with the  keys to This Keypad>Keypad Features>Multi-Area Keypad and press OK.

• Select Yes to set the keypad as a multi-area keypad by default.

• Select No to set the keypad as a single-area keypad by default.

2. Press OK to save the setting. 

3. The keypad beeps once to confirm the change and returns to Multi-Area Keypad.

3.4 Assigning X-10 devices
The keypad can be used to activate selected X-10 devices. The following example programs the module number 
(3) and house code (L) for device 1.  

1. Navigate with the  keys to This Keypad>X-10 Devices>Device 1 and press OK.

2. Scroll to Module Number and press OK.

3. Select 3 and press OK.

4. The keypad beeps once to confirm the change and returns to Module Number.

5. Scroll to House Code and press OK.

6. Select L and press OK.

7. The keypad beeps once to confirm the change and returns to House Code. 

3.5 Copying keypad settings
The current keypad settings can be copied to one or multiple keypads in the system. The following example 
copies the current keypad settings to another keypad in the system. 

1. Navigate with the  keys to This Keypad>Copy Keypad>To One Keypad and press OK.

2. Select the relevant partition number and press OK.

3. Select the number of the keypad to which the settings will be copied and press OK. 

4. The keypad displays the message ‘Copying’ while copying the settings and returns to Keypad # when 
copying is complete.

3.6 Configuring keypad text
You can set several languages on the keypad. The following example configures French as the second keypad 
language.

1. Navigate with the  keys to This Keypad>Text>Set Languages and press OK. 

2. The current language is displayed as Language 1.
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3. Scroll to Language 2 and press OK. 

4. Use the  keys to select Français and press OK.

5. The keypad returns to Set Languages.

6. Repeat these steps to set other languages.

For information on changing the user interface language or setting the keypad messages, see chapter 5.

3.7 Setting the keypad partition and keypad number
When you first power up the keypad, you are prompted to set the language, the default country and the partition 
and keypad number for the current keypad. The keypad can connect to the bus only after you set these numbers. 
The partition number and keypad number prompts are displayed for the initial setting only. To change these 
numbers again, scroll to This Keypad>Partition and This Keypad>Keypad Number.

3.8 Glossary

Location Term Definition

3 This Keypad A menu entry that groups the settings of the current keypad. It allows resetting 
of the keypad, configuration of keypad features and verification of software 
version and models. 

3.1 Keypad Features A menu entry that groups keypad options.

3.1.1 Display A menu entry that groups LCD display options for the keypad. 

3.1.1.1 Armed Zone Info A menu option that enables the mode that displays zone status on the keypad 
when the system is armed. When this mode is disabled, zone status 
information is not displayed when armed.

3.1.1.2 Service Message A menu option that enables or disables the service messages on the keypad. 
A message displayed on the LCD keypad informing the user or installer of a 
system fault. The service message disappears from the keypad when the 
installer enters and leaves programming mode. The message is used as an 
Engineer Reset.

3.1.1.3 Custom Message A menu option that shows or hides the custom message on the LCD keypad. 

3.1.1.4 Clock A menu option that displays the clock on the keypad. This is the internal real 
time clock used for the schedules and autotest intervals. 

3.1.1.5 24-hour Clock A menu option that switches between 24-hour and 12-hour notation. 

3.1.1.6 Type OK for Menu A menu option that enables the menu prompt ‘Type OK for Menu’. 

3.1.1.7 Custom Message Lock A menu option that prevents the customized keypad message being edited.

3.1.1.8 LED Extinguish A menu option that enables or disables LED Extinguish for an individual 
keypad. Both options must be enabled for this feature to work. 
LED extinguish turns off all LEDs on the keypad (except the Power LED) after 
60 seconds without a key press. All LEDs are illuminated again when any key 
is pressed.

3.1.1.9 Hide PINs A menu option that displays the user code as dashes when programming 
codes using the keypad. If this option is disabled, each digit is shown rather 
than displayed as a dash. 

3.1.1.10 Always Multi-Area A menu option that enables a mode on a multi-area keypad in which partition 
status is always displayed regardless of each partition state.

3.1.2 Sounds A menu entry that groups sounder characteristics for the current keypad. It 
defines the events that activate the keypad buzzer.
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3.1.2.1 Silent Keypad A menu option that silences the keypad’s entry/exit sounder and chime only.

3.1.2.2 Ding Dong Chime A menu option that sets the sound a chime makes. It is either a ding dong or a 
beep.  

3.1.2.3 5 sec silence A menu option that silences the pulsing keypad sounder for five seconds when 
a key is pressed. 

3.1.2.4 Beep on Panics A menu option that sounds a keypad beep when the personal attack alarm 
combination keys are held down long enough.

3.1.2.5 Beep on RF loss A menu option that activates the keypad sounder, causing it to beep, when an 
RF zone is lost. This beep indicates that the receiver did not receive the 
supervision signal from the wireless transmitter. 

3.1.3 Case Tamper A menu option that sends a tamper report to the central station and activates a 
siren and/or the keypad when interference with keypad housing occurs. 
A tamper occurs when the casing of a piece of hardware (for example, the 
control panel, sound box or keypad) is interfered with. The CSx75 has an input 
for a normally closed tamper switch. When opened, a box/case tamper is 
reported as an event.

3.1.4 Multi-Area Keypad A menu option that sets the default mode of the selected keypad to multi-area 
mode. This is a mode of operation on a keypad that allows a user or installer 
access multiple partitions within the system and to perform functions in these 
partitions. 
A multi-area keypad can be temporarily switched to operate in single-area 
mode and a single-area keypad can be temporarily switched to operate in 
multi-area mode.  

3.1.5 Panic Keys A menu option that enables panic keys to be programmed. The CSx75 allows 
the user to generate different types of panic by pressing two keys at once. 

3.1.6 User Phone Editing A menu option that allows the user to change the phone numbers used for 
alarm reporting. 
Typically, the installer programs the central station phone numbers and is the 
only person who can change the number. 
However, when voice protocol and siren protocol are used, the user can 
change the phone number. These protocols typically report to the 
homeowner’s mobile phone rather than to the central station. 

3.2 Function Keys A menu entry that groups all programmable function key options. 
Function keys are dedicated for a particular function as programmed by the 
installer. 

3.3 X-10 Devices A menu entry that groups X-10 device options for the selected keypad. 

3.3.1.1 Module Number A menu options menu option that sets the X-10 module number used to 
identify a particular X-10 device on the selected module. 
A CSx75 bus module number is assigned to each system module. The system 
uses this number to identify the module. It is also used to report module 
problems (such as tampers and module supervision lost) to the central station.

3.3.1.2 House Code A menu option that sets the code used to identify a particular premises. It is 
necessary in case any neighbouring premises also has an X-10 home 
automation system. 
More information on the X-10 home automation system can be found at 
www.x-10europe.com.

3.4 Copy Keypad A menu option that copies the current keypad settings to another or multiple 
keypads in the system. 

3.4.1 To One Keypad A menu option that specifies that the current keypad settings are copied to one 
specific keypad. 

Location Term Definition
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3.4.2 To All Keypads A menu option that specifies that the current keypad settings are copied to all 
connected keypads. 

3.5 Text A menu entry that groups the language options of the current keypad. It allows 
the installer to set options such as zone name descriptors and user names.

3.5.1 Set Languages A menu option that selects the keypad language. There are four possible 
languages. 

3.5.2 Language Text A menu entry that groups descriptors such as Custom Message and Shutdown 
Message. These messages are language independent. 

3.5.2.1.1 Custom Message A This Keypad  menu option that edits the custom message. 

3.5.2.1.2 Shutdown Message A menu option that edits the message that is displayed on the keypad when 
the control panel is in shutdown mode. 

3.5.2.1.3 Zone Names A menu option that specifies the name of each zone and allows these names 
to be edited. 

3.5.2.1.4 Partition Names A menu option that specifies the name of each partition.

3.5.2.1.5 Copy Language A menu option that copies information from the current keypad descriptors to 
another or multiple keypads in the system. Included are the zone descriptors, 
custom message, shutdown message, zone names and partition names. 

3.5.3 User Names A menu option that specifies a name for each user code. The maximum length 
of a user name is 15 characters.  

3.5.4 Zone Type Names A menu option that allows the installer to define names for each installed zone 
type. For example, Type 1 can be named Burglary A Alarm, Type 2 can be 
named Fire Alarm, Type 3 can be named Entry/Exit and so on. 

3.5.5 Word Library A menu option that enables the word library. This is a predefined collection of 
words that speed up text editing. As the user/installer types a character, the 
keypad automatically displays a matching word. The word library is enabled by 
default.

3.6 Partition A menu entry menu option that specifies the partition that the selected keypad 
can access if it is a single-area keypad. Together with the keypad number, it 
determines the keypad bus module number for both single-area and multi-area 
keypads. 

3.7 Keypad Number A menu option that sets the keypad number within the partition. The keypad 
can be numbered from one to eight. The selected number links to the module 
number reported to the central station in the case of tampers or expansion 
troubles. 

3.8 Keypad Defaults A menu option that defaults the keypad to the country settings for the selected 
country.

3.9 Model A menu option that displays the current model of the keypad.

3.10 Version A menu option that displays the current software version of the keypad. 

3.11 Default Settings A menu option that defaults the keypad to factory defaults. 

Location Term Definition
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3.9 Technical specifications
3.9.1 CS5006 LED keypad

3.9.2 CS5XX8 LED keypad, where XX is the country code

Power supply specifications

Power supply voltage 13.8V  ± 0.2V  

Consumption – Normal condition (Piezo Off) 78 mA at 13.8V  ± 2%  

Consumption – Normal condition (Piezo On) 90 mA at 13.8V  ± 2%  

Consumption – Standby 7 mA at 13.8V  ± 2%  

Consumption – In Alarm 36 mA at 13.8V  ± 2%  

General feature specifications

PCB Size Dimensions (width x height x depth) 90x135x1.2 mm

Housing Size Dimensions (width x height x depth) 102x153x29 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 170 g

Power supply specifications

Power supply voltage 13.8V  ± 2%  

Consumption – Normal condition (Piezo Off) 92 mA at 13.8V  ± 2%  

Consumption – Normal condition (Piezo On) 103 mA at 13.8V  ± 2%  

Consumption – Standby 12 mA at 13.8V  ± 2%  

Consumption – In Alarm 65 mA at 13.8V  ± 2%  

General feature specifications

PCB Size Dimensions (width x height x depth) 90x135x1.2 mm

Housing Size Dimensions (width x height x depth) 102x153x29 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 170 g
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3.9.3 CS5500 menu driven keypad

3.9.4 Keyswitch zones

Power supply specifications

Power supply voltage 13.8V  ± 2%  

Consumption – Normal condition (Piezo Off) 90 mA at 13.8V  ± 2%  

Consumption – Normal condition (Piezo On) 100 mA at 13.8V  ± 2%  

Consumption – Standby 7 mA at 13.8V  ± 2%  

Consumption – In Alarm 36 mA at 13.8V  ± 2%  

General feature specifications

PCB Size Dimensions (width x height x depth) 90 x 135 x 1.2

Housing Size Dimensions (width x height x depth) 102x153x29 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 170 g

Static Impulse

Single loop 4k7: Disarmed Quiet

Short Armed Change status

Open: No reaction No reaction

Dual loop 9k4 Disarmed Quiet

4k7 Armed Change status

Short or totally open Tamper Tamper
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Chapter 4: Programming the other keypads

To program other keypads, select Installer Menu>Other Keypads and select the partition containing the keypad. 
You can view the keypad version and model and default the selected keypad. 

4.1 Glossary

Location Term Definition

4 Other keypads A menu entry that groups programming options for other keypads in the 
system. 

4.1.1.1 Model A menu option that displays the current model of the selected keypad. 

4.1.1.2 Version A menu option that displays the current software version of the selected 
keypad.

(1) Partition 1 Keypad 1 Model
Version
Default Settings

4.1 4.1.1 4.1.1.1

4.1.1.3
4.1.1.2Partitions 2 - 8

Same as above
Keypads 2 - 8
Same as above
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Chapter 5: Setting up the RF receivers

5.1 Overview
You can add either an 868 Mhz or 433 Mhz wireless receiver to the CSx75. Adding a receiver module makes a 
CSx75 control panel compatible with wireless sensors and keychain touchpads or keyfobs.

5.1.1 Types of receivers

Table 5-1: Types of receivers

Type of Receiver Description

RX8I4CA-pcb 433 Mhz receiver allowing up to 8 wireless zones.

RX16I4CA-pcb 433 Mhz receiver allowing up to 16 wireless zones.

RX48I4CA-pcb 433 Mhz receiver allowing up to 48 wireless zones.

RX8W8CA-pcb 868 Mhz receiver allowing up to 8 wireless zones.

RX16W8CA-pcb 868 Mhz receiver allowing up to 16 wireless zones.

RX32W8CA-pcb 868 Mhz receiver allowing up to 32 wireless zones.
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5.2 Installing an RF433 Mhz receiver

 

5.2.1 Wiring an RF433 Mhz receiver
Wire the RF433 Mhz receiver terminals 5 as follows.

5.2.2 Setting the RF433 Mhz receiver DIP switches

1. Power down the RF433 Mhz receiver.

2. Decide the module number of the RF433 Mhz receiver. 

1 Processor 4 Wireless communication LED 7 Not used

2 No function 5 Keypad bus connection 8 Antenna

3 Bus supervision LED 6 Lid tamper 9 DIP switches

Table 5-2: RF433 Mhz receiver terminal connections

Terminal Description

POS Connect to the KP POS terminal of the CSx75. Current draw is 30 mA.

COM Connect to the KP GND terminal of the CSx75.

DATA Connect to the KP DATA terminal of the CSx75. 
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3. Set the DIP switch 9 from Table 5-3: RF433 Mhz receiver DIP switches. 

4. Power up the RF433 Mhz receiver. 

5.2.3 RF433 Mhz receiver status conditions
When you apply power to the CSx75, the middle (red) LED should start blinking. The LEDs on the receiver 
indicate the module status.

" The red LED at the bottom of the RF433 Mhz receiver may emit a dim glow but is not used as an indicator 
and can be ignored.

For information on installing the RF433 Mhz receiver in the various housings, see chapter A-4 Installing a basic 
system.

Table 5-3: RF433 Mhz receiver DIP switches

DIP switch 1-3 
settings

RF 
receiver

Module 
number

 DIP switch 1-3
 settings

RF receiver Module 
number

      1 34     5 38

   2 33     6 37

   3 32 (default)    7 36

   4 39     8 35

 = ON      = OFF     DIP switch 4 is not used

Table 5-4: RF433 Mhz receiver LED indications

LED Module Status

Red blinking
Red off

Normal data communication with the CSx75.
No data communication with the CSx75, check the wiring and power source.

Yellow blinking
Yellow off

Receiving radio signals from learn mode wireless sensors.
No radio signals currently being received.
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5.3 Installing an RF868 Mhz receiver

5.3.1 Wiring an RF868 Mhz receiver

5.3.2 Setting the RF868 Mhz receiver DIP switches

1. Power down the receiver.

2. Decide the module number of the RF868 Mhz receiver. 

3. Set the DIP switch A from Table 5-6: RF868 Mhz receiver DIP switches.

4. Power up the RF868 Mhz receiver. 

1 Jumper setting 5 Wireless communication LED 9 Jumper setting

2 Lid tamper 6 Keypad bus connection A Processor

3 Eeprom 7 Not used B DIP switches

4 Bus supervision LED 8 Antenna

Table 5-5: RF868 Mhz receiver terminal connections

Terminal Description

DATA Connect to the KP DATA terminal of the CSx75. 

COM Connect to the KP GND terminal of the CSx75.

POS Connect to the KP POS terminal of the CSx75. Current draw is 30 mA.
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" Some RX8W8, RX16W8 and RX32W8 receivers have DIP switch labels with On/Off rather than Open/Closed 
labels. In the table below you can find both references. The label on the receiver always refers to Open/Close (O/
C).

5.3.3 RF868 Mhz receiver status conditions
When you apply power to the CSx75, the red LED should start blinking. The LEDs on the receiver indicate the 
module status.

" If you are installing a system in Holland or Belgium, you must use the test antennas RX 9008 when installing 
an RF868 system.

For information on installing the RF868 Mhz receiver in the various housings, see chapter A-4 Installing a basic 
system.

Table 5-6: RF868 Mhz receiver DIP switches

DIP switch 1-3 
settings

RF 
receiver

Module 
number

 DIP switch 1-3
 settings

RF receiver Module 
number

      1 34     5 38

   2 33     6 37

   3 32 (default)    7 36

   4 39     8 35

 = C (ON)      = O (OFF)     DIP switch 4 is not used

Table 5-7: RF868 Mhz receiver LED indications

LED Module status

Red blinking
Red off

Normal data communication with the CSx75.
No data communication with the CSx75, check the wiring and power 
source.

Green blinking
Green off

Receiving radio signals from learn mode wireless sensors.
No radio signals currently being received.
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5.4 Programming the RF system

5.4.1 Defaulting the wireless modules
You must enroll and default each RF receiver before you begin programming the system. 

You must default each module before you start programming it. 

1. Navigate with the  keys to RF Receivers and press OK. 

2. Select the relevant module bus ID and press OK. In this case select RF Receiver 32 and press OK. 

3. Select Default Settings and press OK.

4. A confirmation message is displayed. Press OK to accept the default settings.

5. The keypad sounder beeps once to confirm the reset.

5.4.2 Programming the wireless detectors

1. Navigate with the  keys to RF Receivers and press OK.

2. Select the relevant module bus ID and press OK. In this case select RF Receiver 32 and press OK.

3. Scroll to Start Zone and press OK.

4. Enter the starting zone of the receiver. In this case, enter zone 9 to set zone 9 as the starting zone for receiver 
32.

5. Scroll to Learn-in Mode and press OK.

6. To learn-in more than one device, scroll to Sequential Programming, select Yes and press OK. 

Model
Version
Default Settings

Internal Reed
External Contact

Receiver Features

Tamper

Jam Detection
Keyfob User ID
Keyfob Low Battery Reports*
Antenna Tamper**
Box Tamper**

Inputs Enabled
Supervised
Fire Supervision

Keyfob Keyfob Funct 1
Keyfob Funct 2
Partitions

Door/Window*

Smoke*

Sensor 15.1.3

5.1.4

5.1.3.1

5.1.4.1

5.1.4.2
5.1.4.3

5.1.4.4

5.1.3.1.1

5.1.3.1.2

5.1.3.1.3

5.1.3.1.4

5.1.3.1.5

5.1.3.1.6

5.1.3.1.4.1

5.1.3.1.4.3

5.1.3.1.4.2

5.1.3.1.5.1
5.1.3.1.5.2

5.1.3.1.6.1

RSSI Check Zone*
RSSI Value*
Last Round Count**

Supervision Normal Window
Short Window
Fire Window

RF Signal

5.1.5

5.1.6

5.1.7

5.1.8

5.1.9

5.1.4.5

5.1.5.1

5.1.5.2
5.1.5.3

5.1.6.1

5.1.6.2

5.1.6.3

Sensors 2 - 168 
Same as above
Range of sensors depends 
on the number of sensors 
and the start zone 
number. 

*Disabled for 868 Mhz 
receivers 

*Disabled for 868 Mhz 
receivers 

* Disabled for 433 Mhz receivers
**Disabled for 868 Mhz receivers 

* Disabled for 433 Mhz receivers
** Disabled for  868 Mhz receivers

Delete5.1.3.1.7

Start Learning

Start ZoneRF Receiver 32

Learn-in Mode

5.1 5.1.1

5.1.2 5.1.2.1

5.1.2.2

RF Receivers 33 - 39
Same as above

(1) Zone 1

Sequential Programming

5.1.2.1.1
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7. Scroll to Start Learning and press OK.

8. Enter the zone number to start with. In this case, enter 9 to program the detectors in zones 9 and 10 and press 
OK. 

5. Tamper the different detectors in sequence. To do this, you activate the sensor’s tamper switch. Table 5-8: 
Learning RF sensors explains how to activate each type of sensor. 

9. Press ## to leave the programming mode. The OK to Exit prompt is displayed. The system now functions as a 
normal alarm system. See the CS5500 LCD Keypad User Manual for information on arming and disarming 
the system. 

< Select Installer Menu>RF Receivers>RF Receiver x>Inputs>Sensor x>Delete to delete an enrolled RF zone.

5.4.3 Configuring receiver features
Configurable receiver features include tampers and communication errors. The following example enables RF 
jamming detection on RF receiver 32. RF communication is considered to be jammed when there has been a 
jamming signal for more than 30 seconds in a 60 second window. 

1. Navigate with the  keys to RF Receivers>RF Receiver 32>Receiver Features and press OK.

2. Scroll to Jam Detection>Enabled and press OK.  

3. The keypad beeps once to accept the change and returns to Jam Detection.

5.4.4 Setting supervision windows
There are three wireless supervision options: Short Window, Normal Window and Fire Window. PIR and door/
window sensors follow short and normal windows. 

• If a PIR or door/windows sensor does not report within the time specified in Short Window, the system does 
not allow the user to arm the system. However, an RF Sensor Lost condition is not reported to the central 
station.

• If a PIR or door/windows sensor does not report within the time specified in Normal Window, an RF Sensor 
Lost condition is reported to the central station and a service message is displayed on the keypad.

The short and normal window timers are configured differently according to country and frequency. 868 Mhz 
transmitters typically report every 15 minutes while 433 Mhz transmitters typically report every 64 minutes.

" If you are installing a system in Holland or Belgium, you must set the supervision values to 120 for a long 
supervision window. Set the short supervision window in Belgium to 15 and in Holland to 20. Fire transmitter 
supervision windows should be set to 240.

When the Arming with Zone Lost option is enabled, the user is always allowed to arm the system even if the PIR 
or door/window sensor does not report within the short window. 

Smoke detectors follow the fire window. 433 Mhz and 868 Mhz smoke sensors report every 64 minutes. Smoke 
detectors follow supervision windows only and report to the central station when not reporting within the fire 
window.

Table 5-8: Learning RF sensors

Transmitter Action

Door/Window Activate the tamper switch by removing the cover.

Door/Window with external contact Activate the tamper switch by removing the cover. 

PIR Activate the tamper switch by removing the back plate from the PIR.

Fire detector Press and hold the test button.

Single Button Panic Press and hold the button.

Keyfobs Press and hold the arm and disarm buttons together.
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5.5 Testing wireless sensors
5.5.1 RF433 Mhz system

The RF433 Mhz system uses a last round count to provide an indication of the quality of the data reception. It 
displays the number of rounds of RF data received during the last transmission. The following example tests the 
last round count on sensors enrolled on RF receiver 33.

1. Activate a tamper alarm and wait five seconds before restoring the tamper to prevent additional signals 
being counted.

2. Navigate with the  keys to RF Receivers>RF Receiver 33 and press OK.

3. Scroll to RF Signal>Last Round Count and press OK.

4. The last round count is displayed on the keypad.

5.5.2 RF868 Mhz system
The Remote Signal Strength Indication Value (RSSI) is a measure of the RF reception and is similar to the 
indication on a mobile phone. The value is linked to the level of the signal between the wireless sensors and the 
RF receiver. On an 868 Mhz system, the RF receiver stores the signal strength of the transmission it receives 
from the sensor in a specified zone. The values in this zone are read as follows:

• Values between 1 and 5: The sensor will not work properly and must be moved to another location.

• Values between 6 and 10: The sensor will work but ideally should be moved to another location. 

• Values between 11 and 20: These are low values but the sensor will still work properly.

• Values between 20 and 50: These are normal working values for sensor located at a longer distance from the 
receiver.

• Values above 50: Perfect conditions.

RSSI Values may change due to environmental circumstances, for example, additional furniture or metal 
constructions. The following example tests the RSSI value of zone 2 on receiver 32.

1. Navigate with the  keys to RF Receivers>RF Receiver 32 and press OK.

2. Scroll to RF Signal>RSSI Check Zone>(2) Zone 2 and press OK.

3. Open and close zone 2.

4. Scroll to RSSI Value and press OK.

5. The RSSI value is displayed on the keypad.

5.6 Deleting sensors
You can program a receiver to ignore a sensor. This does not remove the sensor identification from the module’s 
memory. The sensor can be reactivated later or a new sensor can be learned into the zone. The following 
example removes sensor 10 learned in on receiver 32.

1. Navigate with the  keys to RF Receivers>RF Receiver 32 and press OK.

2. Scroll to Inputs>Sensor 10>Enabled>NO and press OK.  

3. The keypad beeps once to accept the change and returns to Enabled.
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5.7 Glossary

Location Term Definition

5.1 RF Receiver 32 An menu entry that groups all options for the selected RF receiver.

5.1.1 Start Zone An menu option that specifies the first zone number of zones on the RF 
receiver.

5.1.2 Learn-in Mode An menu option that enables the mode in which a new wireless device is 
enrolled on the system.

5.1.2.1 Start Learning An menu command that triggers the learn-in mode. 

5.1.2.2 Sequential Programming

An menu option that allows a group of RF sensors to be enrolled in sequence. 
Once the first sensor (Start Learning sensor) is configured, the detectors are 
learned-in in sequence. The value of ‘Start Learning’ is increased 
automatically. This option allows easier programming. 

5.1.3 Inputs An menu entry that groups options relating to RF zones only. 

5.1.3.1.2 Supervised An menu option that enables supervision of the selected RF sensor.

5.1.3.1.3 Fire Supervision An menu option that specifies that the RF433 or RF868 receiver uses the fire 
supervision timing window.   

5.1.3.1.4 Keyfob An menu entry that groups options relating to any device that sends 
commands by a wireless receiver. 

5.1.3.1.4.1 Keyfob Funct 1

An menu option that enables the light bulb button on the keyfob for the 
selected RF zone on the selected RF receiver. If this option is enabled, 
pressing the light bulb button sends a keyfob function 1 event. Control panel 
auxiliary outputs and CS507 outputs can be programmed to respond to this 
event. 

5.1.3.1.4.2 Keyfob Funct 2

An menu option that enables the * button on the keyfob for the selected RF 
zone on the selected RF receiver. If this option is enabled, pressing the * 
button sends a keyfob function 2 event. Control panel auxiliary outputs and 
CS507 outputs can be programmed to respond to this event. 

5.1.3.1.4.3 Partitions

An menu entry that lists the partitions assigned to the selected keyfob. The 
selected keyfob can trigger an event on these partitions. 
A zone may reside in any combination of partitions. A zone that resides in more 
than one partition becomes a common zone and is reported to its lowest 
partition number. A common zone is armed only when all the partitions that it 
belongs to are armed. It is disarmed the moment one of the partitions it 
belongs to is disarmed. 

5.1.3.1.5 Door/Window
An RF Receiver menu option that configures door/window settings on an RF 
433 Mhz receiver. It includes the use of internal reed and additional external 
contact of the door/windows transmitters. 

5.1.3.1.5.1 Internal Reed An menu option on an RF door/window sensor that enables the internal reed 
contact. 

5.1.3.1.5.2 External Contact
An menu option on an RF door/window sensor that enables an additional 
external contact. When the external contact is triggered, an alarm is generated 
on the same zone number as the door/window sensor (reed contact) itself. 

5.1.3.1.6 Smoke An menu entry that groups smoke sensor options.

5.1.3.1.6.1 Tamper An menu option that enables/disables the tamper of a smoke sensor.

5.1.3.1.7 Delete An menu entry that deletes an enrolled RF zone.

5.1.4 Receiver Features An menu entry that groups programmable options for RF receivers.

5.1.4.1 Jam Detection A menu option that enables the detection of RF jamming. 
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5.1.4.2 Keyfob User ID
A menu option that makes the keyfob report as the zone that it is learned into. 
When this option is disabled, all keyfobs report their open/closing reports as 
user 99. 

5.1.4.3 Keyfob Low Battery Reports

A menu option that reports a keyfob low battery condition. This option is 
available on the 868 Mhz RF Receiver only. 
The low battery condition is reset by pressing the Arm (Lock) and Disarm 
(Unlock) button at the same time. If this option is enabled, each enrolled keyfob 
uses up one zone in the system. If this option is disabled, keyfobs do not use 
up a zone in the system and can overlap with a used zone. 

5.1.4.4 Antenna Tamper A menu option that sends a report if the antenna on the selected RF receiver is 
removed or damaged (cut). 

5.1.4.5 Box Tamper A menu option that enables the box tamper switch on the selected RF receiver. 

5.1.5 Supervision A menu entry that groups wireless supervision options. 

5.1.5.1 Normal Window

A menu option that specifies the normal supervision window for RF devices. 
RF devices on 433 Mhz typically report every 64 minutes. RF devices on 868 
Mhz typically report every 15 minutes. Depending on the country regulations, 
this timer must be set to specific values. 

5.1.5.2 Short Window

A menu option that specifies the short supervision window for RF devices. RF 
devices on 433 Mhz typically report every 64 minutes. RF devices on 868 Mhz 
typically report every 15 minutes. Depending on the country regulations, this 
timer must be set to specific values. 

5.1.5.3 Fire Window
A menu option that specifies the RF supervision to be used for RF smoke/fire 
detectors. The RF smoke/fire detectors send a supervision every 64 minutes, 
irrespective of 433 Mhz or 868 Mhz.

5.1.6 RF Signal A menu entry that groups entries related to measuring RF signal strengths. 

5.1.6.1 RSSI Check Zone

A menu option that sets the zone number on the selected RF receiver. The RF 
receiver stores the signal strength of the transmission it receives from the 
sensor in this zone. To read the signal strength, open and close the zone and 
then select the RSSI Value menu option. 

5.1.6.2 RSSI Value

Remote Signal Strength Indication Value. This is a measure of the RF 
reception and is similar to the indication on a mobile phone.
A menu entry that displays the RSSI value. The value is linked to the level of 
the signal between the wireless transmitters and the RF receiver.  

5.1.6.3 Last Round Count
A menu option that displays the number of rounds of RF data received during 
the last transmission. This option is available only on a 433 Mhz system and is 
replaced by the RSSI value on an 868 Mhz system. 

5.1.7 Model A menu option that displays the model of the selected receiver. 

5.1.8 Version A menu option that displays the current software version of the selected 
receiver. 

5.1.9 Default Settings A menu option that defaults the selected receiver to factory defaults. 

Location Term Definition
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5.8 Technical specifications
5.8.1 RF433 receivers: RX8i4-pcb, RX16i4-pcb, RX48i4-pcb

5.8.2 RF868 receivers: RX8w8-pcb, RX16w8-pcb, RX32w8-pcb

5.8.3 Empty housing RXWEH00 (868 Mhz) and RXIEH00 (433 Mhz)

Power supply specifications

Power supply voltage 13.8V  ± 2%  

Consumption 20 mA at 13.8V  ± 2%  

Wireless Frequency 433 Mhz

General feature specifications

PCB Size Dimensions (width x height x depth) 110x81x25.4 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 95 g

Power supply specifications

Power supply voltage 13.8V  ± 2%  

Consumption 20 mA at 13.8V  ± 2% 

Wireless Frequency 868 Mhz

General feature specifications

PCB Size Dimensions (width x height x depth) 117x81x25.4 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 105 g

General feature specifications

Housing Size Dimensions (width x height x depth) 110x81x25.4 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 95 g
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Chapter 6: Setting up the CS208H / CS208 / CS216

6.1 Overview
The CS208H, CS208 and CS216 input expanders can provide extra wired zones for a CSx75 control panel. Each 
CS208H and CS208 input expander can provide up to 8 extra wired zones. Each CS216 input expander can 
provide up to 16 wired zones. Each CS208 / CS216 input expander has an optional tamper switch and power 
isolator. Each CS208H input expander has a tamper switch and power isolator.

6.2 CS208 / CS216 input expander
The CS208 input expander and CS216 input expander are similar. The only difference is the number of zones 
provided. The illustration below shows the CS216 input expander.

6.2.1 Installing the CS208 / CS216 input expander

6.2.2 Setting the DIP switches

1. Power down the CS208 / CS216 input expander.

2. Decide the starting zone of each input expander. The starting zone of each zone expander must be on a 
boundary of 8 zones. 

3. To set the starting zone, set the DIP switches from Table 6-1: CS208 / CS216 input expander DIP switches. 
The zones for this module begin from this starting zone number. 

1 Zone connections (16 sets) 5 No function

2 Tamper connection (required) 6 Supervision LED

3 Keypad bus connection 7 DIP switches (6 positions)

4 Additional keypad bus connection 8 Processor
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4. Power up the CS208 / CS216 input expander     

6.2.2.1 DIP switch 6 (CS216 only)
To disable the second group of 8 zones on the CS216 input expander, turn DIP switch 6 on. This should be done 
only if you need an 8-zone expander in a particular location. 

For details on how to install the CS208 / CS216 input expander in the various housings, chapter A-4 Installing a 
basic system.

Table 6-1:  CS208 / CS216 input expander DIP switches

DIP 
switch setting

Starting 
zone 

number

Module 
number

 DIP 
 switch setting

Starting 
zone 

number

Module 
number

     

 9   23

      

 89 99

     

 17 16

      

 97 100

     

 25 17

      

 105 101

     

 33 18

      

 113 102

     

 41 19

      

 121 103

     

 49 20

      

 129 104

    

 57 21

     

 137 105

    

 65 96

     

 145 106

    

 73 97

     

 153 107

    

 81 98

     

 161 108

 = ON      = OFF
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6.2.3 Wiring the CS208 / CS216 input expander
To wire the CS208 / CS216 input expander, see Table 6-2: CS208 / CS216 input expander terminals. Any 
unused zones must have an EOL resistor across them, unless all 8 are disabled by DIP switch 6 (CS216 only). 
The CS208 / CS216 input expander is similar to the CS507 output expander. A white connector J9 can be used to 
connect to the CSx75 panel in a housing mounted inside the control unit.

Table 6-2: CS208 / CS216 input expander terminals 

Terminal Description

Connector on the left side 3

DATA Connect to the KP DATA terminal of the CSx75. 

AUX Connect to the KP POS terminal of the CSx75. Current draw is 30 mA.

COM Connect to the KP COM terminal of the CSx75.

Out Can be used to power devices directly from the CS208 / CS216. Power comes from the 
CSx75 and the current draw of these devices must be added to the total current draw of 
the CS208 / CS216. The output current connected to a COM terminal is limited to 100 
mA.

TAM If not used, connect to a COM terminal.

Bottom connector 1

Z9 Connect to one side of zone 9 loop. Connect the other side to the COM terminal. Open or 
short causes alarm. 

COM Common (-) terminal for zones 9 and 10.

Z10 Connect to one side of zone 10 loop. Connect the other side to the COM terminal. Open 
or short causes alarm.

Z11-Z24 Connect as described for Z9 and Z10.

Additional keypad connector 4 (from top to bottom)

1 DATA

2 COM

3 Unused

4 AUX+
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6.3 CS208H input expander
The CS208H input expander comes in its own housing. The board is different to the CS208 input expander.

6.3.1 Installing the CS208H input expander

1. Unscrew the screws to open the housing.

2. Wire the terminals as shown.

3. Replace the lid, making sure that the orientation is correct.

6.3.2 CS208H input expander board

1 Zone connections (8 sets) 3 Tamper switch

2 Keypad bus connection 4 DIP switches
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6.3.3 Setting the DIP switches

1. Power down the CS208H input expander.

2. Decide the starting zone of each CS208H input expander. The starting zone of each zone expander must be 
on a boundary of 8 zones. 

3. To set the starting zone, set the DIP switches from Table 6-3: CS208H DIP switches. The 8 zones for this 
module begin from this starting zone number. 

4. Power up the CS208H input expander. 

Table 6-3: CS208H DIP switches

DIP switch setting Starting 
zone 

number

Module 
number

DIP switch setting Starting 
zone 

number

Module 
number

    

 9   23

     

 73 97

    

 17 16

     

 81 98

    

 25 17

     

 89 99

    

 33 18

     

 97 100

    

 41 19

     

 105 101

    

 49 20

     

 113 102

    

 57 21

     

 121 103

    

 65 96

 = ON      = OFF
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6.3.4 Wiring the CS208H input expander
To wire the CS208H input expander, see Table 6-4: CS208H input expander terminals. Any unused zones must 
have an EOL resistor across them.

6.4 Programming the CS208H / CS208 / CS216 input expander

The zones on the CS208H / CS208 / CS216 input expander are programmed in a similar way to on-board zones. 
For more information on programming on-board zones, see chapter B-2 Programming the control panel. You 
must enroll and default each input expander before you begin to program the system. For more information on 
enrolling and defaulting, see chapter B-1 Enrolling modules. To program the input expander zones, select 
Installer Menu>Control Panel>CS208/CS216 Input Expander.

Table 6-4: CS208H input expander terminals 

Terminal Description

DATA Connect to the KP DATA terminal of the CSx75. 

AUX Connect to the KP POS terminal of the CSx75. Current draw is 30 mA.

COM Connect to the KP COM terminal of the CSx75.

Out Can be used to power devices directly from the CS208H. Power comes from the CSx75 
and the current draw of these devices must be added to the total current draw of the 
CS208H. The output current connected to a COM terminal is limited to 100 mA.

Z1 Connect to one side of zone 1 loop. Connect the other side to the COM terminal. Open or 
short causes alarm. 

COM Common (-) terminal for zones 1 and 2.

Z2 Connect to one side of zone 2 loop. Connect the other side to the COM terminal. Open or 
short causes alarm.

Z3-Z8 Connect as described for Z1 and Z2.

Input Exp 166.1

Input Exps 17 - 108
Same as above
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6.5 Glossary

6.6 Technical specifications
6.6.1 CS208 / CS216 input expander

6.6.2 CS208H input expander

Location Term Definition

6 CS208 / CS216 Input Expanders An expander board that increases the number of wired inputs that can be used 
for a particular zone. It has an optional tamper switch and a power isolator for 
use in a remote location. It cannot be used on the CS175 or CS275 control 
panel. The CS208 has 8 zones and the CS216 has 16 zones.
A menu entry that groups CS208/CS216 input expander options.

Power supply specifications

Power supply voltage 13.8V  ± 2%  

Consumption (with 4K7 EOL) 64 mA at 13.8V  ± 2% 

Auxiliary Power output 100 mA max at 13.8V  ± 2% 

General feature specifications

PCB Size Dimensions (width x height x depth) 110x95x25.4 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 115 g

Power supply specifications

Power supply voltage 13.8V  ± 2% 

Consumption (with 4K7 EOL) 64 mA at 13.8V  ± 2% 

Auxiliary Power output 100 mA max at 13.8V  ± 2% 

General feature specifications

PCB Size Dimensions (width x height x depth) 80x60x105 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 105 g
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Chapter 7: Setting up the CS507

7.1 Overview
The CS507 output expander is an auxiliary module used to expand the output capabilities of the CSx75 control 
panel with the following functionality:

• Microprocessor controlled two relay, five Open Collector expander.

• Two separate normally open and normally closed relay contacts for a variety of applications, including access 
control, home control/automation, wireless interfaces, and security functions. 

• Five low current trigger outputs (Output 1-2-3-4-5).

The CS507 output expander can be programmed to:

• Activate for an event in any or all partitions, if the control panel supports partitions.

• Set up each relay to follow up to eight different schedules to either activate the relay during the On time, or to 
be used in conjunction with another programming option to create time zones.

7.2 Installing the CS507 output expander

1 Form C (SPDT) relay connections (2 sets) + 5 open collectors 7 X–10 supervision LED

2 Tamper connection 8 X-10 connection

3 Auxiliary power connection 9 Processor

4 Keypad bus connection A DIP switches (4 positions)

5 Additional keypad bus connection B Relay

6 Supervision LED
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7.2.1 Setting the DIP switches

1. Power down the CS507 output expander.

2. Set the DIP switch according to Table 7-1: CS507 output expander DIP switches. 

3. The outputs can be logged in the event log. The output numbers that appear in the event log are linked to a 
selected CS507 output expander address.

4. Power up the CS507 output expander. The position of all switches is updated when the CS507 output 
expander is powered up. 

For details on how to install the CS507 output expander in the various housings, see chapter A-4 Installing a 
basic system. 

7.2.2 Wiring the CS507 output expander

Table 7-1: CS507 output expander DIP switches

DIP switch setting Address Outputs  DIP switch setting Address Outputs

    

 24 1-7

    

 28 33-39

   

 25 9-15

     

 29 41-46

    

 26 17-23

    

 30 49-55

    

 27 25-31

     

 31 57-63

 = ON      = OFF

Table 7-2: CS507 output expander terminal connections

Terminal Description

DATA Connect to the KP DATA terminal of the CSx75.

AUX Connect to the KP POS terminal of the CSx75. Current draw is 30 mA.

COM Connect to the KP COM terminal of the CSx75.

Vout This terminal can supply up to 100 mA fused separate from the power in 
the control panel. 
Note: Any power drain from this terminal should be included in total 
current draw from the CSx75. This allows an isolation of the power 
between the main control and remote devices. If a short is created past 
the AUX terminal, these devices cease to function, but the other devices, 
including the CS507 output expander, continue to operate. The CS507 
output expander reports this problem to the control panel for display on 
the keypad as an expander power trouble.
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An additional connector J1, (left middle), allows a direct bus connection to the controller. An additional cable is 
supplied with the panel in case you install the expander in the housing of the CSx75, and connects to J16 on the 
CS575. There are 2 ways of connecting the CS507 output expander module to the CSx75 controller:

• When the CS507 output expander is mounted in the box, you can use the direct bus connection as explained 
above.

• When the expansion module is mounted remotely, you can use the terminals DAT, AUX+, COM as outlined 
in Table 7-2: CS507 output expander terminal connections. In this case, you must wire the tamper of the 
external box to the COM and TAM terminals.

TAM If not used, connect to a COM terminal.

Out 1- 5 Open Collector outputs that switch to GND when activated - capable of up 
to 100 mA. 
Note: If the device is connected to outputs, it must see the transition from 
13 Volts to GND. The enclosed resistors must be used. Connect the 
resistor between AUX and the output being used.

Relay 6 /NC Closed dry contact rated 1 Amp at 30 Vdc.

Relay 6 /NO Open dry contact rated 1 Amp at 30 Vdc.

Relay 6 /CO Common dry contact rated 1 Amp at 30 Vdc.

Relay 7 /NC Closed dry contact rated 1 Amp at 30 Vdc.

Relay 7 /NO Open dry contact rated 1 Amp at 30 Vdc.

Relay 7 /CO Common dry contact rated 1 Amp at 30 Vdc.

Additional keypad connector 5 (from top to bottom)

1 DATA

2 COM

3 Unused

4 AUX+

Table 7-2: CS507 output expander terminal connections

Terminal Description
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7.3 Programming the CS507 output expander

The CS507 outputs are programmed in a similar way to on-board outputs. The outputs are triggered based on 
different events. The events are grouped in the programming tree. A full list of all possible selectable events can 
be found in Table 7-3: CS507 output expander output events. You must enroll and default each output expander 
before you begin to program the system. For more information on enrolling and defaulting, see chapter B-1 
Enrolling modules. To program the outputs, select Installer Menu>CS507 Output Expanders. 

Outputs EventOutput Exp 24 1 (<Event>)

Attributes

Alarms
Arm/Disarm
Communications
Keypads
Sirens
Tamper/Trouble
Tests
Miscellaneous

Latched
Code Stops Timer
Only if Closed
Only if Open
Inverted
Log Event

X-10 Address

Schedules

Module Number
House Code

Schedules Opening
Closing

Hour
Minute

Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday
Disable on Holidays

Active

Schedule 1

Date of holidays January
February
March
April
May
June
July
August
September
October
November
December

Day 1

Users

Model
Version
Default Settings

(1) User 1 Outputs

7.1.1

7.1.2

7.1.3

7.1.4

7.1.5

7.1.7

7.1.6

7.1.1.1

7.1.2.1

7.1.3.1
7.1.3.2

7.1.3.3

7.1.3.4

7.1.3.5

7.1.3.6

7.1.3.8

7.1.3.7

7.1.3.9

7.1.3.10

7.1.3.11

7.1.3.12

7.1.4.1

7.1.1.1.1

7.1.1.1.2

7.1.1.1.3
7.1.1.1.4

7.1.1.1.5

7.1.1.1.6

7.1.1.1.7

7.1.1.1.8

7.1.2.1.1

7.1.2.1.2

7.1.2.1.3

7.1.3.1.1

7.1.4.1.1

7.1.1.1.1.1

7.1.1.1.1.2

7.1.1.1.1.3

7.1.1.1.1.4

7.1.1.1.1.5

7.1.1.1.1.6

7.1.1.1.1.7

7.1.1.1.1.8

7.1.1.1.6.1

7.1.1.1.6.6

7.1.1.1.6.5

7.1.1.1.6.4

7.1.1.1.6.3

7.1.1.1.6.2

7.1.1.1.8.1

7.1.2.1.1.1

7.1.2.1.1.2

7.1.2.1.3.1

7.1.2.1.3.8

7.1.2.1.3.7

7.1.2.1.3.6

7.1.2.1.3.5

7.1.2.1.3.4

7.1.2.1.3.3

7.1.2.1.3.2

7.1

Outputs 2 - 8
Same as above

Output Exps 25 - 31
Same as above

Schedules 2 - 8
Same as above

7.1.1.1.8.2

Days 2 - 8
Same as above.

Users 2 - 99 
Same as above
If more than 10 users, 
users are first displayed in 
groups of 10 and then 
displayed as above.
 

Zone/User
Time Unit
Time
Partitions



CS875-575-375-275-175 Installers Manual with CS5500 keypadB.7.5

Table 7-3: CS507 output expander output events

# Event # Event # Event

Tampers Misc Communications

9 Mains Failure 8 Any Bypass 32 Listen-in

10 Low Battery 11 9 Duress 33 Line Seizure

25 Fire LED 45 9 Code Entry 34 Failed to communicate

26 Fire Trouble 36 Program Mode 35 Telephone line fault

28 9 Expander Trouble 46 99 Keyfob Funct 1 37 Download

39 Over-current 47 99 Keyfob Funct 2 55 End Listen In (Integrated 
Only)

40 Box Tamper 51 CS507 Schedule Arm/disarm

41 Siren Tamper 52 X-10 Alarm Mem 18 Entry

42 Any Open Zone 53 X-10 Siren 19 Exit

58 Sensor Low Battery 56 Compare X10 Commands To 
Programmed Outputs

20 Entry or exit

59 Sensor Lost Keypads 21 Armed

64 Smoke Reset Function 12 9 Manual Fire 22 Not armed

65 Antimask Output 13 9 Keypad Medical 23 Ready 

Alarms 14 9 Keypad panic 24 Not ready 

0  9 Burglary Alarm 15 Keypad tamper 30 * Open schedule 

1  9 Fire Alarm 27 Chime 31 * Closed schedule 

2  9 24-hour Alarm 44 Keypad beeping 48 Auto arm control

3  9 Trouble Alarm Sirens 49 Auto disarm control

4  9 Tamper Alarm 5 Burglary Siren 50 Auto arm and disarm control

17 Alarm memory 6 Fire Siren 54 Armed Away With Exit 
Expired

43 9 Any Alarm 7 Any Siren 57 Armed Stay

62 Verified Burg 61 External Siren Tests

63 Verfied Fire 16 9 Automatic Test

29 Dyn Battery Test

60 Walktest Mode

* See Schedule Times>Opening and Schedule Times>Closing/Autoarm.
9 If set to latched condition, these events are one second.

99 Events 46 and 47 require RX8w8, RX16w8, RX32w8, RX8i4, RX16i4, or RX48i4 wireless receivers to operate.

Events 48, 49 and 50 arm or disarm the CSx75 at the open (disarm) or close (arm) time for the appropriate schedule.
< For events 48 and 50, the keypad buzzer will sound one minute prior to auto arm if the zone value is 1.If the zone 
value is 0, the keypad will not sound prior to auto arm
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7.3.1 Setting up schedules
You can set up a schedule to control the day and time at which the system automatically opens and closes or the 
days on which specific output events are active. You can also specify certain days on which the schedule is not 
active. For example, you might use a schedule to disarm the system each morning at a certain time. However, on 
holidays you might not want the system to disarm at this time. The following example sets up January 1st as the 
day on which schedule 1 is not active. 

1. Navigate with the  keys to CS507 Output Expanders>Output Exp 24>Schedules and press OK.

2. Scroll to Schedule 1>Active>Disable on Holidays>Yes and press OK.

3. Navigate with the  keys to Date of holidays>January>Day 1>1 and press OK.  

4. The keypad beeps once to accept the change and returns to Day 1.

5. To use this schedule, enable Outputs>Schedules for the selected output. For information on how to enable 
this option, see Configuring an output.

7.3.2 Configuring an output
You can specify events, users and partitions that can activate a particular output. The output can be controlled 
using a schedule or by an X-10 device. If an output is controlled by a schedule, it can be activated during the 
times specified in the schedule only. If it is controlled by an X-10 device, it can be activated during the time the 
X-10 device is switched on or off. The following example configures output 1 on output expander 24 to be 
activated by a box tamper event. This output is controlled by schedule 1. 

1. Navigate with the  keys to CS507 Output Expanders>Output Exp 24>Outputs and press OK.

2. Scroll to Output 1>Event>Tamper/Trouble>Box Tamper and press OK. 

3. The keypad beeps once to accept the change and returns to Tamper/Trouble.

4. Scroll to Schedules and press OK. 

5. Press the relevant keys to select schedule only and press OK.

6. The keypad beeps once to accept the change and returns to Schedules.

7.3.3 Configuring users
You can specify the user code that triggers the selected output. The following example sets user code 1 to 
activate outputs on output expander 24. 

1. Navigate with the  keys to CS507 Output Expanders>Output Exp 24>Outputs>Output 1 and press OK.

2. Scroll to Event>Miscellaneous>Code Entry and press OK. 

3. The keypad beeps once to accept the change and returns to Miscellaneous.

4. Scroll to Zone/User>(User) 1 and press OK. 

5. The keypad beeps once to accept the change and returns to Zone/User.

6. Navigate with the  keys to Users>User 1>Outputs and press OK. 

7. Press the relevant keys to select the outputs that the user code can activate and press OK.

8. The keypad beeps once to accept the change and returns to Outputs.
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7.4 Glossary

Location Term Definition

7 CS507 Output Expanders An expander board that increases the number of outputs that can be used with 
the control panel. 
A menu entry that groups CS507 output expander options.

7.1.1 Outputs A menu entry that groups options relating to programmable outputs.
There are two types of outputs; relay and open collector. The control panel 
includes up to four auxiliary outputs. The CS507 output expander provides 
additional outputs.

7.1.1.1.1 Event Any occurrence such as system arming, faults and alarms.
A menu option that specifies which event activates an output. 

7.1.1.1.1.1 Alarms A CS507 Output Expander menu entry that groups together the alarm events 
that can be selected to trigger an output. 

7.1.1.1.1.2 Arm/Disarm A menu entry that groups the events that can be used to trigger outputs. 

7.1.1.1.1.3 Communications A menu entry that groups together the communication events that can be 
selected to trigger an output. 

7.1.1.1.1.4 Keypads A menu entry that groups the keypad events that trigger an output. 

7.1.1.1.1.5 Sirens A menu entry that groups together the siren events that can be selected to 
trigger an output. 

7.1.1.1.1.6 Tamper/Trouble A menu entry that groups together the tamper and trouble events that can be 
selected to trigger an output. 

7.1.1.1.1.7 Tests A menu entry that groups settings related to different tests. These include tests 
such as automatic test calls, dynamic battery tests and so on. 

7.1.1.1.2 Zone/User A menu entry that specifies that the selected event must occur on a specific 
zone or by a specific user. 

7.1.1.1.3 Time Unit A menu option that specifies whether the outputs are timed in minutes or 
seconds.

7.1.1.1.4 Time A menu option that sets the length of time for which an output is activated. If it 
is set to 0, the output follows the event. 

7.1.1.1.5 Partitions A menu entry that lists the partitions assigned to the selected output. The 
selected output can be triggered by an event on these partitions.

7.1.1.1.6 Attributes A menu entry that groups the programmable attributes of the selected output. 

7.1.1.1.6.1 Latched A menu option that causes an output to remain activated until a code is entered 
at the keypad.

7.1.1.1.6.2 Code Stops Timer A menu option that allows the timer used on programmable outputs to be reset 
by entering a valid user code. 

7.1.1.1.6.3 Only if Closed A menu option that activates an output after closing time and before opening 
time. During these times, codes can be used to arm/disarm the system. A timer 
is used to set these times.

7.1.1.1.6.4 Only if Open A menu option that activates an output between opening time and closing time.

7.1.1.1.6.5 Inverted A menu option that enables a mode that inverts the state of an output (normally 
activated and then deactivated when an event occurs). 

7.1.1.1.6.6 Log Event A menu option that causes the selected output to log an event when it is 
activated. 

7.1.1.1.7 Schedules A menu option that selects the schedules that affect the selected output.
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7.1.1.1.8 X-10 Address A menu option that sets the address of an X-10 device. This is a unique 
number assigned to an X-10 device. It consists of the module number and 
house code. The system uses this address to identify the device. 

7.1.1.1.8.1 Module Number A menu option that sets the X-10 module number used to identify a particular 
X-10 device on the selected module. 
A CSx75 bus module number is assigned to each system module. The system 
uses this number to identify the module. It is also used to report module 
problems (such as tampers and module supervision lost) to the central station.

7.1.1.1.8.2 House Code A menu option that sets the code used to identify a particular premises. It is 
necessary in case any neighbouring premises also has an X-10 home 
automation system. 
More information on the X-10 home automation system can be found at 
www.x-10europe.com.

7.1.2 Schedules A menu entry that groups scheduling options. These options set the times to 
start and end an operation. 

7.1.2.1.1 Opening A menu option that sets the time at which the selected schedule enters the 
open state. 

7.1.2.1.2 Closing A menu option sets the time at which the selected schedule enters the closed 
state. 

7.1.2.1.3 Active A menu option that specifies the days of the week that a particular schedule is 
active. 

7.1.2.1.3.2 Disable on Holidays A menu option that activates the holidays feature. The selected schedule is not 
active on the dates specified in Date of holidays.

7.1.3 Date of holidays A menu option that sets the dates of holidays. If the holidays feature 
(7.1.2.1.3.2) has been enabled, no schedules are active on these dates. Up to 
eight holidays per month can be specified. 

7.1.4 Users A menu option that specifies the zone or user number that triggers the output 
on the expander module or power module. 

7.1.4.1.1 Outputs A menu option that specifies which outputs the selected user can operate. The 
users menu can be used only when event 45 (code entry) is used.

7.1.5 Model A menu option that displays the current model of the selected output expander. 

7.1.6 Version A menu option that displays the current software version of the selected output 
expander. 

7.1.7 Default Settings A menu option that defaults the selected output expander. 

Location Term Definition
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7.5 Technical specifications

Power supply specifications

Power supply voltage 13.8V  ± 2% 

Consumption – No outputs active 10 mA at 13.8V  ± 2% 

Consumption – All outputs active 25 mA at 13.8V  ± 2% + current draw of any device 
attached.

Auxiliary Power output 100 mA max at 13.8V  ± 2% 

General feature specifications

PCB Size Dimensions (width x height x depth) 110x95x25.4 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 115 g
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Chapter 8: Setting up the CS586

8.1 Overview
The CS586 direct connect module is an optional device used to interface the up/download software directly to 
the control panel when the on board serial port is not available. The CS586 direct connect module has four 
programming memories.

8.2 Connecting the CS586 direct connect module
8.2.1 Connecting the CS586 to a PC 

1. Connect the CS586 direct connect module to the serial port of the PC. The layout of the 25 PIN serial 
connector on the PCB is:

2. Connect the cable to the CS586 direct connect module.

3. Using stripped wires, connect the cable with alligator clips to a CSx75 panel as follows:

• Red to POS

• Black to COM

• Green to DATA

1 RS232 connector 4 Waiting for bus communication LED

2 RJ11 (rear-entry connector) 5 Sending data LED

3 Waiting for host communication LED 6 Receiving data LED

Table 8-1: CS586 direct connect module serial connector

Sub D9 D25

RXD PIN 2 PIN 3

TXD PIN 3 PIN 2

GND PIN 5 PIN 7

1

2

3

6
5

4
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8.2.2 Connecting the CS586 to a PC and a panel 
Connect the CS586 direct connect module to the serial port of the PC and the panel as shown in the previous 
section. The black and red connectors can be connected to any 12V DC source and the green connector does not 
need to be connected.

8.2.3 Connecting the CS586 to a panel 

1. Connect the cable with alligator clips to a CSx75 panel as follows:

• Red to POS

• Black to COM

• Green to DATA

< If you are using a CS875 and have a keypad installed in partition 8, keypad 8, it must be removed during this 
operation.

8.3 Programming the CS586 direct connect module 

The control panel’s programming memory can be copied to one of the four programming memories in the CS586 
direct connect module and visa versa. You must enroll and default the module before you begin to program the 
system. For more information on enrolling and defaulting, see chapter B-1 Enrolling modules.

To program the CS586 using the CS5500 keypad, select Installer Menu>CS586 Direct Connect Module. To 
program the CS586 using a PC, start the UDx75 up/download software on the PC.

CS586

CS375/575/875

DATA
AUX+
COM

#

"

!

Files File 1 Panel Type
Panel to File
File to Panel

Options Speed

8.1

8.2

8.1.1

8.2.1

8.1.1.1

8.1.1.2

8.1.1.3
Files 2 - 4
Same as above
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8.3.1 Enabling memory transfer using the CS5500 keypad
The following example uses the CS5500 keypad to copy the control panel’s programming memory to the CS586 
programming memory 2. It then copies programming information from the CS586 programming memory 3 to 
the control panel.

1. Navigate with the  keys to CS586 Direct Connect Module>Files and press OK.

2. To write information from the control panel to the CS586, scroll to File 2>Panel to File and press OK. 

3. Select Yes to confirm and press OK.

4. The control panel’s programming memory is copied to the CS589 direct connect module’s programming 
memory 2. The Receiving Data LED on the CS586 direct connect module flashes while the data is received. 
The keypad sounder chimes when the operation is successful.

5. To read information from the CS586 to the control panel, scroll to File 3>File to Panel and press OK. 

6. Select Yes to confirm and press OK.

7. The information in the CS586 programming memory 3 is copied to the current control panel. The Sending 
Data LED on the CS586 direct connect module flashes while the data is received. The keypad sounder 
chimes when the operation is successful.

8. A triple beep sounds if any error occurs when reading or sending data.

8.3.2 Enabling memory transfer using UDx75 software
The following example uses UDx75 software to copy the control panel’s programming memory to the CS586 
programming memory 2. It then copies programming information from the CS586 programming memory 3 to 
the control panel.

1.  Start the UDx75 upload/download software.

2. The UDx75 Master access screen opens. Enter the operator name and password and press OK. The default 
name and password in the program when it is shipped is Operator Aritech and Password 1278.

3. The UDx75 Operator access screen opens. Enter the operator name and password and press OK. The 
default name and password in the program when it is shipped is Operator Aritech and Password 1278.

4. Select Program>Setup>Direct connect settings and press OK.

5. Select the correct port number and baud rate and press OK. The protocol must be binary (default). The baud 
rate should match the CS586 direct connect module. The default baud rate is 9600. 

6. Select View>Customers>List and choose the account to use from the Customer list screen.

7. Select Download>Connect>Write panel to 586 and download as normal. You are warned that this could 
overwrite user codes if the user changed them.

8. Select where to store the data on the CS586 direct connect module. This overwrites the existing data without 
further prompting.

9. A screen opens indicating that the data is being sent. When this screen disappears, the process is complete.

10. Select Download>Read panel from 586.

11. Select which data should be retrieved on the CS586 direct connect module.

12. A screen opens showing that the data is being read. When this screen disappears, the process is complete.
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8.4 Glossary

8.5 Technical Specifications

Location Term Definition

8 CS586 Direct Connect Module A menu optional device used to interface the up/download software directly to 
the control panel when the on board serial port is not available.

8.1 Files A menu entry that groups the four programming memories in the direct connect 
module. 

8.1.1 File 1 A menu option that selects the programming memories within the direct 
connect module. There are four possible programming memories. 

8.1.1.1 Panel Type A menu option that displays panel type information currently stored in one of 
the four programming memory files in the direct connect module. Possible 
values are CS175, CS275, CS375, CS575 and CS875.

8.1.1.2 Panel to File A menu option that copies a panel’s programming to one of the programming 
memories in the direct connect module. There are four possible programming 
memories in the CS586.

8.1.1.3 File to Panel A menu option to copy programming memory from one of the four memory 
locations contained in the direct connect module, to the control panel. 

8.2.1 Speed A menu option that sets the data communications speed from the CS586 direct 
connect module to the control panel. This can be set from 600 baud to 76.8k 
baud. It is recommended to use the default setting of 9600 baud. 

Power supply specifications

Power supply voltage 13.8V  ± 2% 

Consumption 30 mA at 13.8V  ± 2% 

General feature specifications

Housing Size Dimensions (width x height x depth) 57x100x20 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 150 g

Telephone Telephone requirement Touchtone
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Chapter 9: Setting up the CS534

9.1 Overview
The CS534 listen-in module is a two-way audio and voice communicator for the CSx75 control panel. Once the 
control panel has communicated an alarm, the CS534 listen-in module allows a monitoring service operator to 
listen-in to a customer’s premises. It can also provide basic two-way voice communication. This procedure is 
controlled from the central station by the use of a touch tone telephone.

9.2 Installing the CS534 listen-in module
The CS534 listen-in module is installed on top of the main panel board and must be connected to the expansion 
header. For more details on how to install the CS534 listen-in module in the various housings, see chapter A-4 
Installing a basic system.

1
Microphone channels A and B
Wire run can be 300 m if microphone wires are in a separate jacket from the speaker, 150 m if in the same jacket.

2
Speaker terminals
Maximum speaker wire run = 300 m
Minimum speaker rating is 5 W, 8 ohms

3 Supervision LED

4 Expansion port

5 Bus supervision LED

6 Processor

7 X-10 Connection: RJ11
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9.2.1 Wiring the CS534 listen-in module

9.2.2 General operating instructions
The system operates as follows, regardless of how a two-way session is started.

• The session timer is started. Select CS534 Listen-in Module>Timers>Session Timeout.

• All microphones are on. Select Installer Menu>CS534 Listen-in Module>Feature Select>Mic A at Startup or 
Installer Menu>CS534 Listen-in Module>Feature Select>Mic B at Startup.

• Low gain listen-in audio mode is selected (automatic).

• Level 0 command set is active (automatic).

• The CS534 listen-in module operates in one of two modes that must be programmed in. Select CS534 Listen-
in Module>Feature Select>Mode.

9.2.2.1 Line hold mode

1. An alarm is recognized.

2. The phone line is seized from the control panel and all phones on the premises.

3. The line disconnects (goes off the hook).

4. The CS534 listen-in module sends a tone indicator to the central station. For more details see Tones.

5. If a line hold digit has been programmed, the system will wait for the digit to be received before a two-way 
session is started. To check this, select CS534 Listen-in Module>Line Hold digit. If the digit is not received 
before the time-out period, the system returns to stand-by mode and waits for a new trip.

6. If the line hold digit is received or not programmed, the system starts a two-way session.

9.2.2.2 Call back mode

1. An alarm is recognized.

2. The phone line is seized from the control panel and all phones on the premises.

3. The line disconnects (goes off the hook).

4. The CS534 listen-in module starts the call back window timer. If the time runs out before the number of rings 
has been reached, the system returns to stand-by mode and waits for a new trip.

5. The CS534 listen-in module waits to receive the call back, up to the selected number of minutes programmed 
in for the first ring.

Table 9-1: CS534 terminal connections

Terminal Description

Connector on the left side.

1 Connect positive side of microphone #A.

2 Connect negative side of microphone #A.

3 Connect positive side of microphone #B.

4 Connect negative side of microphone #B.

SPK+ SPK- Connect to the speaker(s). Maximum speaker wire run: 300m. Minimum 
speaker rating: 5 Watts, 8 Ohms. Do not go below 4 Ohms.
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6. The CS534 listen-in module sends a continuous indicator tone to the central station until the access code is 
received or the maximum number of attempts is exhausted. When a code is received, the indicator tone is 
silenced.

7. The CS534 listen-in module waits for the access code to match. The reset [#] key may be used during PIN 
entry to clear the PIN buffer. If the access code does not match after a set number of attempts, the system 
returns to stand-by mode and waits for a new trip. If the code is validated, the system silences the siren and 
starts a two-way session.

9.2.3 Control levels
Levels of the modes may be changed at any time by pressing * followed by the level number you wish to access 
on a touch-tone telephone. If no key is pressed for 3 seconds on the telephone, then the buffer is automatically 
cleared. Press * on the telephone twice to return to the beginning.

• If a new alarm in the same partition is activated during a two-way session, the session timer can be extended 
by pressing a key before the session times out.

• If a new alarm in a different partition is activated during a two-way session, the timer is reduced to 20 
seconds, and cannot be extended.

" Levels 1, 2 and 4 are not supported. Attempts to access these levels will revert to Level 0

Table 9-2: CS534 control levels

Level
0

Basic control level

0 Returns to the initial session settings when it is tripped. This includes the microphone 
selection and audio mode.

1 High gain talk to the premises and extends the session time.

3 High gain listen-in from the premises and extends the session time.

2, 4, 5, 7, 8, 9 Extends the session time.

6 Low gain listen-in from the premises and extends the session time.

88 Terminates the session and starts the call back mode.

99 Terminates the session and returns to the stand-by mode and waits for a new trip.

Level
3

Microphone control (zoning)

0 Returns to the initial session settings when it was tripped. This includes the microphone 
selection and audio mode.

1 Turns microphone 1 on, microphone 2 off, and extends the session time.

2 Turns microphone 2 on, microphone 1 off, and extends the session time.

3, 4, 5, 6, 7, 8 Extends the session time.

9 Turns both microphones on and extends the session time.

Level
5

Output / relay control level (negative—turn off)
Note: This feature requires X-10 Interface.

0 Returns to the initial session settings when it is tripped. This includes the microphone 
selection and audio mode.

1 – 9 Turns the corresponding output/relay OFF. A negative confirmation tone (two low beeps) 
is heard. For more information, see Table 9-3: CS534 tones.
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9.2.4 Tones
These indicator tones may be heard at the central station during a two-way session. The definition of these 
indicator tones is as follows:

LOW = 400 HzMID = 1000 Hz.................................... HIGH = 1600 Hz

Level
6

Output / relay control level (positive—turn
 Note: This feature requires X-10 Interface.

0 Returns to the initial session settings when it is tripped. This includes the microphone 
selection and audio mode.

1 - 9 Turns the corresponding output/relay ON. A positive tone sounds.

Level
7

Status check

0 Returns to the initial session settings when it is tripped. This includes the microphone 
selection and audio mode.

1 Armed status: If partition 1 is armed, a positive tone sounds. If disarmed, a negative tone 
sounds.

2 Ready status: If partition is in Ready status, a positive tone sounds. If it is not Ready, a 
negative tone sounds.

3 Power status: If AC and battery are good, a positive confirmation tone sounds. If either 
AC or battery is bad, a negative tone sounds.

4 – 9 Extends the session time.

Level
8

Arming / disarming partition 1

0 – 9 Enter your PIN user code to arm or disarm the system. If partition 1 is armed, a positive 
beep sounds. If partition 1 is disarmed, a negative beep sounds. 

Table 9-3: CS534 tones

Tone Description

One high tone for 100 mS Time remaining indicator “A “.

One mid tone for 100 mS Time remaining indicator “B”.

One mid tone for 100 mS, off for 100 mS, one high tone for 
100 mS

New alarm alerts for the same partition.

One high tone for 100 mS, off for 100 mS, one mid tone for 
100 mS, off for 100 mS, one high tone for 100 mS

New alarm alerts for a different partition.

Continuous on/off high tone every 100 mS; will stop after a 
digit is received

System waiting for access PIN.

One low tone for 200 mS (if enabled) Anti lock-up

One mid tone for 500 mS Acknowledgement to level change command.

One mid tone for 250 mS, off for 250 mS, one mid tone for 250 
mS, off for 250 mS, one mid tone for 250 mS

Error tone

One low tone for 100mS Relay / Output turned ON, or
Positive Status response, or
Partition 1 armed.

One low tone for 100mS; off for 200mS; one low tone for 100 
mS

Relay / Output turned OFF, or
Negative Status response, or
Partition 1 disarmed.

Table 9-2: CS534 control levels
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9.3 Programming the CS534 listen-in module

You must enroll and default the CS534 module before you begin to program the system. For more information 
on enrolling and defaulting, see chapter 6. To program the CS534, select Installer Menu>CS534 Listen-in 
Module. 

9.3.1 Configuring listen-in options
You can configure the listen-in mode and listen-in options. The following example prevents the central station 
turning on the speaker at the premises if a duress, silent panic or hold-up alarm is reported by the control panel.

1. Navigate with the  keys to CS534 Listen-in Module>Feature Select and press OK. 

2. Scroll to Speaker Lockout>Yes and press OK. 

3. The keypad beeps once to accept the change and returns to Speaker Lockout.

9.3.2 Programming timers
You can set timers to control various CS534 listen-in module features. The following example sets the line hold 
digit to 2 and line hold timeout to 60 seconds.

1. Navigate with the  keys to CS534 Listen-in Module>Line Hold Digit and press OK. 

2. Select 2 and press OK.

3. The keypad beeps once to confirm the change and returns to Line Hold Digit.

4. Scroll to Timers>Line Hold Timeout and press OK. 

5. Select 60 and press OK.

6. The keypad beeps once to confirm the change and returns to Line Hold Timeout.

9.3.3 Setting volume levels
You can adjust volume levels used with the CS534 listen-in module. The following example sets the volume for 
high gain listen in  to level 4. 

Timers

Mode
Listen-in Only
Speaker Lockout
Mic A at Startup
Mic B at Startup
Answer Machine Defeat
Status Check
Arming/Disarming

Feature Select

X-10 Devices

Volumes

Model
Version
Default Settings

Low Gain Listen In
High Gain Listen In
Speaker

Call Back Code
Line Hold Digit
Wrong PIN Digit Entries
Rings to Answer

Device 1

9.1

9.2

9.6

9.5

9.4

9.3

9.7

9.8

9.9

9.11

9.10

9.1.1

9.1.2

9.1.3

9.1.4

9.1.5

9.1.6

9.1.7

9.1.8

9.6.1

9.6.2

9.6.3

9.6.4

9.6.5

9.6.6

9.6.7

9.7.1

9.7.2

9.7.3

9.8.1

Line Hold Timeout
New Trip Hangup Time
Call Back Window Timer
Session Timeout
Indicator-A Time Remaining

Anti-Lock-Up Tone Time
Indicator-B Time Remaining

Module Number
House Code

9.8.1.1

Devices 2 - 9
Same as above

9.8.1.2



CS875-575-375-275-175 Installers Manual with CS5500 keypadB.9.6

1. Navigate with the  keys to CS534 Listen-in Module>Volumes and press OK.

2. Scroll to High Gain Listen In>4 and press OK.

3. The keypad beeps once to accept the change and returns to High Gain Listen In.

9.3.4 Assigning X-10 devices
The CS534 listen-in module can activate X-10 devices over the telephone. The following example assigns device 
1 (module number 5, house code L) to the CS534 listen-in module.

1. Navigate with the  keys to CS534 Listen-in Module>X-10 Devices>Device 1 and press OK.

2. Scroll to Module Number and press OK.

3. Select 5 and press OK.

4. The keypad beeps once to confirm the change and returns to Module Number.

5. Scroll to House Code and press OK.

6. Select L and press OK.

7. The keypad beeps once to confirm the change and returns to House Code.

9.4 Glossary

Location Term Definition

9 CS534 Listen-in Module A two-way audio voice communicator. If the control panel communicates an 
alarm, the audio module allows the central station to establish a two-way 
session or monitor the premises for listen-in purposes.

9.1 Feature Select A menu entry that groups all optional features relating to partition settings, 
control panel system settings and so on. 

9.1.1 Mode A menu option that specifies if the listen-in module is used in line hold mode or 
call back mode. 

9.1.2 Listen-in Only A menu option that enables the listen-in only mode. This is the mode in which 
the central station can monitor sounds at the customer's premises but cannot 
establish two-way communication. 

9.1.3 Speaker Lockout A menu option that prevents the central station turning on the speaker at the 
premises if a duress, silent panic or hold-up alarm is reported by the control 
panel. 

9.1.4 Mic A at Startup A menu option that activates microphone A when listen-in commences.

9.1.5 Mic B at Startup A menu option that activates microphone B when listen-in commences.

9.1.6 Answer Machine Defeat A menu entry used to defeat an answering machine. A telephone call is made 
to the premises and is answered by an answering machine or other device. If 
tone-sniff AMD is enabled, only one call is required to defeat the answering 
machine. The computer calls the panel as normal. When the answering 
machine answers, the panel hears the tones from the modem and seizes the 
phone line for a download.

9.1.7 Status Check A menu option that allows the end-user to verify the system status using a 
touch phone. This option enables level 7. 

9.1.8 Arming/Disarming A menu option that allows the end-user to arm/disarm the system from a 
remote location using a touch phone (for example, GSM). This option enables 
level 8. 
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9.2 Call Back Code A menu option that specifies the code that starts a listen-in session when the 
panel is in call back mode. This code can be a maximum of six digits long. 

9.3 Line Hold Digit A menu option that specifies the digit that starts a two-way session when the 
control panel is in line hold mode. 

9.4 Wrong PIN Digit Entries A menu option that specifies the maximum number of incorrect digits that can 
be entered for call-back and call-in features before the panel is locked out.

9.5 Rings to Answer A menu option that sets the number of rings that must occur before the panel 
answers to start a listen-in session. If the value is 0, the panel or the CS534 will 
never react to an incoming phone line and will never pick up the phone line. 
Regulations in some countries do not allow a call in from an installer or central 
station without approval by the end-user. In this case the Answer U/D Call or 
Begin U/D Call menu options should be used instead.  

9.6 Timers A menu entry that groups timer options. 

9.6.1 Line Hold Timeout A menu option that sets the length of time the listen-in module will remain on 
the phone line with no activity from the central station. This time can be set 
from 30 to 255 seconds. If it does not receive the digit within this time, the 
listen-in module disconnects.

9.6.2 New Trip Hangup Time A menu option that sets the time at which the two-way session timer is reset if 
a new event occurs in a partition during a two-way session between the 
partition and the central station.  

9.6.3 Call Back Window Timer A menu option that sets the amount of time, in one-minute increments, that the 
CS534 listen-in module will wait to call back after an alarm has been reported.

9.6.4 Session Timeout A menu option that defines how long the listen-in module remains on the 
phone line with no activity from the central station. 

9.6.5 Indicator-A Time Remaining A menu option that sets the length of time remaining after indicator “A” is sent 
to the central station. The two-way session is terminated after this time if there 
is no further activity from the central station. This time can be set between 1 
and 255 seconds. 

9.6.6 Indicator-B Time Remaining A menu option that sets the length of time remaining after indicator “B” is sent 
to the central station. The two-way session is terminated after this time if there 
is no further activity from the central station. This time can be set between 1 
and 255 seconds. 

9.6.7 Anti-Lock-Up Tone Time A menu option that sets the interval at which the anti-lock-up tone is sounded 
at the central station. 

9.7 Volumes A menu entry that groups options to adjust levels used with the CS534 listen-in 
module. 

9.7.1 Low Gain Listen In A menu option that enables the mode in which the central station listens in to 
the customer’s premises. This mode is used in environments where 
background noise may distort the audio. 

9.7.2 High Gain Listen In A menu option that activates high gain listen-in mode. This is a listen-in mode 
that is generally used in environments that produce very low noise. 

9.7.3 Speaker A menu option that sets the volume of the speaker.

9.8 X-10 Devices A menu entry that groups X-10 device options for the selected listen-in module.

9.8.1.1 Module Number A menu option that sets the X-10 module number used to identify a particular 
X-10 device on the selected module. 
A CSx75 bus module number is assigned to each system module. The system 
uses this number to identify the module. It is also used to report module 
problems (such as tampers and module supervision lost) to the central station.

Location Term Definition
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9.5 Technical specifications

9.8.1.1 House Code A menu option that sets the code used to identify a particular premises. It is 
necessary in case any neighbouring premises also has an X-10 home 
automation system. 
More information on the X-10 home automation system can be found at 
www.x-10europe.com.

9.9 Model A menu option that displays the current model of the selected module. 

9.10 Version A menu option that displays the current software version of the selected 
module.

9.11 Default Settings A menu option that defaults the selected module to factory defaults. 

Power supply specifications

Power supply voltage 13.8V  ± 2%  

Consumption – Not in session 50 mA at 13.8V  ± 2%  

Consumption – 2 way listen-in in session 100 mA at 13.8V  ± 2%  

General feature specifications

PCB Size Dimensions (width x height x depth) 100x96x25.4 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 115 g

Telephone Telephone requirement Touchtone

Location Term Definition



CS875-575-375-275-175 Installers Manual with CS5500 keypad B.10.1

Chapter 10: Setting up the CS320

10.1 Overview
The CS320 is an auxiliary power module that can be used with the CSx75 range of panels. It has three programmable 
outputs and one dedicated sounder output. 

You can use up to eight CS320 auxiliary power modules to supply 32 outputs for the panel, 24 of which are 
programmable and eight are dedicated sounder outputs. The 24 programmable outputs can be used as auxiliary power, 
fire detector power and sounder power outputs.

10.2 Installing the CS320 auxiliary power module
Each CS320 auxiliary power module has a tamper terminal that can be used to supervise the casing. 

When the CS320 auxiliary power module is connected to the CSx75, the maximum total wire run to all devices is 750 
metres. Each CS320 auxiliary power module should be connected individually to the CSx75 and not in series.

. 

1 DIP switches 4 Bell 7 Earth

2 Outgoing terminals 5 Tamper terminal 8 Tamper switch (not used)

3 Outputs 6 Incoming bus terminals 9 AC inputs

1

234567

9
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10.2.1 Wiring the CS320 auxiliary power module

10.2.2 Setting the DIP switches
DIP switches 1-3 set the address of the CS320 auxiliary power module.

DIP switch 4 controls the tamper feature. On enables tamper. Off disables tamper.

Table 10-1: CS320 auxiliary power module terminal connections

Terminal Description

DATA Connect to the KP DATA terminal of the CSx75. This terminal is the incoming data-
signalling terminal to the CS320 auxiliary power module. 

COM Connect to the KP COM terminal of the CSx75. This terminal supplies the common side of 
the power to the CS320 auxiliary power module.

POS Connect to the KP POS  terminal of the CSx75. 

DATA This terminal is the outgoing data-signalling terminal for the bus extension.

COM Common terminal for any device powered by the CS320 auxiliary power module.

OUT A Programmable output current limited to 1.9 A.1

1.The total current of the CS320 auxiliary power module is 2.5 A. There can be a total 
of 1.9 A between outputs A, B and C and a total of 2.5 A between the sounders and 
outputs.

OUT B Programmable output current limited to 1.9 A. 

COM Common terminal for any device powered by the CS320 auxiliary power module.

OUT C Programmable output current limited to 1.9 A. 

BELL + Positive sounder current limited to 2.5 A. 

BELL - Negative sounder current limited to 2.5 A. 

TAM Optional tamper terminal. Connect the normally closed tamper switch between this terminal 
and COM. If DIP switch 4 is off, this feature is not used.

EARTH (GND) Earth Ground

AC AC input. Connect to a 16.5 V 50 VA transformer.

Table 10-2: CS320 auxiliary power module DIP switches

DIP switch 1-3 settings Address  DIP switch 1-3
 settings

Address

  
84

    
88

  
85

    
89

   
86

    
90

   
87

       
91

 = ON      = OFF     
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10.2.3 Enrolling the CS320 auxiliary power module

1. Set DIP switches 1-3 to the correct address.

2. Select Enrol Modules>Enrol and press OK. to enrol the CS320 auxiliary power module. The enrolling 
process takes about 12 seconds. User codes are not accepted during the enrolling process. 

10.3 Programming the CS320 auxiliary power module

You must enroll and default the CS320 power module before you begin to program the system. For more information 
on enrolling and defaulting, see Enrolling the CS320 auxiliary power module above and chapter B-1 Enrolling 
modules. To program the CS320 power module, select Installer Menu>CS320 Power Modules. 

10.3.1  Configuring outputs
You can specify events and partitions that can activate a particular output. The outputs are triggered based on different 
events. The events are grouped in the programming tree. A full list of all possible selectable events can be found in 
Table 10-3: CS320 power module output events.   You can also assign a defined attribute to the output. The following 
example enables user code 1 to reset the timer on output 1, power module 84 when an autotest event occurs.  

1. Navigate with the  keys to CS320 Power Modules>Power Module 84>Outputs and press OK.

2. Scroll to Output 1>Event>Tests>Automatic Test and press OK.  

3. The keypad beeps once to accept the change and returns to Tests.

4. Scroll to Attributes>Code Stops Timer>Yes and press OK.  

5. The keypad beeps once to accept the change and returns to Code Stops Timer.

6. Navigate with the  keys to Users>(1) User 1>Outputs> and press OK. 

7. Press the relevant keys to select output 1 only and press OK.

8. The keypad beeps once to accept the change and returns to Outputs.

Time Unit
Time
Partitions

OutputsPower Module 84

Feature Select Mains Delay Time
Battery Test
Battery Test Time

Reports

1 (<Event>) Event Alarms
Arm/Disarm
Communications
Keypads
Sirens
Tamper/Trouble
Tests
Miscellaneous

Attributes Latched
Code Stops Timer
Inverted
Disable on Listen-in

Report Mains Fault Always
Low Battery
Siren Tamper/Trouble

Users (1) User 1 Outputs

10.1 10.1.1

10.1.2

10.1.3

10.1.4

10.1.5

10.1.6

10.1.1.1

10.1.2.1

10.1.3.1

10.1.3.3

10.1.3.2

10.1.3.4

10.1.1.1.1

10.1.1.1.2

10.1.1.1.3

10.1.1.1.4

10.1.1.1.5

10.1.2.1.1

10.1.3.4.1
10.1.3.4.2

10.1.3.4.3

10.1.1.1.1.1

10.1.1.1.1.8

10.1.1.1.1.7

10.1.1.1.1.6
10.1.1.1.1.5

10.1.1.1.1.4

10.1.1.1.1.3

10.1.1.1.1.2

10.1.1.1.5.1

10.1.1.1.5.4

10.1.1.1.5.3

10.1.1.1.5.2

Power Modules 85 - 91
Same as above

Outputs 2 - 3
Same as above

Users 2 - 99 
Same as above
If more than 10 users, 
users are first displayed in 
groups of 10 and then 
displayed as above.

Model
Version
Default Settings
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10.3.2 Configuring features
You can configure testing and reporting features for the CS320 power module. The following example enables a battery 
test which lasts for 60 minutes and sends a report to the central station when a low battery condition occurs. 

1. Navigate with the  keys to CS320 Power Modules>Power Module 84>Feature Select and press OK.

2. Scroll to Battery Test>Enabled and press OK. 

3. The keypad beeps once to accept the change and returns to Battery Test.

4. Scroll to Battery Test Time and press OK.

5. Select 60 min. and press OK.

6. The keypad beeps once to confirm the change and returns to Battery Test Time.

7. Scroll to Reports>Low Battery>Yes and press OK. 

8. The keypad beeps once to accept the change and returns to Low Battery.

Table 10-3: CS320 power module output events

# Event # Event # Event

Alarms Arm/disarm Misc

17 Alarm Memory 21 Armed 32 Code Entry

Tests 22 Disarmed 7 Program Mode

3 Dyn Battery Test 23 Ready to Arm 0  Always On

Tampers 18 Entry Keypads

25 Fire LED 19 Exit 29 Keypad Fire

11 Smoke Det Reset 20 Entry or Exit 30 Keypad Medical

8 Over-current 24 Not Ready to Arm 31 Keypad Panic

9 Box Tamper Sirens 28 Keypad Beeping

10 Siren Tamper 12 Burglary Siren 27 Chime

26 Fire Trouble 13 Fire Siren Communications

1 Mains Failure 14 Any Siren 4 Listen-in

2 Low Battery 15 Fire Sir Steady 5 Line Seizure

16 Any Sir Temporal 6 Phone Line Fault
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10.4 Glossary

Location Term Definition

10 CS320 Power Modules A module that provides an additional power supply if the system is using more 
peripherals than can be serviced by the panel power supply. 

10.1 Power Module 84 A menu entry that groups all options for the selected power module. 

10.1.1 Outputs

A menu entry that groups options relating to programmable outputs.
There are two types of outputs; relay and open collector. The control panel 
includes up to four auxiliary outputs. The CS320 power module provides 
additional outputs.

10.1.1.1.1 Event Any occurrence such as system arming, faults and alarms.
A menu option that specifies which event activates an output. 

10.1.1.1.1.1 Alarms A menu entry that groups together the alarm events that can be selected to 
trigger an output. 

10.1.1.1.1.2 Arm/Disarm A menu entry that groups the events that can be used to trigger outputs. 

10.1.1.1.1.3 Communications A menu entry that groups together the communication events that can be 
selected to trigger an output. 

10.1.1.1.1.4 Keypads A menu entry that groups the keypad events that trigger an output.  

10.1.1.1.1.5 Sirens A menu entry that groups together the siren events that can be selected to 
trigger an output. 

10.1.1.1.1.6 Tamper/Trouble A menu entry that groups together the tamper and trouble events that can be 
selected to trigger an output. 

10.1.1.1.1.7 Tests A menu entry that groups settings related to different tests. These include tests 
such as automatic test calls, dynamic battery tests and so on. 

10.1.1.1.2 Time Unit A menu option that specifies whether the outputs are timed in minutes or 
seconds.

10.1.1.1.3 Time A menu option that sets the length of time for which an output is activated. If it 
is set to 0, the output follows the event. 

10.1.1.1.4 Partitions A menu entry that lists the partitions assigned to the selected output. The 
selected output can be triggered by an event on these partitions.

10.1.1.1.5 Attributes A menu entry that groups the programmable attributes of the selected output. 

10.1.1.1.5.1 Latched A menu option that causes an output to remain activated until a code is entered 
at the keypad.

10.1.1.1.5.2 Code Stops Timer A menu entry that allows the timer used on programmable outputs to be reset 
by entering a valid user code. 

10.1.1.1.5.3 Inverted A menu option that enables a mode that inverts the state of an output (normally 
activated and then deactivated when an event occurs). 

10.1.1.1.5.4 Disable on Listen-in
A menu option that disables the selected output during listen-in time. This 
option is normally used to silence sirens during listen-in. After the listen-in 
session, the sirens are activated again. 

10.1.2 Users A menu option that specifies the zone or user number that triggers the output 
on the expander module or power module. 

10.1.2.1.1 Outputs A menu option that specifies which outputs the selected user can operate. 

10.1.3 Feature Select A menu entry that groups all optional features relating to the selected module.
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10.1.3.1 Mains Delay Time
A menu option that sets the length of time between detecting a mains failure on 
a power module and sending a report to the central station. The restore event 
is sent four minutes after the mains is restored. 

10.1.3.2 Battery Test
A menu option that enables a test to determine whether the battery is 
connected to the power module. This test is usually performed automatically 
when the system is first powered up and periodically thereafter.

10.1.3.3 Battery Test Time A menu option that sets the length of time that the power module performs the 
battery test. This can be between 0 to 255 minutes where 0 is no test. 

10.1.3.4 Reports A menu entry that groups report options for the selected module.

10.1.3.4.1 Report Mains Fault Always

A menu option that sends a report to the central station if power is lost for the 
time programmed in Mains Delay Time. If this option is disabled, the report is 
sent only if the control panel has not sent a mains power lost report and Mains 
Fail report is enabled.  
This option applies only to the CS320 power module and not to the control 
panel. 

10.1.3.4.2 Low Battery A menu option that enables low battery reporting on a CS320 power module. 

10.1.3.4.3 Siren Tamper/Trouble A menu option that sends a report to the central station when a power module 
siren tamper or trouble condition occurs.

10.1.4 Model A menu option that displays the current model of the selected module.

10.1.4 Version A menu option that displays the current software version of the selected 
module.

10.1.5 Default Settings A menu option that defaults the selected module to factory defaults.

Location Term Definition
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10.5 Technical specifications

Mains power specifications

Mains Input Voltage (25VA Transfo) 230V ~ - 50Hz ± 10% - 25VA

Mains Input Voltage (40VA Transfo) 230V ~ - 50Hz ± 10% - 40VA

Current consumption at 230V~ (25 VA) 0.108 A

Current consumption at 230V~ (40 VA) 0.173 A

Main board supply voltage 16.5 V ~  typical

Power supply specifications

Power supply voltage 13.8V  ± 2%  

Consumption - Standby 40 mA at 13.8V  ± 2%  

Consumption – Maximum 110 mA at 13.8V  ± 2%  

General feature specifications

PCB Size Dimensions (width x height x depth) 161x108x28 mm

Housing Size Dimensions (width x height x depth) DHX75PB 380x260x120 mm
DHX75PBM 450x300x90 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 146g



CS875-575-375-275-175 Installers Manual with CS5500 keypadB.11.1

Chapter 11: Setting up the CS535

11.1 Overview
The CS535 voice module reports alarm events to designated phone numbers using pre-recorded voice messages. 
You record the voice messages using a normal analog telephone. When an alarm event occurs, the control panel 
establishes a telephone connection with a specified phone number and informs the CS535 voice module to report 
configured events. 

The CS535 voice module can send four types of voice message in a report. 

• A leader message announces the report. 

• An event message describes the event(s) that have occurred. 

• An address message identifies the premises reporting the event(s). 

• A kiss off message confirms receipt of a kiss off digit.

The voice module informs the panel when it is finished reporting and the panel closes the connection with the 
phone.  

11.2 Installing the CS535 voice module
The CS535 voice module can be connected directly to the board. If a CS534 listen-in module is used, the CS535 
voice module is connected to the board and the CS534 listen-in module is attached to it via a ribbon cable. If a 
CS7002 GPRS module is used, the CS7002 GPRS module is connected to the board and the CS535 listen-in 
module is attached to it via a ribbon cable. 

For information on installing the CS535 voice module in the various housings, see chapter A-4 Installing a basic 
system.

1 Rear entry connector 5 RJ11 telephone connection

2 Reporting LED 6 Record/playback LED

3 Bus supervision LED 7 Record/playback button

4 Processor 8 Expansion port for CS534 listen-in module

1

2

3

4

5 6

7

8
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11.3 Programming the CS535 voice module

You must enroll and default the CS535 voice module before you begin to program the system. For more 
information on enrolling and defaulting, see chapter B-1 Enrolling modules. To program the CS535, select 
Installer Menu>CS535 Voice Module. 

11.3.1 Configuring the control panel for voice reporting
You must enable event reporting in the control panel and program the zones types for which reports are sent. 
You must also map each event to a recorded message. You can map one message to a number of events. For 
more information see chapter B-2 Programming the control panel.

Events can be reported to six phone numbers. Each phone number has it own account code, protocol and events. 
You must program this information for phone number 1 at least. You can also set number of dial attempts and a 
dialer delay for voice reporting. For more information, see chapter B-2 Programming the control panel. 

< To allow a user to cancel reports and stop voice reporting by entering a user code, enable the abort all 
function. This is useful in the case of a false alarm. Select Control Panel>System Settings>Feature 
Select>Miscellaneous>All Abort>Enabled and press OK. 

11.3.2 Recording voice messages
The CS535 voice module can store up to 18 recorded voice messages. There must be one leader message and one 
address message. There can be an optional kiss off message. The remaining 15 messages are event messages. 
The messages can be recorded altogether or one at a time. Some events may be covered by one message. The 
following steps explain how to record different messages.

1. Connect a telephone handset to the phone jack on the CS535 voice module.

2. Navigate with the  keys to CS535 Voice Module>Recording and press OK.

3. Complete one of the following steps depending on the message(s) you want to record.

- To record all messages, scroll to All in Sequence and press OK.

- To record one message at a time, scroll to the relevant menu option and press OK. For example, to 
record the leader message, scroll to Leader Message and press OK.

- To record a single event message, scroll to Single Event Message and press OK. Select the number of 
the message (1-15) and press OK.

- To record a range of event messages, scroll to Multiple Event Message and press OK. Select the number 
of the first message (1-15) and press OK.

4. Press the recording/playback button on the CS535 voice module and record the message. 

All in Sequence
Leader Message

Message 1

Recording

Handshake Digit
Kiss Off Digit
Model
Version
Default Settings

Single Event Message
Multiple Event Messages

Address Message
Kiss Off Message

Playback All in Sequence
Leader Message

Single Event Message
Multiple Event Messages

Message 1

Address Message
Kiss Off Message

11.1

11.2

11.3

11.4

11.5

11.6

11.7

11.1.1

11.1.2

11.1.6

11.1.5

11.1.4
11.1.3

11.2.1

11.2.2

11.2.6

11.2.5

11.2.4

11.2.3

11.1.3.1

11.2.3.1

Messages 2 - 15
Same as above

Messages 2 - 15
Same as above
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5. If you a recording a single message, press the recording/playback button to stop recording. The message is 
played back.

6. If you are satisfied with the message, press the recording/playback button to record the next message. Do not 
start recording the next message while the recording/playback LED is lit.

7. To re-record a message, press the recording/playback button twice in quick succession and re-record the 
message.

8. If you are recording a range of messages, continue recording each message until you have finished. All the 
messages are played back in sequence when you have recorded and played back the final message.

9. Record all messages finishing with the address message.

11.3.3 Playing back messages
Pre-recorded voice messages can be played back altogether or one at a time. The following steps explain how to 
playback different messages.

1. Connect a telephone handset to the phone jack on the CS535 voice module.

2. Navigate with the  keys to CS535 Voice Module>Playback and press OK.

- To playback all messages, scroll to All in Sequence and press OK.

- To playback one message at a time, scroll to the relevant menu option and press OK. 

- To playback a single event message, scroll to Single Event Message and press OK. Select the number of 
the message (1-15) and press OK.

- To playback a range of event messages, scroll to Multiple Event Message and press OK. Select the 
number of the first message (1-15) and press OK.

3. Press the recording/playback button on the CS535 voice module to playback the message. 

4. Press the recording/playback button to playback the next message. 

11.3.4 Configuring handshake and kiss off
Handshake and kiss off can be programmed as any key press or as a specific telephone key. The following steps 
explain how to configure these digits. 

< The voice protocol cannot generate a ‘fail to communicate’ signal.

1. Navigate with the  keys to CS535 Voice Module>Handshake Digit and press OK.

2. Select the handshake digit and press OK.

3. The keypad beeps once to accept the change.

4. Scroll to Kiss Off Digit and press OK.

• Select the kiss off digit and press OK.

• Select Any Digit to program any key press as the handshake/kiss off digit. This is the default.

• Select None to disable kiss off.

5. The keypad beeps once to accept the change.



CS875-575-375-275-175 Installers Manual with CS5500 keypad B.11.4

11.4 Glossary

Location Term Definition

11 CS535 Voice Module A module used to send pre-recorded voice messages when activated.

11. Recording A menu entry that groups recording options for messages sent by the voice 
module. 

11.1.1 All in Sequence
A menu command that records all voice messages in sequence. The sequence 
is: Leader message; 15 messages that can be linked to different types of event 
(such as, alarms or opening/closing); Kiss off message; Address message. 

11.1.2 Leader Message A menu command that records the leader message. This message is sent by 
the CS535 voice module at the start of a voice reporting phone call. 

11.1.3 Single Event Message A menu command that records a single event message. This message is sent 
by the voice module and states the event that has occurred. 

11.1.4 Multiple Event Messages A menu command that records a multiple event message. This message is 
sent by the CS535 voice module and states the events that have occurred. 

11.1.5 Address Message A menu command that records the address message. This message is sent by 
the CS535 voice module and states where an event has occurred.

11.1.6 Kiss Off Message
A menu command that records the kiss off message. This message is sent by 
the CS535 voice module at the end of a voice reporting phone call to indicate 
that the kiss off digit has been received. 

11.2 Playback A menu entry that groups options that allow the installer to play back recorded 
voice messages. 

11.2.1 All in Sequence A menu command that plays back all voice messages in sequence. 

11.2.2 Leader Message A menu command that plays back the leader message. 

11.2.3 Single Event Message A menu command that plays back a single message. 

11.2.4 Multiple Event Messages A menu command that plays back multiple event messages in a row. 

11.2.5 Address Message A menu command that plays back the address message. 

11.2.6 Kiss Off Message A menu command that plays back the kiss off message. 

11.3 Handshake Digit

A menu option that specifies the handshake digit. This digit is sent from the 
central station (in the case of a CS535 voice module, this is usually a house 
phone or a mobile phone) to the control panel in order to establish a 
connection. 

11.4 Kiss Off Digit A menu option that specifies the digit that the voice module accepts as a signal 
from the telephone saying that the person has understood the message. 

11.5 Model A menu option that displays the current model of the selected module. 

11.6 Version A menu option that displays the current software version of the selected 
module. 

11.7 Default Settings A menu option that defaults the selected module to factory defaults. 
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11.5 Technical specifications

Power supply specifications

Power supply voltage 13.8V  ± 2% 

Consumption – Not in session 30 mA at 13.8V  ± 2% 

Consumption – 2 way listen-in in session 100 mA at 13.8V  ± 2% 

General feature specifications

PCB size Dimensions (width x height x depth) 57x100x20 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 150 g

Telephone Telephone requirement Touchtone
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Chapter 12: Setting up the CS1700

12.1 Overview 
The CS1700 is a proximity card reader/door control module. Up to 15 readers can be connected to the CSx75 
control panel, depending on the model of panel. The CS1700 can be programmed to control access in any or all 
areas. The LEDs can be programmed to follow the output and/or the armed or ready status of the system. It has 
an optional optical tamper switch. The CS1700 proximity reader can be used only with the CS375, CS575 and 
CS875.

There are three badging actions that can activate a particular function or an X-10 device. These actions are 
different depending on whether you are in default mode or legacy mode. 

In default mode:

• Single badge (1 beep) - a proximity card is held against the proximity reader for one beep.

• Double badge (2 beeps) - a proximity card is held against the proximity reader for two beeps.

• Badge hold (3 beeps) - a proximity card is held near the proximity reader for three beeps. 

In legacy mode:

• Single badge (1 beep) - a proximity card is held once against the proximity reader.

• Double badge (2 beeps) - a proximity card is held against the proximity reader twice within the time set in 
Scan Time.

• Badge hold (3 beeps) - a proximity card is held near the proximity reader for longer than the time set in Scan 
Time.

12.2 Installing the CS1700 proximity reader

1. Place the screws in the screw holes of the CS1700 proximity reader. Attach to the door.

2. Place the cover on the CS1700 proximity reader.



CS875-575-375-275-175 Installers Manual with CS5500 keypadB.12.2

12.2.1 Wiring the CS1700 proximity reader

12.2.2 Enrolling the CS1700 proximity reader
Unlike most CSx75 expanders, the CS1700 proximity reader determines its own address after installation is 
complete. It is the first step in programming the reader. To enroll a reader follow the steps below:

1. Wire the CS1700 proximity reader to the system.

2. Enter programming mode.

3. When you are in the installer menu, scan a card at the reader to initiate addressing mode. 

4. An address is assigned almost instantly and the reader beeps back its address as shown in Table 12-2: CS1700 
proximity reader addresses.

5. Select Installer Menu>Enrol Modules>Enrol to enrol the CS1700 proximity reader. The enrolling process 
takes about 12 seconds. User codes are not accepted during the enrolling process. 

Table 12-1: CS1700 proximity reader terminal connections

Wire Description

Green (data) Connect to the control panel DATA terminal. This wire is the data-signalling terminal to all 
the devices on the bus.

Black (com) Connect to the control panel COMMON terminal. This wire supplies the common side of 
the power to the CS1700 proximity reader.

Red (pos) Connect to the control panel AUX POWER + terminal. This wire supplies power to the 
CS1700 proximity reader.

White (egress) This is an optional EGRESS input. To use this feature, connect the normally open egress 
switch between this terminal and COM. If this feature is not used, there is no need to 
connect this wire.

Blue (output) This is an optional open-collector OUTPUT. To use this feature, connect the coil contacts 
of a relay between this terminal and AUX POWER +.

Table 12-2: CS1700 proximity reader addresses 

Beeps Address Beeps Address

1 113 9 121

2 114 10 122

3 115 11 123

4 116 12 124

5 117 13 125

6 118 14 126

7 119 15 127

8 120
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12.3 Programming the CS1700 proximity reader

You must enroll and default each CS1700 proximity reader before you begin to program the system. For more 
information on enrolling, see Enrolling the CS1700 proximity reader above. For more information on defaulting, 
see chapter 6. If the proximity reader is moved, the module number must be wiped and the reader learned in 
again on the control panel using the Reset Reader Address option. To program the CS1700, select Installer 
Menu>CS1700 Proximity Readers.

12.3.1 Programming badge functions
Each of the three badging actions can activate a particular function. The following example explains how to 
enable keyfob function 1 for the single badge action on proximity reader 113. To enable this function, you must 
also program the keyfob function in RF Receivers. For more information see chapter 9.

1. Navigate with the  keys to CS1700 Proximity Readers>Prox Reader 113 and press OK.

2. Scroll to Badge Functions>Single badge (1 beep)>Keyfob Funct 1>Yes and press OK. 

Badge FunctionsProx Reader 113 Single Badge (1 Beep)
Double Badge (2 Beeps)
Badge Hold (3 Beeps)

12.1 12.1.1 12.1.1.1

Prox Reader 114 - 127
Same as above

12.1.1.2
12.1.1.3

12.1.4 12.1.4.1
12.1.4.2

12.1.4.3

X-10 Functions

User Card Programming
Optical Tamper
Buzzer Follows Keypad
Ding Dong Chime
Log RTE (Card)
Log RTE (Zone)
Card Scan Mode

Module Number
House Code

Functions

Feature Select

12.1.2

12.1.3

12.1.2.1

12.1.2.2

12.1.2.3

12.1.3.1

12.1.3.2
12.1.3.3

12.1.3.4

12.1.3.5

Access Options Maglock or Drop Bolt Lock
Allow Access While Armed
Don’t Stay Unlocked While Open
Only if Open
Only if Closed
Access Without RTE
Log Forced Entry
Output Schedule Selection

Send Code Entry Function
Arm Away
Arm Stay
Disarm
Keyfob Funct 1
Keyfob Funct 2
Broadcast X10 Function
Activate Relay

12.1.1.1.1

12.1.1.1.2

12.1.1.1.3

12.1.1.1.4

12.1.1.1.5

12.1.1.1.6

12.1.1.1.7

12.1.1.1.8

Single Badge (1 Beep)
Double Badge (2 Beeps)
Badge Hold (3 Beeps)

12.1.2.3.1

12.1.2.3.3

12.1.2.3.2

12.1.3.6

12.1.3.7

12.1.4.4
12.1.4.5

12.1.4.6

LED 1 (Green) Ready State
Relay State
Inverted

Armed State
Relay State
Inverted

LED 2 (Red)

Miscellaneous Door Shunt Zone
Request to Exit Zone
Door Fault Warning Time
Door Fault Alarm Time 
Scan Time
Relay Active Time
Partitions
Logging Partition

12.1.5

12.1.6

12.1.5.1
12.1.5.2

12.1.5.3

12.1.6.1

12.1.6.2

12.1.6.3

12.1.7.2

Reset Reader Address
Model
Version
Default Settings

12.1.9

12.1.8 Schedules Schedule 1

Date of holidays

12.1.4.7

12.1.4.8

12.1.7 12.1.7.1

12.1.7.3

12.1.7.4

12.1.7.5

12.1.7.6
12.1.7.7

12.1.7.8

12.1.10
12.1.11

12.1.12

12.1.13

12.1.8.1

January
February
March
April
May
June
July
August
September
October
November
December

12.1.9.1
12.1.9.2

12.1.9.3

12.1.9.4
12.1.9.5
12.1.9.6

12.1.9.7

12.1.9.8

12.1.9.9

12.1.9.10
12.1.9.11
12.1.9.12

Opening
Closing

Hour
Minute

Active Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday
Disable on Holidays

12.1.8.1.1
12.1.8.1.2

12.1.8.1.3

12.1.8.1.1.1

12.1.8.1.1.2

12.1.8.1.3.1
12.1.8.1.3.2

12.1.8.1.3.3

12.1.8.1.3.4

12.1.8.1.3.5

12.1.8.1.3.6
12.1.8.1.3.7
12.1.8.1.3.8

Day 112.1.9.1.1
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3. The keypad beeps once to accept the change and returns to Keyfob Funct 1.

12.3.2 Configuring X-10 functions
You can program the X-10 function that is performed when a card is scanned. The following example enables X-
10 device 4 (module number 6, house code B) for the double badge action on proximity reader 113. To activate 
the double badge action, you must set the scan time. In this example, it is set to 1 second.

1. Navigate with the  keys to CS1700 Proximity Readers>Prox Reader 113 and press OK.

2. Scroll to Feature Select>Card Scan Mode>Single/Double/Hold and press OK.

3. The keypad beeps once to confirm the change and returns to Card Scan Mode.

4. Navigate with the  keys to Badge Functions>Double Badge (2 Beeps)>Broadcast X10 Function>Yes 
and press OK.

5. The keypad beeps once to confirm the change and returns to Broadcast X10 Function.

6. Navigate with the  keys to X-10 Functions>Module Number and press OK.

7. Select 6 and press OK.

8. The keypad beeps once to confirm the change and returns to Module Number.

9. Scroll to House Code and press OK.

10. Select B and press OK.

11. The keypad beeps once to confirm the change and returns to House Code.

12. Scroll to Functions>Double Badge (2 Beeps)>On and press OK. 

13. The keypad beeps once to accept the change and returns to Double Badge (2 Beeps).

14. Navigate with the  keys to Miscellaneous>Scan Time and press OK.

15. Select 100 x 10 ms and press OK. 

16. The keypad beeps once to accept the change and returns to Scan Time.

12.3.3 Adding and deleting cards
To add or delete cards, you must enter information at the keypad and then scan the cards. Before a card can be 
added, one CS1700 proximity reader on the system must be programmed to enable user card programming. It is 
recommended that only one reader on the system is enabled to do this and that this reader is located near a keypad. 
This CS1700 proximity reader transfers information to all other CS1700 proximity readers in the system once 
programming is finished. The following example enables user card programming on proximity reader 113. 

< The proximity reader recognizes pre-defined card serial numbers. It is not recommended to change these 
serial numbers. 

1. Navigate with the  keys to CS1700 Proximity Readers>Prox Reader 113 and press OK.

Table 12-3: CS1700 proximity reader X-10 functions

Function Description Function Description

0 All units off 4 Dim

1 All units on 5 Bright

2 On 6 All lights off

3 Off
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2. Scroll to Feature Select>User Card Programming>Enabled and press OK. 

3. The keypad beeps once to accept the change and returns to User Card Programming.

4. Enter a master user code to enter the user menu. Choose from one of the procedures outlined below.

Task Steps

Add one card 1. Select User Menu>CS1700 Proximity Readers>Add One Card.
2. Enter the user number to be assigned to the card and press OK.
3. LED1 on any enabled readers begins to flash. 
4. Scan the card designated for the entered user. If the user card is not already in the system, it is added and 

LED1 stops flashing. If the card is already in the system, the reader triple beeps and LED1 continues 
flashing. 

5. 40 seconds after you have finished scanning, all the readers in the system are updated with the new user 
card information.

Add multiple users 1. Select User Menu>CS1700 Proximity Readers>Add Multiple Cards.
2. Enter the user number to be assigned to the card and press OK.
3. LED1 on any enabled readers begins to flash. 
4. Scan the card designated for the entered user. If the user card is not already in the system, it is added and 

LED1 continues flashing indicating that the next user card can be scanned. If the card is already in the 
system, the reader triple beeps and LED1 continues flashing.

5. 40 seconds after you have finished scanning, all the readers in the system are updated with the new user 
card information.

Delete one user 1. Select User Menu>CS1700 Proximity Readers>Delete One Card.
2. Enter the user number assigned to the card and press OK.
3. The user card information for the entered user number will be cleared and LED1 stops flashing. After about 

40 seconds, all the readers in the system are updated with the new user card information.

Activate a card 1. Select User Menu>CS1700 Proximity Readers>Activate Card.
2. Enter the user number assigned to the card and press OK.
3. The user card information for the entered user number will be activated and LED1 stops flashing. After 

about 40 seconds, all the readers in the system are updated with the new user card information.

Deactivate a card 1. Select User Menu>CS1700 Proximity Readers>Dectivate Card.
2. Enter the user number assigned to the card and press OK.
3. The user card information for the entered user number will be deactivated and LED1 stops flashing. After 

about 40 seconds, all the readers in the system are updated with the new user card information.
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12.4 Glossary

Location Term Definition

12 CS1700 Proximity Readers A proximity card reader/door control module that can be programmed to 
control access in any or all areas.

12.1 Prox Reader 113 A menu entry that groups all options for the selected proximity reader. 

12.1.1 Badge Functions A menu entry that groups the functions activated by Single Badge, Double 
Badge and Badge Hold actions. 

12.1.1.1 Single Badge (1 Beep) A menu entry that groups the functions activated by holding a proximity card 
once against the proximity reader. 

12.1.1.2 Double Badge (2 Beeps) A menu entry that groups the functions activated by holding a proximity card 
against the proximity reader twice within the time set in Badge Hold. 

12.1.1.3 Badge Hold (3 Beeps) A menu entry that groups the functions activated by holding a proximity card 
near the proximity reader for longer than the time set in Badge Hold. 

12.1.1.1.1 Send Code Entry Function A menu option that enables the send code entry function for the selected 
proximity reader action. The actions are Single Badge, Double Badge and 
Badge Hold. This function sends the same command to the control panel, 
using the proximity card, as a keypad would send if a valid code were entered. 
For example, if the system is armed, the selected action disarms it.

12.1.1.1.2 Arm Away A menu option that enables the arm away function for the selected proximity 
reader action. The actions are Single Badge, Double Badge and Badge Hold.

12.1.1.1.3 Arm Stay A menu option that enables the arm stay function for the selected proximity 
reader action. The actions are Single Badge, Double Badge and Badge Hold.

12.1.1.1.4 Disarm A menu option that enables the disarm function for the selected proximity 
reader action. The actions are Single Badge, Double Badge and Badge Hold. 

12.1.1.1.5 Keyfob Funct 1 A menu option that sends a keyfob function 1 event for the selected proximity 
reader action. The actions are Single Badge, Double Badge and Badge Hold. 

12.1.1.1.6 Keyfob Funct 2 A menu option that sends a keyfob function 2 event for the selected proximity 
reader action. The actions are Single Badge, Double Badge and Badge Hold. 

12.1.1.1.7 Broadcast X10 Function A menu option that causes the proximity reader to transmit an X-10 function to 
the home automation system.

12.1.1.1.8 Activate Relay A menu option that activates the proximity reader’s built in relay driver instead 
of an external relay driver. 

12.1.2 X-10 Functions A menu entry that groups X-10 device information and the functions for the 
selected proximity reader. 
The X-10 functions are linked to the access reader. It is possible to control X-
10 devices using the badge on the card reader. It is also possible to configure 
the actions that are activated by each card action. 
0 All units off 
1 All lights on 
2 On
3 Off All others 
4 Dim
5 Bright
6 All lights off

12.1.2.1 Module Number A menu option that sets the X-10 module number used to identify a particular 
X-10 device on the selected module. 
A CSx75 bus module number is assigned to each system module. The system 
uses this number to identify the module. It is also used to report module 
problems (such as tampers and module supervision lost) to the central station.
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12.1.2.2 House Code A menu option that sets the code used to identify a particular premises. It is 
necessary in case any neighbouring premises also has an X-10 home 
automation system. 
More information on the X-10 home automation system can be found at 
www.x-10europe.com.

12.1.2.3 Functions A menu entry that groups the functions that can be linked between a CS1700 
proximity reader and X-10 functions. 

12.1.2.3.1 Single Badge (1 Beep) A menu option that sets the X-10 function sent when a proximity card is held 
against the proximity reader once. 

12.1.2.3.2 Double Badge (2 Beeps) A menu option that sets the X-10 function sent when a proximity card is held 
against the proximity reader twice within the time set in Badge Hold. 

12.1.2.3.3 Badge Hold (3 Beeps) A menu option that sets the X-10 function sent when a proximity card is held 
near the proximity reader for longer than the time set in Badge Hold.

12.1.3 Feature Select A menu entry that groups all optional features relating to the selected proximity 
reader. 

12.1.3.1 User Card Programming A menu option that enables user cards to be programmed.

12.1.3.2 Optical Tamper A menu option that sends a report to the central station when there is 
interference with the proximity reader. The optical tamper is built in as a pry-off 
protection.

12.1.3.3 Buzzer Follows Keypad A menu option that makes the reader buzzer settings the same as the keypad 
buzzer settings.

12.1.3.4 Ding Dong Chime A menu option that enables a ding dong chime. 

12.1.3.5 Log RTE (Card) A menu option that records an RTE (Card) event in the event log. An RTE 
(Card) event is a request to exit by scanning a card.

12.1.3.6 Log RTE (Zone) A menu option that records an RTE (Zone) event in the event log. An RTE 
(Zone) event is a request to exit by activating a zone.

12.1.3.7 Card Scan Mode A menu option that switches between the old and new scanning mode. The old 
mode is displayed as Single/Double/Hold and the new mode is displayed as 1/
2/3 Beeps.   

12.1.4 Access Options A menu entry that groups access options for the selected proximity reader.

12.1.4.1 Maglock or Drop Bolt Lock A menu option that controls a maglock or drop bolt lock. When a door zone is 
programmed and this option is enabled, the proximity reader monitors the door 
zone and waits for a couple of seconds after the door is closed before 
activating the lock. This is to prevent a door slamming shut due to a maglock or 
not getting shut at all due to the premature locking of a drop bolt.

12.1.4.2 Allow Access While Armed A menu option that enables a user to activate/deactivate the selected proximity 
reader while the system is armed.

12.1.4.3 Don’t Stay Unlocked While Open A menu option that prevents a door which has been opened during the open 
period from staying open.

12.1.4.4 Only if Open A menu option that activates the selected proximity reader between opening 
time and closing time. During these times, a card can be used to arm/disarm 
the system. A timer is used to set these times.

12.1.4.5 Only if Closed A menu option that activates the selected proximity reader after closing time 
and before opening time. During these times, a card can be used to arm/
disarm the system. A timer is used to set these times.

Location Term Definition
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12.1.4.6 Access Without RTE A menu entry that enables a user to open the door without a Request To Exit 
(RTE). 

12.1.4.7 Log Forced Entry A menu option that records a force entry event in the event log.

12.1.4.8 Output Schedule Selection A menu option that selects the schedule that is used by the selected proximity 
reader. Up to eight schedules can run at the same time in a complementary 
manner.

12.1.5 LED 1 (Green) A menu entry that groups options that cause LED 1 to display a green light. 
The proximity reader has a built-in LED (at the top of the reader) which can 
display a green light or be turned off. 
The LED follows the ready state or the state of the built-in relay in the proximity 
reader. It is possible to invert the action that activates the LED. 

12.1.5.1 Ready State A menu option that lights LED 1 (Green) when the system is ready to be 
armed. 

12.1.5.2 Relay State A menu option that lights the selected LED when the device’s relay is 
activated.

12.1.5.3 Inverted A menu option that lights the selected LED (Green/Red) when the device is in 
inverted mode. 

12.1.6 LED 2 (Red) A menu entry that groups options that cause LED 2 to display a red light. The 
proximity reader has a built-in LED (at the bottom of the reader) which can 
display a red light or be turned off. 
The LED follows the armed state or the state of the built-in relay in the 
proximity reader. It is possible to invert the action that activates the LED.

12.1.6.1 Armed State A menu option that lights LED 2 (Red) when the system is armed. 

12.1.6.2 Relay State A menu option that lights the selected LED when the device’s relay is 
activated.

12.1.6.3 Inverted A menu option that lights the selected LED (Green/Red) when the device is in 
inverted mode. 

12.1.7.1 Door Shunt Zone A menu option that sets which zone senses that the door is open for door fault 
alarms and warnings. 

12.1.7.2 Request to Exit Zone A menu option that selects the zone that is monitored to signal a Request to 
Exit (RTE). You must enable the RTE zone type option for the selected zone.

12.1.7.3 Door Fault Warning Time A menu option that sets the time after which a warning sound is made before a 
door fault alarm occurs. 

12.1.7.4 Door Fault Alarm Time A menu option that sets the time within which the door must be closed before a 
door fault alarm occurs. 

12.1.7.5 Scan Time A menu option that specifies the length of time during which the proximity card 
must be held near the proximity reader to activate its functions. A proximity 
reader can be programmed to activate different functions depending on 
whether the card is held near it once, twice within this time or continuously for 
this time. 

12.1.7.6 Relay Active Time A menu option that sets the length of time the relay is activated when a 
proximity card is held against the proximity reader. 

12.1.7.7 Partitions A menu entry that lists the partitions assigned to the selected proximity reader. 
The selected proximity reader can trigger an event on these partitions. 

12.1.7.8 Logging Partition A menu option that specifies the partition number that the proximity reader 
adds to any event that it records in the event log.

12.1.8 Schedules A menu option that, combined with Output Schedule Selection selects the 
schedules that affect the proximity reader.

Location Term Definition
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12.5 Technical specifications

12.1.8.1.1 Opening A menu option that sets the time at which the selected schedule enters the 
open state. 

12.1.8.1.2 Closing A menu option that sets the time at which the selected schedule enters the 
closed state. 

12.1.8.1.3 Active A menu option that specifies the days of the week that the selected schedule is 
active. 

12.1.8.1.3.1 Disable on Holidays A menu option that activates the holidays feature. The selected schedule is not 
active on the dates specified in Date of holidays.

12.1.9 Date of holidays A menu option that sets the dates of holidays. If the holidays feature 
(12.1.8.1.3.1) has been enabled, no schedules are active on these dates. Up to 
eight holidays per month can be specified. 

12.1.10 Reset Reader Address A menu option that wipes the proximity reader’s module number so that the 
reader can be learned in again on the control panel.

12.1.11 Model A menu option that displays the current model of the proximity reader.

12.1.12 Version A menu option that displays the current software version of the proximity 
reader. 

12.1.13 Default Settings A menu option that defaults the selected proximity reader to factory defaults.

Power supply specifications

Power supply voltage 13.8V  ± 2%  

Consumption - Standby 40 mA at 13.8V  ± 2% 

Consumption – Maximum 110 mA at 13.8V  ± 2% 

General feature specifications

Reader Size Dimensions (width x height x depth) 35x118x15 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% non condensing

Shipping Weight 115 g

Location Term Definition
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Chapter 13: Setting up the CS7002

13.1 Overview
The CS7002 is the GPRS module that can be added to a CSX75 range of panel. The CS7002 GPRS module 
features include 

• Wireless event reporting

• Four programmable report destinations 

• Selectable reportable events from eight partitions

• Provides backup for the panel and external diallers.

• PSTN/ISDN can be used as backup

• SIA reporting using TCP/IP over GPRS

• Contact ID reporting using TCP/IP over GPRS

• SIA reporting with optional area modifiers using SMS messages

• Control panel can use GSM in addition to PSTN (reporting all panel protocols using GSM)

• Wireless upload/download using a GSM CSD connection

• Wireless upload/download using a GPRS CSD connection

• Upload/download may be initiated remotely or locally

• Optional automatic download sessions. These normally follow test calls. Test call reporting can be switched 
off so that there is automatic download calls without test report calls.

• Contact ID or SIA reporting formats over SMS.
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13.2  Installing the CS7002 GPRS module

The CS7002 GPRS module can be connected directly to the board. If a CS534 listen-in module and/or a CS535 
voice module are used, the CS7002 GPRS module is connected to the board and the CS534 listen-in module and 
CS535 listen-in module are attached to it via a ribbon cable. 

For more details on how to install the CS7002 GPRS module in the various housings, see chapter A-4 Installing 
a basic system.

13.2.1 Enrol the SIM card on the GSM network
You must enrol the SIM card on the GSM network before you install it in the CS7002 GPRS module. 

1. Select CS7002 GPRS module>Options>GPRS>SIM PIN Code and press OK.

2. Enter the SIM PIN and press OK.

3. Exit programming mode. The SIM PIN is automatically enrolled on the GSM network.

1 VVMiQ connector 7 Battery connectors for main panel battery leads

2 SIM card holder 8 Remote header connector for CS534/535

3 GPRS modem 9 Header connector for main panel

4 Antenna Connector A LEDs

5 Flash upgrade header B TCP socket open LED

6 Flying leads connect to battery terminals C Network OK LED. The CS7002 is logged on to GSM network LED

BUS COM

BUS COM

SIM ERR

GPRS ACTIVE

REPORTING

PSU ERR

GSM IN USE

NE
TW
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K 
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13.2.2 Inserting the SIM card

1. Power down the system.

2. Open the SIM card holder by sliding back the metal clip and lifting the holder.

3. Slide the SIM card into the holder with the contacts (gold pads) facing the circuit board and the angled corner 
facing out.

4. Close the holder and slide the metal clip back to the original position.

5. Power up the system.

6. The SIM card automatically selects a network operator when enrolled on the network. For details on 
manually selecting an operator, see the CS7002 GPRS Module Installation Manual. 

7. Most SIM cards contain a preprogrammed SMS service centre address and under normal circumstances, this 
should not be changed. If you do need to change it, include the international country prefix using a ‘+’ instead 
of leading zeros.

13.2.3 Wiring the CS7002 GPRS module

When wiring the CS7002 do the following:

1. Attach the CS7002 to the CSx75 board.

2. Connect the control panel battery leads to the CS7002 board.

3. Connect the CS7002 battery leads to the battery and power up the panel.

More details can be found in the CS7002 GPRS Module Installation Manual.

13.2.4 Reporting LEDs 
The module LEDs indicate the current status of the CS7002.

• The Bus communications LED indicates that the module is receiving messages over the Bus rather than from 
the GSM/GPRS network.

• The SIM error LED indicates that the SIM card is blocked and a PUK code is required to unblock it. 

• The GPRS active LED indicates that the module is connected to the GPRS network. This LED turns off when 
the module is no longer connected to the GPRS network, for example, when it uses the voice channel or CSD.

• The Reporting LED indicates that TCP/SMS reporting is taking place.

• The PSU error LED indicates that there is a problem with the 3.8 V Switched Mode Power Supply Unit. 

• The Network OK LED indicates that the CS7002 is currently using the GSM network (voice channel or 
CSD). 

• The TCP socket open LED indicates that a TCP connection to a server has been established.

• The Logged on to GSM network LED indicates that the module is connected to the GSM network.

Table 13-1: CS7002 GPRS module terminal connections

Terminal Description

+ Connect to the + panel battery lead 

- Connect to the – panel battery lead 
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13.3 Programming the CS7002 GPRS module

You must enroll and default the CS7002 GPRS module before you begin to program the system. For more 
information on enrolling and defaulting, see chapter B-1 Enrolling modules. To program the CS7002 GPRS 
module, select Installer Menu>CS7002 GPRS Module. 

13.3.1 Testing the RSSI value
During the enrolling procedure, it is mandatory to check the RSSI value (signal strength) of the CS7002 and 
record it in the system documentation. The RSSI value is linked to the signal level of the GSM network and 

Report ControlReporting (1) Report 113.1 13.1.1 13.1.1.1 Destination
Backup Destination

Events Alarms
Alarm Restores
Opening/Closings
Zone Bypass and Restores

Tamper/Trouble Tampers and Restores
Zone Trouble and Restores
Expander Trouble and Restores
Siren/Phone Faults and Restores
RF Sensor Lost and Restores
RF Low Battery and Restores

Power Power Trouble and Restores
Aux Overcurrent and Restores
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Test Reports

Miscellaneous Program/Download
Zone Inactivity Monitor

13.1.1.1.3.3.1
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13.2.1 Connection Type
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ranges from 0-31, with 99 as unknown. If an RSSI reading is not satisfactory, move the antenna to get a better 
reception. The following steps explain how to read the RSSI value. 

1. Navigate with the  keys to CS7002 GPRS module>Options>GSM>RSSI Value and press OK.

2. Note the RSSI reading.

3. Navigate with the  keys to Status Check and press OK.

4. Scroll through the status messages to ensure the SIM card is logged onto the GSM network and the SIM card 
PIN is not blocked.

13.3.2 Reporting
The CS7002 contains six report controls which can use four report destinations. You can configure the events to 
be reported and specify two reporting destinations for each report control. Two of these can be SMS, two can be 
TCP/IP. The backup destination, which is used if there is a dialler problem, should be another dialler, for example 
PSTN.

< All events in Report Control 1 are enabled by default.

The module can send primary, secondary and backup reports.

13.3.2.1 Primary reports
Primary reports are the main means of reporting the selected events.

• Set a report control to Report When>Report Always.

• Select the event group for each partition.

• Select the report destination and report format.

13.3.2.2 CS7002 as backup for another dialler
The CS7002 reports the event when the control panel or other dialler fails to report.

13.3.2.3 CS7002 backup format (SMS / GPRS)
Control panel

The report control monitors the control panel and reports the selected events if the control panel fails to report 
them.

• Set a report control to Report When>Control Dialler Problem.

• Program the first report destination and report format.

CS7050/CS7501

The CS7050 is a TCP/IP auxiliary dialler. The CS7501 is an ISDN dialler. When either fails to report, it sends an 
expansion event which the CS7002 reports.

• Set a report control to Report When>Report Always.

• Enable Test Report events only.

• Program the first report destination and ensure the CS7002 report format is the same as that used by the 
CS7050.

13.3.2.4 CS7002 backup format (audio reporting)
Control panel

The control panel can send reports using GSM audio instead of PSTN. Alternatively, it can be configured to use 
both GSM audio and PSTN.

• Configure reporting on the control panel.

• Enter 'G' at the start of the phone number to use the GSM instead of the PSTN to dial the phone number.

< Press #0 to enter 'G' on a CS5500 keypad or press 10 on a CS-LCD or CS-LED keypad.
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13.3.2.5 Control panel/CS7002 as backup for CS7002
Backup reports are sent when the CS7002 fails to send primary reports. Backup reports can be sent by another 
report control on the module or by another device on the system.

13.3.2.6 CS7002 as backup
• Set a report control to Report When>Report Always.

• Program the first and backup report destinations to one of the TCP/IP or SMS destinations or set another 
report control as Report control>Backup.

13.3.2.7 Control panel as backup
When the CS7002 fails to report, it sends an expansion event which the control panel or auxiliary dialler reports.

• Set a report control to Report When>Report Always.

• Set the backup destination to Other Dialler.

• Enable the autotest report on the panel phone events and panel system events.

• Ensure the reporting format on the dialler is the same as that set in CS7002 
GPRS>Module>Reporting>Backup Format.

13.3.3 Using upload/download

13.3.3.1 GSM CSD connection.
The upload/download access code is set on the control panel in Communications>Up/Download>Access Code. 
For more information, see chapter B-2 Programming the control panel. The following example configures the 
CS7002 GPRS module to answers calls from phone number 5666666 only. The PC initiates the upload/
download session. 

1. Navigate with the  keys to CS7002 GPRS Module>Up/Download and press OK.

2. Scroll to Remote Initiated>Enabled and press OK.

3. The keypad beeps once to accept the change and returns to Remote Initiated.

4. Scroll to Phone Number and press OK.

5. Press #  to clear the current value. 

6. Enter 5666666 and press OK.

7. The keypad beeps once to accept the change and returns to Phone Number.

8. You must configure the CS7002 data phone number on the upload/download PC. Ask your network provider 
for this number. 

9. You must also configure the GSM modem on the upload/download PC. Select Program>Setup>GSM 
Modem setup. Enter S7=60S10=255X0T+MS=9,1,9600,9600 in the Initialization string 2 field.

13.3.3.2 GPRS CSD connection.
The connection is made via a TCP/IP network. Instead of a phone number, an IP address is set. The Call Back 
Req’d and Allow Calls From options are disabled.
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13.4 Glossary

Location Term Definition

13 CS7002 GPRS Module A module that operates as a GPRS and GSM communications module for 
reporting and upload/download. 

13.1 Reporting A menu entry that groups reporting options.

13.1.1 Report Control A block of reporting data that contains configurations to format selected events 
into one or more messages according to pre-configured settings and send 
them to specified destinations.
A menu entry that groups report control options.

13.1.1.1.1 Destination A menu option that configures the report destination for the selected report 
control. 

13.1.1.1.2 Backup Destination A menu option that configures the backup destination for the selected report 
control. If using another device as the backup destination, set the reporting 
format in Reporting>Backup Format and enable test report events in the 
backup device. 

13.1.1.1.3 Events A menu entry that contains all configurable events for each report control. All 
events for report control 1 are enabled by default. Events for all other report 
controls are disabled by default. Enabled events are formatted into one or 
more messages according to pre-configured settings and sent to the selected 
report destination. You must enable only Test Reports if using the CS7002 as 
backup to another auxiliary dialler.

13.1.1.1.3.1 Arm/Disarm/Alarm A menu entry that groups the events that are reported to the selected report 
control. 

13.1.1.1.3.1.1 Alarms A menu option that sends a report to the selected report control when an alarm 
occurs. 

13.1.1.1.3.1.2 Alarm Restores A menu option that sends a report to the selected report control when the 
alarm has been restored after an alarm. 

13.1.1.1.3.1.3 Opening/Closings A menu option that sends a report to the selected report control stating when 
the system is opened (disarmed) and closed (armed).  

13.1.1.1.3.1.4 Zone Bypass and Restores A menu option that sends a report to the selected report control when a zone is 
bypassed. A report is also sent when the zone is restored (un-bypassed). 

13.1.1.1.3.2 Tamper/Trouble A menu entry that groups together the tamper and trouble events that are 
reported to the selected report control.

13.1.1.1.3.2.1 Tampers and Restores A menu option that sends a report to the selected report control when a tamper 
occurs. A report is also sent when the tamper is no longer active. 

13.1.1.1.3.2.2 Zone Trouble and Restores A menu option that sends a report to the selected report control when a zone 
trouble condition occurs. A report is also sent when the trouble condition is no 
longer active. 

13.1.1.1.3.2.3 Expander Trouble and Restores A menu option that sends an expander trouble and restore report to the 
selected report control.

13.1.1.1.3.2.4 Siren/Phone Faults and Restores A menu option that sends a report to the selected report control when a siren 
or phone fault occurs. A restore report is sent when the fault is fixed. 

13.1.1.1.3.2.5 RF Sensor Lost and Restores A menu option that sends a report to the selected report control when an RF 
sensor is missing. A restore report is sent to the central station when the 
receiver receives a valid signal from the lost transmitter. 

13.1.1.1.3.2.6 RF Low Battery and Restores A menu option that sends a report to the selected report control when a low 
battery condition occurs in an RF sensor. A restore report is also sent when the 
low battery condition is no longer active.
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13.1.1.1.3.3 Power A menu entry that groups the power events that are reported to the selected 
report control.

13.1.1.1.3.3.1 Power Trouble and Restores A menu option that reports mains failure, mains restore, low battery and low 
battery restore events to the selected phone number, report control, receiver or 
email account. 

13.1.1.1.3.3.2 Aux Overcurrent and Restores A menu option that sends a report to the selected report control when too 
much current is detected. A restore report is also sent when the overcurrent 
condition is fixed. 

13.1.1.1.3.4 Communications A menu entry that groups together the communication events that are reported 
to the selected report control.

13.1.1.1.3.4.1 Fail to Communicate A menu option that reports a fail to communicate event to the selected report 
control.

13.1.1.1.3.4.2 Test Reports A menu option that sends a test report to the selected report control at pre-
programmed intervals. The units can be set in days or hours. 

13.1.1.1.3.5.1 Program/Download A menu option that reports programming and up/download events to the 
selected report control.

13.1.1.1.3.5.2 Zone Inactivity Monitor A menu option that sends a report to the selected report control when a zone 
inactivity event occurs.

13.1.1.1.4 Report Delay A menu option that configures the delay in seconds before the CS7002 module 
reports. If any other events occur during this delay, they are sent with the first 
event in one message. This can be from 0 to 255 seconds. This setting is 
useful only if using SMS reporting.

13.1.1.1.5 Report When A menu option that enables primary reporting (Report Always) or secondary 
reporting (Control Dialler Problem) for the selected report control. 

13.1.2 TCP/IP Reporting A menu entry that groups TCP/IP reporting options. 

13.1.2.1 Receivers A menu entry that groups TCP/IP receiver options.

13.1.2.1.1.1 IP Address A menu option that configures the address of the selected TCP/IP receiver.

13.1.2.1.1.2 Account Code A menu option that specifies the unique code sent from the modem in the 
control panel or dialler to the selected report control or phone number. This 
code is used to identify and charge the user. Separate account codes can be 
set up for each phone number and each partition. This is also known as the 
account number. The letters A, B, C, D, E and F can be included in CS7002 
GPRS module account codes.

13.1.2.1.1.3 Receiver Number A menu option that configures the phone line receiver number associated with 
the receiver account. 

13.1.2.1.1.4 Line Number A menu option that configures the line number associated with the receiver 
account. 

13.1.2.2 Report Format A menu option that configures the communicator format used to report to TCP/
IP receivers. Consult the instructions for your central station receiver to 
determine which format is compatible.

13.1.2.3 Receiver Polling A menu option that configures the module to send polling messages to the 
report receivers.

13.1.2.4 Polling Time A menu option that configures the TCP/IP polling time. This value must match 
the TCP/IP polling time set on a TCP/IP receiver. The value chosen is 
determined by the level of security required and the cost of data transmission. 
This can be from 1 to 255 minutes. If set to 0, the option is disabled. 

Location Term Definition
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13.1.3 SMS Reporting A menu entry that groups SMS reporting options.

13.1.3.1.1 Phone Number A menu option that sets the phone number to which SMS reports are sent.

13.1.3.1.2 Account Code A menu option that specifies the unique code sent from the modem in the 
control panel or dialler to the selected report control. This code is used to 
identify and charge the user. Separate account codes can be set up for each 
phone number and each partition. This is also known as the account number. 
The letters B, C, D, E and F can be included in control panel account codes. 
The letters A, B, C, D, E and F can be included in CS7002 GPRS module 
account codes.

13.1.3.1.3 Protocol A menu option that configures the communicator format used to report to the 
selected SMS receiver. 

13.1.3.1.3.1 SIA Single Evts A menu entry that sets SMS reporting options so that events are are grouped 
and sent as separate messages to separate account codes. 

13.1.3.1.3.2 SIA Comb'd Evts A menu entry that sets SMS reporting options so that events for separate 
account codes can be sent in the same message.

13.1.3.1.3.3 SIA area mods A menu entry that allows area modifiers to identify partitions.

13.1.3.1.3.4 Contact ID A menu entry that selects the Contact ID protocol

13.1.4 Partition Account Codes A menu option that lists the account codes for each partition. The account 
code is sent when the relevant partition is reported. 
There are two sets of account codes. The first set assigns an account code to 
each report destination. The second set assigns an account code to each 
partition. If you attempt to use both sets, the partition account code takes 
precedence

13.1.5 Report Attempts A menu entry that groups report options. 

13.1.5.1 Max Report Attempts A menu option that configures the number of attempts the CS7002 makes to 
send a report. This can be from 0 to 15.

13.1.5.2 FTC Report Attempts A menu option that configures the number of attempts that can be made to a 
specific report destination before the Fail to Communicate condition is set. This 
can be from 1 to 15.

13.1.5.3 Max Reports in 24h A menu option that configures the maximum number of reports that can be 
sent by the CS7002 in 24 hours. The CS7002 stops reporting when the 
number of messages in a 24 hours exceeds this number. This can be from 1 to 
255. If set to 0, there is no limitation. This applies to SMS and TCP/IP.

13.1.5.4 Report Timeout A menu option that configures the maximum length of time for each attempt by 
the CS7002 to report to each receiver. If the report is not successful during this 
time, the attempt is abandoned. This can be from 0 to 255 seconds.

13.1.5.5 Control Panel Timeout A menu option that configures the maximum time during which the control 
panel must report an event. If the CS7002 report control is configured for 
secondary reporting and the control panel does not report the event during this 
time, the report control reports the event. This can be from 1 to 255 seconds. If 
set to 0, the option is disabled.

13.1.6 Backup Format A menu option that configures the reporting format when using another device 
as backup. You must set the same reporting format on the backup device. 

13.2 Up/Download A menu entry that groups options used to control download sessions between 
the up/download software and the control panel. 

13.2.1 Connection Type A menu entry that selects a CSD or GPRS connection.

13.2.1.1 CSD Circuit Switched Data. This communication is used to upload/download data. It 
is similar to a modem but it is wireless and built in to the CS7002.

Location Term Definition
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13.2.1.2 GPRS General Packet Radio Service. A global standard for wireless 
communications. It supports a range of bandwidths and can transmit and 
receive both small bursts and large amounts of data.

13.2.2 Phone Number A menu option that sets the phone number of the PC running the upload/
download software.

13.2.3 IP Address A menu option that configures the address of the selected TCP/IP receiver.

13.2.4 Site Initiated A menu option that allows an upload/download session between the module 
and the PC to be initiated from a keypad.

13.2.5 Remote Initiated A menu option that allows an upload/download session between the module 
and the PC to be initiated by the PC. The PC dials into the module. You must 
dial the data phone number to dial into the GSM for upload/download.
This option is dependent on other options (Allow Calls From, Auto-answer and 
Call Back Req’d).

13.2.6 Allow Calls From A menu option that answers calls from a known phone number only. To enable 
this option, you must enable Remote Initiated and program the phone number 
of the PC in Up/Download>Phone Number.

13.2.7 Auto-answer A menu option that configures the CS7002 to automatically answer any 
incoming calls. To enable this option, you must enable Remote Initiated. 

13.2.8 Call Back Req’d A menu option that configures the CS7002 to call back the PC in order to 
initiate an upload/download session. To enable this option, you must enable 
Remote Initiated.

13.2.9 Auto U/D at Test Time A menu option that configures the module to automatically dial the PC to 
initiate an upload/download session after an autotest. You must program the 
autotest on the control panel. 

13.3.1 GSM Global System for Mobile Communications. A global standard for wireless 
communications. It supports narrowband Time Division Multiple Access 
(TDMA). 
A menu entry that groups GSM connection options.

13.3.1.1 SIM PIN Code A menu option that configures the code used to enroll the SIM card on the 
GSM network.

13.3.1.2 GSM Operator A menu entry that groups information on the current GSM operator and allows 
a specific GSM operator to be manually selected.

13.3.1.2.1 Operator Selection A menu option that configures the GSM network operator used by the module. 
Set this to 00000 to allow the SIM card automatically select a network operator. 
Alternatively, enter an operator ID code to manually select a network operator.

13.3.1.2.2 Current Operator A menu option that displays the name of the automatically or manually 
selected GSM network operator. This option is valid only when the module is 
logged into the GSM network. 

13.3.1.3 SMS Service Centre Address A menu option that configures the SMS service centre phone number. Usually, 
this number should be left blank as it is dialled automatically by the SIM card. It 
should include the country code.

13.3.1.4 RSSI Value Remote Signal Strength Indication Value. This is a measure of the RF 
reception and is similar to the indication on a mobile phone.
A menu entry that displays the current RSSI value. The RSSI value is 
periodically updated when logged into the network. RSSI values range from 0 
to 31 with 99 as unknown.

Location Term Definition
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13.3.1.5 Bit Error Rate A menu option that displays the current Bit Error Rate (BER). The BER value is 
periodically updated when the module is logged into the network. This 
information is used for verification purposes only. BER values range from 0% 
to 7%, with 99 as unknown. It is applicable to GPRS only.

13.3.1.6 Connection Fault A menu entry that groups connection fault options. A connection fault occurs 
when the module cannot log into the GSM network.

13.3.1.6.1 Line Fault RF Level A menu option that configures the acceptable level of the RSSI signal. If the 
signal falls below this level for the amount of time set in Line Fault Delay, a line 
fault is generated. This can be from 1 to 31. If set to 0, the setting is disabled. 

13.3.1.6.2 Line Fault Delay A menu option that configures the length of time the RSSI signal must be 
below the Line Fault RF Level before a line fault is generated. This can be from 
0 to 255 seconds.

13.3.1.7 GSM Engine Info A menu entry that groups information returned from the on-board GSM module 
on the GSM module.

13.3.1.7.1 Manufacturer A menu option that contains the GSM Engine Manufacturer Identification. 

13.3.1.7.2 Type A menu option that displays the type of GSM modem used by the module.

13.3.1.7.3 Software Revision A menu option that displays the current software version of the selected 
module.

13.3.1.7.4 Serial Number A menu entry displays the serial number of the GSM modem used by the 
module. It is used for diagnostics only.

13.3.2 CSD Circuit Switched Data. This communication is used to upload/download data. It 
is similar to a modem but it is wireless and built in to the CS7002.

13.3.2.1 Speed A menu option that configures the baud rate for CSD/ GSM download. This 
setting must match the baud rate set on the PC modem.

13.3.2.2 Use V1.110 A menu option that enables V1.110 for site-initiated CSD GSM calls. Enable 
this option if the PC is on an ISDN line and is using an ISDN modem.

13.3.2.3 Mode A menu option that configures the mode used for site initiated CSD GSM calls. 
If you are experiencing problems with upload/download, change this setting 
from transparent mode to non-transparent mode or vice versa. 

13.3.3 Network A menu entry that groups network options.

13.3.3.1 DHCP Assigned IP Address A menu option that displays the IP address that is assigned to the CS7002 
when it logs into the GPRS network.

13.3.3.2 PPP User ID A menu option that configures the user ID for a PAP login. Contact the network 
provider to confirm if a PAP login is required and to obtain the user ID and 
password.

13.3.3.3 PPP Password A menu option that configures the password for a PAP login. Contact the 
network provider to confirm if a PAP login is required and to obtain the user ID 
and password.

13.3.3.4 GPRS APN A menu option that configures the GPRS access point name. Contact the 
network provider to obtain this name. This is a mandatory setting if using TCP/
IP reporting.

13.3.3.5 GPRS APN 2 A CS7002 GPRS Module menu option that configures a second GPRS access 
point name. Contact the network provider to obtain this name. This is used if 
the connection cannot be made via GPRS APN.

13.3.3.6 Port Numbers A menu entry that groups TCP/IP port options.

Location Term Definition
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13.3.3.6.1 TCP/IP Alarm Port A menu option that configures the number of the TCP/IP port to which polling 
and alarms are reported. The default is 9999 and under normal circumstances 
should not be changed.

13.3.3.6.2 U/D Port A  menu option that configures the number of the port used for upload/
download. 

13.3.4 Status Check A menu entry that groups status messages for GSM events.

13.3.4.1 GSM Connection A menu entry that groups GSM connection settings. 

13.3.4.1.1 GSM Engine Comms A menu option that indicates that communication with the GSM module is 
established. 

13.3.4.1.2 SIM PIN Accepted A menu option that indicates that the PIN number for the SIM card has been 
entered correctly.

13.3.4.1.3 Logged into GSM Network A menu option that indicates that the GSM module is logged into the GSM 
network. 

13.3.4.1.4 SIM PUK Required A menu option that indicates that the SIM card has been blocked and a PUK 
code must be entered to unblock it. Put the card into a mobile phone and enter 
the PUK code. When the card has been unblocked put it back into the GPRS 
module.

13.3.4.1.5 Sending SMS A menu option that indicates that the module is sending an SMS message over 
the GSM network.

13.3.4.1.6 Using GSM Audio A menu option that indicates that the module is using GSM audio. The GSM 
audio channel is used when the panel reports through the voice channel of the 
GSM network.

13.3.4.1.7 Using GSM CSD A menu option that indicates that the module is using GSM CSD. 

13.3.4.1.8 GPRS Connected A menu option that indicates that the module is logged into the GPRS network.

13.3.4.1.9 Good RSSI A menu option that indicates that the current RSSI level is equal to or greater 
than the minimum signal quality level configured in Line Fault RF Level. If the 
RSSI level drops below this value a GSM line fault is indicated. 

13.3.4.2 Power A menu entry that groups power related status messages. 

13.3.4.2.1 Battery Trouble A menu option that indicates that there is a problem with the battery.

13.3.4.2.2 SM PSU Trouble A menu option that indicates that there is a problem with its 3.8 V Switched 
Mode Power Supply Unit. 

13.3.4.2.3 Bus Power Trouble A menu option that indicates that there is a problem with power to the Bus.

13.3.4.3 Application A menu entry that groups application related status messages.

13.3.4.3.1 Downloading A menu option that indicates that downloading is taking place. 

13.3.4.3.2 Download Starting A menu option that indicates that downloading is about to start.

13.3.4.3.3 Reporting A menu option that displays a status message when reporting is taking place.

13.3.4.3.4 Hit 24H Report Limit A menu option that indicates that the maximum number of reports allowed in 
24 hours has been reached. This applies to SMS and GPRS reports.

13.4 Model A menu option that displays the current model of the selected module. 

13.5 Version A menu option that displays the current software version of the selected 
module.

13.6 Default Settings A menu option that defaults the selected module to factory defaults. 

Location Term Definition
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13.5 Technical specifications

Power supply specifications

Power supply voltage 12V  ± 2% 

Consumption - Standby 30 mA at 12V  ± 2% 

Consumption – Maximum via battery leads 2A at 12V  ± 2% 

General feature specifications

PCB Size Dimensions (width x height x depth) 97x102x24 mm

Environmental Operating temperature +0° C to + 49 °C

Humidity Max 93% 

Shipping Weight 115 g
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Chapter 14: Reserved
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Chapter 15: Setting up the CS7050

15.1 Overview
The CS7050 TCP/IP module is a dual microprocessor-controlled Internet/Intranet interface used to connect the 
CSx75 control panel to the OH Network Receiver. This interface allows any or all events from the CSx75 to be 
reported over the network. The CS7050 TCP/IP module features include:

• Four programmable report destinations (two TCP/IP receivers, two email addresses).

• Event reporting from eight partitions.

• Selectable reportable events for each partition.

• Control panel as backup.

• SIA reporting using TCP/IP.

• Contact ID reporting using TCP/IP.

• Email reporting in English and on POP server only.

• DHCP or fixed IP address.

• Upload/download may be initiated remotely or locally.

• Optional automatic download sessions. These normally follow test calls. Test call reporting can be switched 
off so that there is automatic download calls without test report calls.

15.2 Installing the CS7050 TCP/IP module

For information on installing the CS7050 TCP/IP module in the various housings, see chapter A-4 Installing a 
basic system.

1 SIM pin 1 5 RS232

2 Modem pin 2 6 Connect to CSx75 panel

3 Processor to RS232 setting: position 9 &10 7 10BT ethernet

4 Processor to RS232 setting: position 3 & 4 8  Audio tap

1 2 3 4

567
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15.2.1 Wiring the CS7050 TCP/IP module

15.2.2 LED indicators

Table 15-1: CS7050 TCP/IP module terminal connections

Terminal Description

+ Connect to the panel bus Aux+.

COM Connect to the panel bus COM terminal.

DATA Connect to the panel bus DATA terminal.

J16 Connect the Ethernet Jack J16 (10BT) to a 10BT Ethernet capable hub, router or gateway. Do not 
use a CASCADE or X port in crossover mode.

Table 15-2: CS7050 TCP/IP module LED indicators

LED Description

DS1 Flashes each time the CS7050 has an opportunity to access the Aritech CSx75 bus. It should flash 
about twice a second.

DS3 Flashes when it is waiting for a communication from the Ethernet module.

DS4 On when waiting for a reply from a Aritech CSx75 bus device.

DS5 Flashes when the CS7050 gets a packet from the Ethernet module.

DS6 On when the bus has a message to send to the network. 

" DS3 - DS6 are off if the system is initialized, normal and waiting for a new event to report.

L1 (on SIM module) Flashes ON Ethernet Activity.

L2 (on SIM module) Steady ON when Ethernet Link is established with the 10BT cable.

DS2 The sixth LED is located toward the back of the board. It is used for hardware, and only glows dimly 
when connected to the CSx75 control panel.
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15.3 Programming the CS7050 TCP/IP module

You must enroll and default the module before you begin to program the system. For more information on 
enrolling and defaulting, see chapter B-1 Enrolling modules. You can program the CS7050 TCP/IP module using 
a keypad or UDx75 software. To program the CS7050 using a keypad, select Installer Menu>CS7050 TCP/IP 
Module.

1 Receiver (1)TCP/IP Reporting IP Address15.1 15.1.1 15.1.1.1

Events Alarms
Alarm Restores
Opening/Closings
Zone Bypass and Restores

Tamper/Trouble Tampers and Restores
Zone Trouble and Restores
Expander Trouble and Restores
Siren/Phone Faults and Restores
RF Sensor Lost and Restores
RF Low Battery and Restores

Power Power Trouble and Restores
Aux Overcurrent and Restores

Communications Fail to Communicate
Test Reports

Miscellaneous Program/Download
Zone Inactivity Monitor

14.1.1.2.3.1
14.1.1.2.3.2

15.1.1.2.4.1

15.1.1.2.4.2

15.1.1.2.5.1

15.1.1.2.5.2

Arm/Disarm/Alarm15.1.1.2.1 15.1.1.2.1.115.1.1.2

15.1.1.2.2

15.1.1.2.3

15.1.1.2.4

15.1.1.2.5

15.1.1.2.1.2

15.1.1.2.1.3

15.1.1.2.1.4

15.1.1.2.2.1

15.1.1.2.2.2

15.1.1.2.2.5

15.1.1.2.2.4

15.1.1.2.2.3

15.1.1.2.2.6

E-mail Reporting Our E-mail Address

1 E-mail (1)

15.3

15.2.1

E-mail Address

E-mail Server

System Account Codes

Domain Name
IP Address

Account Codes

1 Partition (1)

15.2.3

15.3.1

15.2.2.1

15.2.3.1

15.3.2.1

15.2.2.1.1E-mail Accounts

Program/Download
Zone Inactivity Monitor

15.2.2.1.2.2

15.2.2.1.2.1 Alarms
Alarm Restores
Opening/Closings
Zone Bypass and Restores

Tamper/Trouble Tampers and Restores
Zone Trouble and Restores
Expander Trouble and Restores
Siren/Phone Faults and Restores
RF Sensor Lost and Restores
RF Low Battery and Restores

Power Power Trouble and Restores
Aux Overcurrent and Restores

Communications Fail to Communicate
Test Reports

Miscellaneous

15.2.2.1.2.3.1

15.2.2.1.2.3.2

15.2.2.1.2.4.1

15.2.2.1.2.4.2

15.2.2.1.2.5.1
15.2.2.1.2.5.2

Arm/Disarm/Alarm 15.2.2.1.2.1.1
15.2.2.1.2.1.2

15.2.2.1.2.1.3
15.2.2.1.2.1.4

15.2.2.1.2.2.1

15.2.2.1.2.2.2
15.2.2.1.2.2.3
15.2.2.1.2.2.4
15.2.2.1.2.2.5

15.2.2.1.2.2.6

Events

Partition Account Codes

Receiver Number
Line Number

Up/Download Site Initiated
Remote Initiated
Auto U/D at Test Time
IP Address 

15.2

15.4

15.2.2

15.2.2.1.2

15.2.2.1.2.3

15.2.2.1.2.4

15.2.2.1.2.5

15.2.3.2

15.3.2

15.3.3

15.3.4

15.4.1
15.4.2

15.4.3

15.4.4

Automation Enable Automation
IP Address

15.5 15.5.1

15.5.2

Reporting Report Format
Control Panel is Backup
Receiver 2 as Backup
Receiver Polling
Polling Time

Event Recorder Send Tags to Recorder
IP Address

Options

Use DHCP 
Our IP Address
Gateway IP Address
Subnet Mask
Network Timeout
Max Network Attempt

Network

15.7.1

15.7.1.3

15.7.1.2

15.7.1.1

Model
Version
Default Settings

TCP/IP Alarm Port
U/D Port
E-mail Port
Automation Port

15.9

15.8

15.10

15.8.2.7.3

15.8.2.7.2

15.8.2.7.1Port Numbers

15.6

15.7

15.6.1

15.7.2

15.7.1.4

15.7.1.5

15.7.2.1

15.7.2.2

15.7.2.3

15.7.2.4

15.7.2.5

15.7.2.6

15.7.2.7

15.8.2.7.4

Receiver 2
Same as above

E-mail 2
Same as above

Partition 2-8
Same as above

15.6.2
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15.3.1 Configuring TCP/IP reporting
The CS7050 TCP/IP module can report to two receivers. You can configure the events to be reported, the 
reporting format and the reporting connection parameters. The following example uses TCP/IP reporting to send 
primary reports for tamper events occurring in partition 1 to receiver 1 (IP address 122.168.1.1).

1. Navigate with the  keys to CS7050 TCP/IP Module>TCP/IP Reporting>Receiver (1) and press OK.

2. Scroll to IP Address and press OK.

3. Enter 122.168.1.1 and press OK.

4. The keypad beeps once to confirm the change and returns to IP Address.

5. Scroll to Events>Tamper/Trouble>Tampers and Restores and press OK.

6. Press the relevant keys to include partition 1 in the tamper and restores event report.

7. The keypad beeps once to accept the change and returns to Tampers and Restores.

8. Navigate with the  keys to Options>Reporting>Report Format and select the format relevant for your 
central station receiver.

9. Obtain the IP port and IP address, gateway and subnet mask for the CS7050 TCP/IP module:

- For Windows 9X / Windows ME, type ipconfig at the DOS prompt.

- For Windows 2000 / XP, type ipconfig at the COMMAND prompt. 

10. Navigate with the  keys to Network and press OK.

11. Scroll in turn to Our IP Address, Gateway IP Address, Subnet Mask and Port Numbers and enter the 
information obtained in step 9. 

15.3.2 Configuring email reporting
Reporting to email addresses can include computers, cell phones, pagers and devices. You can configure the 
events to be reported, the reporting format and the reporting connection parameters. When using email reporting, 
you must configure the server settings and the CS7050 email address and port. The following example uses 
email reporting to send primary reports for alarms occurring on in partition 2 from ouremail@myemail.com to 
email address 1 (user1@myemail.com).

1. Navigate with the  keys to CS7050 TCP/IP Module>E-mail Reporting>Our E-mail Address and press 
OK.

2. Enter ouremail@myemail.com and press OK.

3. The keypad beeps once to confirm the change and returns to Our E-mail Address.

4. Scroll to E-mail Accounts>E-mail 1>E-mail Address and press OK.

5. Enter user1@myemail.com and press OK.

6. The keypad beeps once to confirm the change and returns to E-mail Address.

7. Scroll to Events>Arm/Disarm/Alarm>Alarms and press OK.

8. Press the relevant keys to include partition 2 in the alarms report and press OK.

9. The keypad beeps once to accept the change and returns to Alarms.
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10. Navigate with the  keys to Options>Reporting>Report Format and select the format relevant for your 
central station receiver.

11. The keypad beeps once to accept the change and returns to Report Format.

12. Navigate with the  keys to E-mail Reporting>E-mail Server>Domain Name and press OK.

13. Enter the domain name of the server to which reports are sent and press OK.

14. The keypad beeps once to accept the change and returns to Domain Name.

15. Scroll to E-mail Server>IP Address and press OK.

16. Enter the IP address of the server to which reports are sent and press OK.

17. The keypad beeps once to accept the change and returns to IP Address.

15.3.3 Configuring reporting options
The CS7050 TCP/IP module can send primary, backup and dual reports. The following steps explain how to 
configure each type of report. 

1. Navigate with the  keys to CS7050 TCP/IP Module>Options>Reporting and press OK. 

2. To use another CS7050 receiver as backup, select Receiver 2 as Backup>Enabled and press OK. 

3. To use the control panel as backup:

- Select Control Panel is Backup>Enabled and press OK. 

- Enable autotest report on the control panel phone events and panel system events. 

- Ensure the reporting format used by the control panel is the same as that set in Report Format. 

4. To configure dual reporting:

- Select Receiver 2 as Backup>Disabled and press OK. 

- Select Control Panel is Backup>Disabled and press OK. 

- Enable all event categories on the control panel. 

15.3.4 Configuring upload/download
To enable upload/download, you must configure the session initiation settings on the CS7050 TCP/IP module and 
specify the PC IP address and port. The upload/download access code is set on the control panel. The following 
example enables download sessions during test calls. The calls are initiated from a central station (IP address 
192.37.57.3) using the TCP/IP alarm port. 

1. Navigate with the  keys to CS7050 TCP/IP Module>Up/Download and press OK.

2. Scroll to Remote Initiated>Enabled and press OK.

3. The keypad beeps once to accept the change and returns to Remote Initiated.

4. Scroll to IP Address and press OK. 

5. Enter 192.37.57.3 and press OK.

6. The keypad beeps once to accept the change and returns to IP Address.

7. Scroll to Auto U/D at Test Time>Enabled and press OK.

8. The keypad beeps once to accept the change and returns to Auto U/D at Test Time.
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9. Navigate with the  keys to Options>Network>Port Numbers and press OK.

10. Scroll to TCP/IP Alarm Port and press OK.

11. Enter the number of the port and press OK.

12. The keypad beeps once to accept the change and returns to TCP/IP Alarm Port.
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15.4 Glossary

Location Term Definition

15 CS7050 TCP/IP Module A module that operates as an Ethernet communications module for reporting 
and upload/download. 

15.1 TCP/IP Reporting A menu entry that groups TCP/IP reporting options. 

15.1.1.1 IP Address A menu option that configures the address of the selected TCP/IP receiver.

15.1.1.2 Events

A menu entry that contains all configurable events for each receiver or email 
account. All partitions are enabled by default. Enabled events are formatted 
into one or more messages according to pre-configured settings and sent to 
the selected report destination or email address. 
Select the partition(s) to include for each event report.  If the partition is not 
selected, no event from that partition reports via the network regardless of 
what is programmed elsewhere.

15.1.1.2.1 Arm/Disarm/Alarm A menu entry that groups the events that are reported to the selected receiver. 

15.1.1.2.1.1 Alarms A menu option that sends a report to the selected receiver when an alarm 
occurs. 

15.1.1.2.1.2 Alarm Restores A menu option that sends a report to the selected receiver when the alarm has 
been restored after an alarm. 

15.1.1.2.1.3 Opening/Closings A menu option that sends a report to the selected receiver stating when the 
system is opened (disarmed) and closed (armed).  

15.1.1.2.1.4 Zone Bypass and Restores A menu option that sends a report to the selected receiver when a zone is 
bypassed. A report is also sent when the zone is restored (un-bypassed). 

15.1.1.2.2 Tamper/Trouble A menu entry that groups together the tamper and trouble events that are 
reported to the selected receiver.

15.1.1.2.2.1 Tampers and Restores A menu option that sends a report to the selected receiver when a tamper 
occurs. A report is also sent when the tamper is no longer active. 

15.1.1.2.2.2 Zone Trouble and Restores
A menu option that sends a report to the selected receiver when a zone trouble 
condition occurs. A report is also sent when the trouble condition is no longer 
active. 

15.1.1.2.2.3 Expander Trouble and Restores A menu option that sends an expander trouble and restore report to the 
selected receiver.

15.1.1.2.2.4 Siren/Phone Faults and Restores A menu option that sends a report to the selected receiver when a siren or 
phone fault occurs. A restore report is sent when the fault is fixed. 

15.1.1.2.2.5 RF Sensor Lost and Restores
A menu option that sends a report to the selected receiver when an RF sensor 
is missing. A restore report is sent to the central station when the receiver 
receives a valid signal from the lost transmitter. 

15.1.1.2.2.6 RF Low Battery and Restores
A menu option that sends a report to the selected receiver when a low battery 
condition occurs in an RF sensor. A restore report is also sent when the low 
battery condition is no longer active.

15.1.1.2.3 Power A menu entry that groups the power events that are reported to the selected 
receiver.

15.1.1.2.3.1 Power Trouble and Restores A menu option that reports mains failure, mains restore, low battery and low 
battery restore events to the selected receiver. 

15.1.1.2.3.2 Aux Overcurrent and Restores
A menu option that sends a report to the selected receiver when too much 
current is detected. A restore report is also sent when the overcurrent condition 
is fixed. 
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15.1.1.2.4 Communications A menu entry that groups the communication events that are reported to the 
selected receiver.

15.1.1.2.4.1 Fail to Communicate A menu option that reports a fail to communicate event to the selected report 
control. 

15.1.1.2.4.2 Test Reports A menu option that sends a test report to the selected receiver. The units can 
be set in days or hours. 

15.1.1.2.5.1 Program/Download A menu option and that reports programming and up/download events to the 
selected receiver.

15.1.1.2.5.2 Zone Inactivity Monitor A menu option menu option that sends a report to the selected receiver when a 
zone inactivity event occurs.

15.2 E-mail Reporting A menu entry that groups email reporting options.

15.2.1 Our E-mail Address

A menu option that configures the email address assigned to the CS7050 TCP/
IP module. This is a mandatory setting for email reporting. The mail server 
must accept the domain name. Many mail servers reject emails from domains 
other than their own to prevent spamming.

15.2.2 E-mail Accounts A menu entry that groups email account options.

15.2.2.1.1 E-mail Address
A menu option that configures the address of the selected email account. This 
must be a functional email account that is known to work. A large variety of 
devices can be utilised including computers, cell phones, pagers and devices. 

15.2.2.1.2 Events

A menu entry that contains all configurable events for each receiver or email 
account. All partitions are enabled by default. Enabled events are formatted 
into one or more messages according to pre-configured settings and sent to 
the selected report destination or email address. 
Select the partition(s) to include for each event report. If the partition is not 
selected, no event from that partition reports via the network regardless of 
what is programmed elsewhere.

15.2.2.1.2.1 Arm/Disarm/Alarm A menu entry that groups the events that are reported to the selected email 
account.

15.2.2.1.2.1.1 Alarms A menu option that sends a report to the selected email account when an 
alarm occurs. 

15.2.2.1.2.1.2 Alarm Restores A menu option that sends a report to the selected email account when the 
alarm has been restored after an alarm. 

15.2.2.1.2.1.3 Opening/Closings A menu option that sends a report to the selected email account stating when 
the system is opened (disarmed) and closed (armed).  

15.2.2.1.2.1.4 Zone Bypass and Restores A menu option that sends a report to the selected email account when a zone 
is bypassed. A report is also sent when the zone is restored (un-bypassed). 

15.2.2.1.2.2 Tamper/Trouble A menu entry that groups the tamper and trouble events that are reported to 
the selected email account.

15.2.2.1.2.2.1 Tampers and Restores A menu option that sends a report to the selected email account when a 
tamper occurs. A report is also sent when the tamper is no longer active. 

15.2.2.1.2.2.2 Zone Trouble and Restores
A menu option that sends a report to the selected email account when a zone 
trouble condition occurs. A report is also sent when the trouble condition is no 
longer active. 

15.2.2.1.2.2.3 Expander Trouble and Restores A menu option that sends an expander trouble and restore report to the 
selected email account.

Location Term Definition
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15.2.2.1.2.2.4 Siren/Phone Faults and Restores A menu option that sends a report to the selected email account when a siren 
or phone fault occurs. A restore report is sent when the fault is fixed. 

15.2.2.1.2.2.5 RF Sensor Lost and Restores
A menu option that sends a report to the selected email account when an RF 
sensor is missing. A restore report is sent to the central station when the 
receiver receives a valid signal from the lost transmitter. 

15.2.2.1.2.2.6 RF Low Battery and Restores
A menu option that sends a report to the selected email account when a low 
battery condition occurs in an RF sensor. A restore report is also sent when the 
low battery condition is no longer active.

15.2.2.1.2.3 Power A menu entry that groups the power events that are reported to the selected 
email account.

15.2.2.1.2.3.1 Power Trouble and Restores A menu option that reports mains failure, mains restore, low battery and low 
battery restore events to the selected email account. 

15.2.2.1.2.3.2 Aux Overcurrent and Restores
A menu option that sends a report to the selected email account when too 
much current is detected. A restore report is also sent when the overcurrent 
condition is fixed. 

15.2.2.1.2.4 Communications A menu entry that groups the communication events that are reported to the 
selected email account.

15.2.2.1.2.4.1 Fail to Communicate A menu option that reports a fail to communicate event to the selected email 
account. 

15.2.2.1.2.4.2 Test Reports A menu option that sends a test report to the selected email account at pre-
programmed intervals. The units can be set in days or hours.  

15.2.2.1.2.5.1 Program/Download A menu option that reports programming and up/download events to the 
selected email account.

15.2.2.1.2.5.2 Zone Inactivity Monitor A menu option that sends a report to the selected email account when a zone 
inactivity event occurs.

15.2.3 E-mail Server A menu entry that groups email server options.

15.2.3.1 Domain Name A menu option that configures the domain name of the email server to which 
reports are sent.

15.2.3.2 IP Address A menu option that configures the address of the selected email server.

15.3 Account Codes A menu entry that groups account code options.

15.3.1 System Account Codes

A menu option that configures the SIA or Contact ID account numbers for each 
report receiver. SIA account numbers are 6 digits long. Contact ID account 
numbers are 4 digits long. They must be entered with extra zeros to the left. If 
you attempt to use both system account codes and partition account codes, 
the partition account codes take precedence. 

15.3.2 Partition Account Codes

A menu option that lists the account codes for each partition. The account 
code is sent when the relevant partition is reported. 
There are two sets of account codes. The first set assigns an account code to 
each report destination. The second set assigns an account code to each 
partition. If you attempt to use both sets, the partition account code takes 
precedence.

15.3.3 Receiver Number A menu option that configures the phone line receiver number associated with 
the receiver account. 

15.3.4 Line Number A menu option that configures the line number associated with the receiver 
account. 

15.4 Up/Download A menu entry that groups options used to control download sessions between 
the up/download software and the control panel. 

Location Term Definition
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15.4.1 Site Initiated A menu option that allows an upload/download session between the module 
and the PC to be initiated from a keypad.

15.4.2 Remote Initiated

A menu option that allows an upload/download session between the module 
and the PC to be initiated by the PC. The PC dials into the module. You must 
dial the data phone number to dial into the GSM for upload/download.
It is advisable to enable this setting only for a private network using a firewall. 

15.4.3 Auto U/D at Test Time
A menu option that configures the module to automatically dial the PC to 
initiate an upload/download session after an autotest. You must program the 
autotest on the control panel. 

15.4.4 IP Address A menu option that configures the address of the PC running upload/download 
software.

15.5 Automation A menu entry that groups automation options.

15.5.1 Enable Automation A menu option that allows automation systems to control the system via the 
CS7050 TCP/IP module. 

15.5.2 IP Address A menu option that configures the address of the PC running automation 
software.

15.6 Event Recorder A menu entry that groups event recorder options.

15.6.1 Send Tags to Recorder This option is not used in Europe.

15.6.2 IP Address A menu option that configures the address of the selected event recorder.

15.7.1 Reporting A menu entry that groups TCP/IP reporting options.

15.7.1.1 Report Format
A menu option that configures the communicator format used to report to TCP/
IP receivers. Consult the instructions for your central station receiver to 
determine which format is compatible.

15.7.1.2 Control Panel is Backup
A menu option. This allows the control panel to act as a backup to the CS7050. 
This means that when the CS7050 fails to send a report, it sends an expansion 
event to the control panel and the control panel sends the report instead.

15.7.1.3 Receiver 2 as Backup A menu option that configures the module to send backup reports to its second 
TCP/IP receiver. 

15.7.1.4 Receiver Polling A menu option that configures the module to send polling messages to the 
report receivers.

15.7.1.5 Polling Time

A menu option that configures the TCP/IP polling time. This value must match 
the TCP/IP polling time set on a TCP/IP receiver. The value chosen is 
determined by the level of security required and the cost of data transmission. 
This can be from 1 to 255 seconds. If set to 0, the option is disabled. 

15.7.2 Network A menu entry that groups network options.

15.7.2.1 Use DHCP

A menu option that configures the CS7050 to use a dynamically assigned IP 
address. If this option is enabled, you should configure a Polling Time. If this 
option is disabled, configure Our E-mail Address, Gateway IP Address and 
Subnet Mask.

15.7.2.2 Our IP Address A menu option that configures the IP address assigned to the module. 

15.7.2.3 Gateway IP Address
A menu option that configures the IP address of the gateway used by the 
module. You must power down the CS7050 module and power it back up to 
initialize the new IP address.

Location Term Definition
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15.5 Technical specifications

15.7.2.4 Subnet Mask

A menu option that configures the subnet mask. This is typically 
255.255.255.0. Contact the network administrator to confirm. All IP addresses 
up to and including the local gateway must be allowed. When using cable 
modem/DSL, this mask is the same as that used by the PC. 

15.7.2.5 Network Timeout
A menu option that configures the maximum overall length of time by the 
CS7050 to report to each receiver. If the report is not successful during this 
time, the attempt is abandoned. This can be from 30 to 255 seconds.

15.7.2.6 Max Network Attempt A menu option that configures the number of attempts the module makes to 
send a report. This can be from 1 to 15.

15.7.2.7 Port Numbers A menu entry that groups TCP/IP port options.

15.8.2.7.1 TCP/IP Alarm Port
A menu option that configures the number of the TCP/IP port to which polling 
and alarms are reported. The default is 9999 and under normal circumstances 
should not be changed.

15.8.2.7.2 U/D Port
A menu option that configures the number of the port used for upload/
download. The default is 9999 and under normal circumstances should not be 
changed.

15.8.2.7.3 E-mail Port
A menu option that configures the port number that the email server uses for 
email. The default is 0025 and under normal circumstances should not be 
changed.

15.8.2.7.4 Automation Port A menu option that configures the number of the port used for automation. The 
default is 0000 and under normal circumstances should not be changed.

15.8 Model A menu option that displays the current model of the selected module. 

15.9 Version A menu option that displays the current software version of the selected 
module.

15.10 Default Settings A menu option that defaults the selected module to factory defaults.

Power supply specifications

Power supply voltage 13.8 V  ± 2% 

Consumption - Standby 90 mA

Consumption – Communicating 120 mA

General feature specifications

PCB Size Dimensions (width x height x depth) 153x84x25 mm

Environmental Operating temperature +0° C to + 40 °C

Humidity Max 93% 

Shipping Weight 455 g

Location Term Definition
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Chapter 16: Setting up the CS7501

16.1 Overview
The CS7501 ISDN (integrated services digital network) dialler allows digital data to be sent over a standard 
phone line. It supports reporting over the B and D channels on ISDN.

16.2 Installing the CS7501 ISDN dialler 

Part Purpose

J1 ISDN connector to receive the incoming signal.

J2/J3 Bi-directional connector to the control panel. It connects the audio circuits to the control panel and 
CS534 to provide up/download and audio listen-in. 

J4 1 DAT Connects to the DATA connection on the control panel

2 COM Connects to the COM connection on the control panel

3 POS Connects to the AUX+ connection on the control panel

4 COM Power connection using the black battery lead.

5 PWR Power connection using the red battery lead.

J5 ISDN connector for the outgoing signal.

JP2/JP3 ISDN terminating resistors. The total impedance of the S0-bus should be 50 Ohm. The 2 jumpers 
JP2/3 should only be placed when the "priority relay" is used and when you have no EOL resistors 
on a device other than the CS7501.

D11 Green LED  ISDN communication status.

J1

J2 J3

JP2/3

J4

D11

J5 D13
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16.2.1 LED indicators

16.2.2 Mounting the CS7501 ISDN dialler

1. Mount the support pillars as shown.

2. Slot the board into the support pillars.

D13 Red LED Panel communication status.

LED Status Description

Green LED  
B channel 
reporting

Off No activity.

On The CS7501 ISDN connection is in use.

Flashing The CS7501 is between calls or trying different destinations.

Green LED 
D channel 
reporting

Off The CS7501 has no connection with the central station.

On The CS7501 is making a connection to the central station or busy with 
reporting events to central station.

Flashing The CS750 had a connection to the central station.

Blinking The CS7501 is waiting between reports.

Red LED Off The CS7501 is not communicating with the control panel.

Blinking The CS7501 is communicating with the control panel.

CS7501
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3. Connect the DATA, COM and POS bus connections on the CS7501 to the keypad bus

.

4. Connect the ISDN connections via the RJ45 connector.

5. Plug the cable between the CS7501 and the panel. Ensure that the colour of the cable matches at each end.        

Cables: Brown - Blue - Orange - Green.

1
2

3
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6. The CS7501 cannot be used with a CS535 voice module. However you can install a CS534 audio module 
using a ribbon cable as shown above. The coloured side of the ribbon cable should be on the lefthand side.

7. Place the CS534 under the tray in the panel box. The CS534 is mounted below the panel pcb. Lift the panel 
pcb and mount the CS534. Connect the ribbon cable underneath the board with the J7 connector. 
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8. Connect the following: 

• Connect the COM of the panel (A) to the COM of the ISDN dialler connection (B). 

• Connect the battery COM cable of the panel (C) to the COM of the battery (D). §

• Connect the red POS Male connector (E) f rom the ISDN dialler (F) to the battery 12V connector of the 
panel (G).§

• Connect the red female POS connector (H) to the POS of the battery (I).

C

A

B

D

E

F

H

I

G
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9. The red LED flashes when the CS7501 is powered up.

16.2.3 Wiring the battery leads
The battery leads should be wired to the panel battery as follows:

1. Connect the COM of the panel to the COM of the ISDN dialler connection. 

2. Connect the battery COM cable of the panel to the COM of the battery. 

3. Connect the red POS Male connector from the ISDN dialler to the battery 12V connector of the panel

4. Connect the red female POS connector to the POS of the battery.

5. The red LED flashes when the CS7501 is powered up.

For information on installing the CS7501 TCP/IP module in the various housings, see chapter A-4 Installing a 
basic system.
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16.3 Programming the CS7501 ISDN dialler 

You must enroll and default the CS7501 ISDN dialler before you begin to program the system. For more 
information on enrolling and defaulting, see chapter B-1 Enrolling modules. To program the CS7501, select 
Installer Menu>CS7501 ISDN Dialler. 

16.3.1 Configuring phone reporting
The CS7501 ISDN dialler can report to four phone numbers. You can configure the events to be reported, the 
reporting format and the reporting connection parameters. The following example reports alarm events that 
occur to phone number 8888999, account code 445566 using SIA format.

1. Navigate with the  keys to CS7501 ISDN Dialler>Reporting>Phone Numbers and press OK.

2. Scroll to Phone Number 1>Phone Number and press OK.

3. Enter 8888999 and press OK.

Phone NumbersReporting Phone Number (1)16.1 16.1.1 16.1.1.1 Phone Number
Account Code
Protocol

Backup Control

16.1.1.1.1
16.1.1.1.2

Dial Attempts
Dial Sequence

Dial Attempts16.1.2

Events Alarms
Alarm Restores
Opening/Closings
Zone Bypass and Restores

Tamper/Trouble Tampers and Restores
Zone Trouble and Restores
Expander Trouble and Restores
Siren/Phone Faults and Restores
RF Sensor Lost and Restores
RF Low Battery and Restores

Power Power Trouble and Restores
Aux Overcurrent and Restores

Communications Fail to Communicate
Test Reports

Miscellaneous Program/Download
Zone Inactivity Monitor

16.1.1.1.5.3.1

16.1.1.1.5.3.2

16.1.1.1.5.4.1

16.1.1.1.5.4.2

16.1.1.1.5.5.1
16.1.1.1.5.5.2

Arm/Disarm/Alarm

16.1.1.1.5.2

16.1.1.1.5.1

16.1.1.1.5.3

16.1.1.1.5.4

16.1.1.1.5.5

16.1.1.1.5.1.1
16.1.1.1.5.1.2

16.1.1.1.5.1.3
16.1.1.1.5.1.4

16.1.1.1.5.2.1

16.1.1.1.5.2.2

16.1.1.1.5.2.3
16.1.1.1.5.2.4

16.1.1.1.5.2.5

16.1.1.1.5.2.6

Burglary & Trouble Telim Ch

Priority Reporting
Priority Type
Backup Control *

Up/Download Phone Number
Remote U/D When Armed
Answer Delay

Options ISDN

Model
Version
Default Settings

Listen-in

Volumes

16.1.3

16.1.4

16.1.5

ARC Dial Attempts
FTC Dial Attempts
Voice/Siren Dial Attempts

When Disarmed
When Armed

Connection Type
MSN Phone Number
D-Ch Polling
D-Ch TEI
D-Ch X.25 LCGN
D-Ch X.25 LCN

CS534 Listen-in

CS534 Listen-in
Answer Delay

Up/Download

Outgoing
Incoming

Outgoing
Incoming

16.1.2.1
16.1.2.2

16.3.1.1

16.1.3.2

16.1.2.3

16.1.3.1

16.2 16.2.1

16.2.2

16.2.2

16.3 16.3.1

16.3.2

16.3.3

16.4

16.5

16.6

16.1.1.1.3

16.1.1.1.4

16.1.1.1.5

16.1.1.1.4.1

16.1.1.1.4.2

16.3.1.2

16.3.1.3
16.3.1.4

16.3.1.5

16.3.1.6

16.3.2.1

16.3.2.2

16.3.3.1

16.3.3.2

16.3.3.1.1

16.3.3.1.2

16.3.3.2.1

16.3.3.2.2

Phone Number 2-4
Same as above

Version 3 only

Version 4 and above only

Version 4 and above only

16.1.6

*Version 4 and above only
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4. The keypad beeps once to accept the change and returns to Phone Number.

5. Scroll to Account Code and press OK.

6. Enter 445566 and press OK.

7. The keypad beeps once to accept the change and returns to Account Code

8. Scroll to Protocol>SIA and press OK.

9. The keypad beeps once to accept the change and returns to Protocol.

10. Scroll to Events>Arm/Disarm/Alarm>Alarms and press OK.

11. The keypad beeps once to accept the change and returns to Alarms.

16.3.2 Configuring AL2 supervised ISDN connection
If you are using the AL2 supervised ISDN connection, you must also program  the D channel polling and D 
Channel Terminal Equipment identifier (TEI) options as well as the phone number, account code, protocol and 
events. The following example reports alarm events to phone number 02048888999, account code 55555 using 
the Alphacom X25 D-channel protocol.

1. Navigate with the  keys to CS7501 ISDN Dialler>Reporting>Phone Numbers and press OK.

2. Scroll to Phone Number 1>Phone Number and press OK.

3. Enter 020488899 and press OK.  

4. The keypad beeps once to accept the change and returns to Phone Number.

5. Scroll to Account Code and press OK.

6. Enter 55555  and press OK.

7. The keypad beeps once to accept the change and returns to Account Code

8. Scroll to Protocol> Alphacom D-channel and press OK.

9. The keypad beeps once to accept the change and returns to Protocol.

10. Scroll to Events and enable all events that must be reported to central station. 

11. Navigate with the  keys to CS7501 ISDN Dialler>Options>ISDN>D-Ch Polling and press OK.

12. Scroll to D-Ch Polling>5 min. and press OK.

13. The keypad beeps once to accept the change and returns to D-Ch Polling.

14. Scroll to D-Ch TEI>8 and press OK.

15. The keypad beeps once to accept the change and returns to D-Ch TEI.

" Default are all events enabled in dialer.

16.3.3 Uploading and downloading
There are two methods for up/downloading , call back or start u/d with code. 

When using the CS534, the ISDN dialler differentiates between these two methods. 

• For listen-in via call back, the ISDN listens for 5 seconds to check if a DTMF tone 0 was entered for a period 
of 1 second. 

• If no DTMF tone was recognised the ISDN starts an up/download session.
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16.3.3.1 Time synchronisation
The CS7501  automatically corrects the time and date on the panel when the difference is more then 5 minutes 
between the panel time and ISDN network. This is done on every communication with the B-channel.

16.3.3.2 Call back
The panel is set up to call back the central station in order to initiate an upload/download session. When the 
central station calls the panel, the panel answers the call and then hangs up. After approximately a short period, 
the CS7501 calls the central station back.

To use the CS7501 ISDN dialler for callback, you must configuring both the CS7501 and the control panel. The 
following example sets a four second delay before answering. A call back is required before the upload/
download session begins.  

1. Navigate with the  keys to CS7501 ISDN Dialler>Up/Download>Phone Number and press OK.

2. Enter the panel phone number and press OK.

3. The keypad beeps once to accept the change and returns to Phone Number.

4. Navigate with the  keys to Control Panel>Communications>Central Station>Phone Prefix and press 
OK.

5. Enter #3 and press OK.

6. The keypad beeps once to accept the change and returns to Phone Prefix.

7. Scroll to Up/Download>Rings to Answer and press OK.

8. Select 0 and press OK.

9. The keypad beeps once to accept the change and returns to Rings to Answer .

10. Scroll to Call Back Reqd>Active and press OK.

11. The keypad beeps once to accept the change and returns to Call Back Reqd.

16.3.3.3 Start u/d with code
The user initiates the upload/download by selecting an option in the User menu.

1. Follow steps 1-6 above to set up the phone number and prefix.

2. When upload is required, the user selects User Menu>Command Menu>Download>Answer U/D Call.

16.4 Glossary

Location Term Definition

16 CS7501 ISDN Dialler A module that operates as an ISDN communications module for reporting and 
upload/download. 

16.1 Reporting A menu entry that groups ISDN reporting options.

16.1.1 Phone Numbers A menu entry that groups phone number reporting options. 

16.1.1.1.1 Phone Number A menu option that sets the phone number to which events are reported. The 
control panel can report to up to six phone numbers.
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16.1.1.1.2 Account Code A menu option that specifies the unique code sent from the modem in the 
control panel or dialler to the selected phone number. This code is used to 
identify and charge the user. Separate account codes can be set up for each 
phone number and each partition. This is also known as the account number. 

16.1.1.1.3 Protocol A menu option that configures the communicator format used to report to the 
selected phone number. 
Consult the instructions for your central station receiver to determine which 
format is compatible.

16.1.1.1.4 Backup Control A menu entry that groups options that set the backup sequence of the ISDN 
telephone numbers.

16.1.1.1.4.1 Dial Attempts A menu option that specifies the number of dial attempts that the module 
makes to the central station before attempting an alternative destination.

16.1.1.1.4.2 Dial Sequence A menu option that specifies the order in which the configured phone numbers 
are dialled. 

16.1.1.1.5 Events A menu entry that contains all configurable events for each phone number.

16.1.1.1.5.1 Arm/Disarm/Alarm A menu entry that groups the events that are reported to the selected phone 
number. 

16.1.1.1.5.1.1 Alarms A menu option that sends a report to the selected phone number when an 
alarm occurs. 

16.1.1.1.5.1.2 Alarm Restores A menu option that sends a report to the selected phone number when the 
alarm has been restored after an alarm. 

16.1.1.1.5.1.3 Opening/Closings A menu option that sends a report to the selected phone number stating when 
the system is opened (disarmed) and closed (armed).  

16.1.1.1.5.1.4 Zone Bypass and Restores A menu option that sends a report to the selected phone number when a zone 
is bypassed. A report is also sent when the zone is restored (un-bypassed). 

16.1.1.1.5.2 Tamper/Trouble A menu entry that groups the tamper and trouble events that are reported to 
the selected phone number.

16.1.1.1.5.2.1 Tampers and Restores A menu option that sends a report to the selected phone number when a 
tamper occurs. A report is also sent when the tamper is no longer active. 

16.1.1.1.5.2.2 Zone Trouble and Restores A menu option that sends a report to the selected phone number when a zone 
trouble condition occurs. A report is also sent when the trouble condition is no 
longer active. 

16.1.1.1.5.2.3 Expander Trouble and Restores A menu option that sends an expander trouble and restore report to the 
selected phone number.

16.1.1.1.5.2.4 Siren/Phone Faults and Restores A menu option that sends a report to the selected phone number when a siren 
or phone fault occurs. A restore report is sent when the fault is fixed. 

16.1.1.1.5.2.5 RF Sensor Lost and Restores A menu option that sends a report to the selected phone number when an RF 
sensor is missing.  A restore report is sent to the central station when the 
receiver receives a valid signal from the lost transmitter. 

16.1.1.1.5.2.6 RF Low Battery and Restores A menu option that sends a report to the selected phone number when a low 
battery condition occurs in an RF sensor. A restore report is also sent when the 
low battery condition is no longer active.

16.1.1.1.5.3 Power A menu entry that groups the power events that are reported to the selected 
phone number.

16.1.1.1.5.3.1 Power Trouble and Restores A menu option that reports mains failure, mains restore, low battery and low 
battery restore events to the selected phone number.

Location Term Definition
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16.1.1.1.5.3.2 Aux Overcurrent and Restores A menu option that sends a report to the selected phone number when too 
much current is detected. A restore report is also sent when the overcurrent 
condition is fixed. 

16.1.1.1.5.4 Communications A menu entry that groups together the communication events that are reported 
to the selected phone number.

16.1.1.1.5.4.1 Fail to Communicate A menu option that reports a fail to communicate event to the selected phone 
number. 

16.1.1.1.5.4.2 Test Reports A menu option that sends a test report to the selected phone number at pre-
programmed intervals. The units can be set in days or hours.  

16.1.1.1.5.5.1 Program/Download A menu option that reports programming and up/download events to the 
selected phone number.

16.1.1.1.5.5.2 Zone Inactivity Monitor A menu option that sends a report to the selected phone number when a zone 
inactivity event occurs.

16.1.2 Dial Attempts A menu entry that groups dialling options.

16.1.2.1 ARC Dial Attempts A menu option that specifies the number of dial attempts (1 to 15 attempts) 
that the communicator makes when reporting to the selected phone number. 

16.1.2.2 FTC Dial Attempts A menu option that specifies the number of dial attempts that are made by the 
GSM module to a specified phone number, before the Fail To Communicate 
condition appears. 

16.1.2.3 Voice/Siren Dial Attempts A menu option that specifies the number of dial attempts (1 to 15) that the 
communicator makes for voice dialing, pager or Siren Tone formats.

16.1.3 Burglary & Trouble Telim Ch A menu option that specifies the TELIM channels to be used for burglary and 
trouble reports.

16.1.3.1 When Disarmed A menu option that specifies the burglary and trouble TELIM channel used to 
report alarms while disarmed.

16.1.3.2 When Armed A menu option that specifies the burglary and trouble TELIM channel used to 
report alarms while armed.

16.1.4 Priority Reporting A menu option that enables priority reporting. 

16.1.5 Priority Type A menu option that configures the priority type used when priority reporting is 
enabled. If this option is set to Check Free B-Ch, the dialler disconnects calls 
to report alarms by attempting to free the B-channel. If it cannot free the 
channel, it  disconnects the S0 bus. 
If this is set to Always Disconnect, the dialler disconnects calls to report alarms 
by  disconnecting the S0 bus. 

6.1.6 Backup Control A menu option that configures the backup control for the GSM in SIA or CID or 
configures the  ISDN to be backup for the GSM .

16.2 Up/Download A menu entry that groups options used to control download sessions between 
the up/download software and the control panel. 

16.2.1 Phone Number A menu option that sets the phone number to which events are reported. The 
control panel can report to up to six phone numbers.

16.2.2 Remote U/D When Armed A menu option that allows an upload/download session between the module 
and the PC to be initiated by the PC when the system is armed.

16.2.3 Answer Delay A menu option that sets the number of seconds before the panel answers to 
start an upload/download session.

16.3.1 ISDN A menu entry that groups ISDN connection options.

Location Term Definition
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16.3.1.1 Connection Type A menu option that specifies the type of ISDN connection. You can choose 
point to point or point to multipoint.

16.3.1.2 MSN Phone Number Multiple Subscriber Number. You can have more then 1 telephone number on 
a single ISDN connection. MSN is only used in point to multipoint connection. If 
you can connect more then one device to the same ISDN connection, the MSN 
number is assigned to only one device. When you make a call to this number, 
only the device with the number assigned will answer. 
A menu option configures this device number.

16.3.1.3 D-Ch Polling A menu option that configures D channel polling. 

16.3.1.4 D-Ch TEI A menu option that configures the D channel terminal equipment identifier.

16.3.1.5 D-Ch X.25 LCGN A menu option that configures D-Ch X.25 LCGN. D-Ch X.25 LCGN is a logical 
channel group number. Contact the network provider to obtain this number. 
This can be from 0 to 255, the default is 0.

16.3.1.6 D-Ch X.25 LCN A menu option that configures D-Ch X.25 LCN. D-Ch X.25 LCGN is a logical 
channel number. Contact the network provider to obtain this number. This can 
be from 1 to 255, the default is 0.

16.3.2 Listen-in A menu entry that groups listen-in options.
In order to use listen-in, a CS534 listen-in module must be installed and a 
microphone must be connected. When an alarm is generated and reported, 
the central station can listen to what is happening on the premises. 
Certain protocols (such as SIA, Contact ID and 200Bd FSK) have ‘listen-in 
blocks’ that are communicated with the alarm code and indicate that a listen-in 
session must be started.

16.3.2.1 CS534 Listen-in A menu option that enables listen-in on the CS534 Listen-in module. 

16.3.2.2 Answer Delay A menu option that sets the number of seconds before the panel answers to 
start a listen-in session.

16.3.3 Volumes A menu entry that groups options to adjust levels used with the CS534 listen-in 
module. 

16.3.3.1 CS534 Listen-in A menu option that configures the volume of incoming and outgoing 
communication with the CS534 Listen-in module. 

16.3.3.2 Up/Download A menu option that configures the volume of incoming and outgoing 
communication during an upload/download session.

16.4 Model A menu option that displays the current model of the selected module. 

16.5 Version A menu option that displays the current software version of the selected 
module. 

16.6 Default Settings A menu option that defaults the selected module to factory defaults. 

Location Term Definition
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16.5 Technical specifications

Power supply specifications

Power supply voltage 12V  ± 2%  

Consumption - Standby 30 mA at 12V  ± 2%  

Consumption – Maximum via battery leads 2A at 12V  ± 2%  

General feature specifications

PCB Size Dimensions (width x height x depth) 150x80x24 mm

Environmental Operating temperature +0° C to + 49 °C

Humidity Max 93% 

Shipping Weight 115 g
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Chapter 17: Reading the event log

17.1 Overview

The event log displays the details of all the events that occur from when you turn the system on. A maximum of 
512 events are held in the event log. 

To read the event log:

1. Press OK at the system prompt and enter your installer code. 

2. Navigate with the  keys to Commands and press OK.

3. Scroll to Event Log and press OK.

4. The last event to be added to the log is shown. The > symbol indicates that the message must be scrolled 
horizontally.

5. Press F3 to scroll to the right and view the rest of the event description. Table 17-1: Event description 
explains each part of the event description.

- In this case, an alarm occurred in zone 168 in partition 3 at 17:32. No report was sent to the central 
station. The event occurred on September 25. This is the twenty-eighth event in the log.

6. Press the  keys to scroll through the events in the log.

Alarm 3 Press F3 Alarm 3
168 17:32 > 25/9 028

Table 17-1: Event description

Event description Explanation

L1   EventType PN PartitionName

L2 Zone/User Name UN/ZN HH:MM DD/MM LOG

EventType The type of event that occurred.

PN The number of the partition in which the event occurred.

PartitionName The name of the partition in which the event occurred.

Zone/User Name The zone name or user name.

UN/ZN The user number, zone number or device number.

HH:MM The hour and the minute the event occurred.

DD/MM The day and month the event occurred.

LOG The position of the event in the event log.

Alarm Memory
Reset Smoke Detector
Service Check
Do Self Test
Event Log
X-10 Devices
Advanced Menu
Zone Status
Device/Location Programming

17.1

17.7

17.6
17.5

17.4

17.3

17.2

17.8

17.9



CS875-575-375-275-175 Installers Manual with CS5500 keypad B.17.2

17.2 Event log events
Table 17-2: Event list

Event message Explanation

Alarm An alarm has been tripped.

Alarm Restore See Alarm event message.

Autotest An autotest message was sent to the central station.

B-Alarm A full alarm on a B zone type that is considered a burglary alarm. 

Box Tamper A box tamper.

Box Tamper Restore See Box Tamper event message.

Burglary A burglary zone has been tripped. 

Burglary Restore See Burglary event message.

Bypass A zone is bypassed.

Bypass Restore See Bypass event message.

Cancel The report to the central station has been cancelled. This occurs when a user enters a code after an alarm.

CleanMe A smoke detector is dirty. 

CleanMe Restore See CleanMe event message.

Clock Set A user set the date and time.

Close (arm) Closing (arm) by a specific user.

Code Entry The lock of the access reader has been triggered. 
The lock can be triggered by an accepted proximity card or by an Egress switch. An Egress switch is a button that can 
be pressed by a user to open the lock of the door. It can also be called Request-to-Exit (RTE). When the Code Entry 
option is activated, the reader sends a log message to the control panel, indicating that the lock has been triggered.

Data Lost The panel has been unable to send alarm messages to the central station. The panel tries to send these messages a 
number of times as specified in the FTC (Dial attempts before Fail to Communicate). Any pending reportable events are 
lost.

Disarm from Alarm A user disarmed the panel during an alarm.

Duress A duress code entered by a user. An alarm message is sent to the central station.

Early Open A user disarmed the system before the open time specified in the panel schedules.

End Download The end of an up/download.

End Prog End programming. The installer left programming mode.

End Walktest See Walktest event message.

Enrolled Modules are enrolled on the bus. The module numbers are recorded. 

Exit Error An exit door remained open after the exit delay expired.

Expander Trouble A problem with an expander module.

Expander Trouble 
Restore

See Expander Trouble event message.

Expansion Event A bus device generated an event to report conditions not described by other events. 

Fail to Communicate The control panel or module tried to send a message to a central station but failed.

Fire A fire alarm has been tripped.



CS875-575-375-275-175 Installers Manual with CS5500 keypadB.17.3

Fire Restore See Fire event message.

First Open The time at which the first area was opened. 

Keypad Tamper A keypad tamper.  

Last Close The time at which the last area was closed.

Late Close A user disarmed the system after the closing time specified in the panel schedules.

Listen-in The start of a listen-in session. 

Log Full The event log is full and the events must be reported to the up/download software. An event can also be sent to the 
central station.

Low Batt Restore See Low Battery event message.

Low Battery The standby battery for the control panel/expansion module is low.

Mains Fail Restore See Mains Failure event message.

Mains Failure The 220 V has disappeared.

Manual Fire A manual fire alarm generated by pressing the keys 1 and 3 on the keypad.

Manual Test A manual test call to the central station.

Medical (Aux2) A medical alarm generated by pressing the keys 4 and 6 on the keypad.

Open (disarm) Opening (disarm) by a specific user.

Output An output has been activated or restored. The output number is logged. This is linked to the output module number. 

Output Restore See Output event message.

Output Trip An output has been activated.

Over-current An excessive amount of current has been drawn from one of the outputs.

Over-current Restore See Over-current event message.

PA Panic Alarm A personal attack alarm has been tripped.

Panic Keypad A panic alarm generated by pressing the keys 7 and 9 on the keypad.

Partarm See Partial Arm event message.

Partial Arm Part arm of the system by a specific user.

Recent Closing An alarm occurred within five minutes of the panel being armed. 

Re-exit A special feature of false alarm preventing. 

Reset A user has manually reset a smoke detector. 

RF Jam Restore See RF Jammed event message.

RF Jammed RF jamming. 

RF Low Battery An RF transmitter has reported a low battery.

RF Low Battery Restore See RF Low Battery event message.

Service End End of the ‘Installer on-site’ (service mode).

Service Start Start of the ‘Installer on-site’ (service mode). 

Silent Panic A silent panic alarm.

Siren Tamper A siren tamper.

Table 17-2: Event list

Event message Explanation
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17.3 Glossary

Siren Tamper Restore See Siren Tamper event message.

Start Download The start of an up/download.

Start Prog Start programming. The installer entered programming mode.

Tamper A tamper. 

Tamper Restore See Tamper event message. 

Telephone Fault Telephone line faults.

Telephone Fault Restore See Telephone Fault event message.

Trouble A trouble condition. 

Trouble Restore See Trouble event message.

Walktest The start/end of a walktest.

Zone Inactive Restore See Zone Inactivity event message.

Zone Inactivity A zone inactivity monitoring event.

Zone Lost An RF transmitter has lost the supervision with the wireless receiver. This happens when the transmitter has not 
reported its supervision message to the RF receiver within the long supervision window. See appendix 5.

Zone Lost Restore See Zone Lost event message.

10 unsuccessful 
download attempts

This is a security feature. This event occurs if someone tries to hack into the system.

Location Term Definition

17 Commands A menu entry that groups options relating to issuing commands by the 
installer. 

17.1 Alarm Memory A menu option that displays a list of alarms and where they occurred. Only the 
alarms that have occurred during the last arm/disarm cycle are shown in the 
alarm memory log.

17.2 Reset Smoke Detector A menu command that resets two-wire and four-wire smoke detectors and the 
Fire LED. For hardwired smoke detectors, the power supply to the smoke 
detectors is cut temporarily. 
RF smoke detectors have an auto reset because the RF communication is uni-
directional (from RF detector to RF receiver). This command does not reset RF 
smoke detectors but should still be used to reset the Fire LED. 

17.3 Service Check A menu command that is used to verify service messages. 
The service message disappears when the installer enters and then leaves 
programming mode. If Master Code Resets Tamper Memory is enabled, a 
master user can reset the service message by entering a master user code. 

17.4 Do Self Test A menu command that performs the keypad LED and LCD test and the 
manual tests enabled in Diagnostics. The siren is activated during the tests if 
the Manual Siren menu option is enabled. Likewise, a manual test call is made 
to the central station if the Manual Dialler Test menu option is enabled.  

Table 17-2: Event list

Event message Explanation
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17.5 Event Log A menu command that is used to view the event log. The event log is a list of 
events that occur in the system, regardless of the armed state of the system. 
They are held in a sequential event buffer with a time and date stamp. When 
the log is full, it overwrites the oldest entries with new data. These events can 
later be viewed through downloading. 

17.6 X-10 Devices A menu option that lists the X-10 devices that can be turned ON/OFF.

17.7 Advanced Menu A menu option that activates certain options in the installer menu structure.

17.8 Zone Status A menu entry that indicates the zone status.

17.9 Device/Location Programming A menu command that switches into backward compatible programming 
mode. This mode uses devices, locations and segments.
In this mode:
The OK/Menu key is used instead of the * key.
The F2 key is used instead of the Exit key. 
Please note that the recommended programming method is to use the menu 
structure rather than devices and locations. 

Location Term Definition
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Chapter 18: Programming with the UDx75 software

18.1 Other methods of programming
You can program the system using the CS5500 keypad or the UDx75 software. This software allows you to 
download the programming information on the control panel to the computer running the UDx75 software, 
change it and upload the changes from the computer to the panel. It also allows you to view the program log and 
event log. To program the system using this software, you must connect the control panel to the computer. 

18.2 Connecting the panel to the computer
You can connect the control panel to the computer either directly via the RS232 serial port or remotely via a 
modem. 

18.2.1 Connecting using a serial port
Connecting via a serial port is useful if you are on site and want to connect directly to the alarm system. 

The connection to the CS275, CS375, CS575or CS875 panel is made through the RS232 port using CS590 cable. 
The CS175 does not have an RS232 port. The connection to the CS175 is made through the CS586 module, 
which provides a standard RS232 bi-directional DB-9 connector. The CS586 can be used as a programming tool 
on any panel, as it is connected to the data bus. It stores control panel settings that can be up/downloaded using 
the keypad or a computer. For more information on reading data from the CS586, see chapter B-8 Setting up the 
CS586.

To use the UDx75 software with a direct connection:

1. Double click the icon for the software or click Start>Programs>UDX75>UDX75. 

2. The UDX75 window and the UDX75 Master access screen open.

3. Enter the operator name and password and click OK. 

4. The UDX75 Operator access screen opens.

5. Enter the current operator and password and click OK. 

6. To connect to the panel directly via the serial port, select Download>Connect>Direct connect. The 
Connecting message box opens.

7. To connect to the panel via a TCP/IP network, select Download>Connect>Connect TCP/IP. The Reserved 
(TCPIP) screen opens. Enter the TCP/IP address and click OK.

8. When you are finished uploading or downloading, select Download>Disconnect.

< The default operator is Aritech and the default password is 1278. You may have to enter this twice.

18.2.2 Connecting using a modem
You can connect the control panel to the computer remotely via a modem. This can be useful if you are not on 
site and want to connect to the alarm system. 

You can connect normally or connect using answering machine defeat (AMD). If you use AMD, the 
automatically timed two-call-answer-machine-defeat sequence is used.

To use the UDx75 software with a modem connection:

1. Follow steps 1 - 5 in Connecting using a serial port above.  

2. Make sure that the modem settings are correct. For more information about modem settings, see the UDx75 
Online Help. 

3. Select Download>Connect> Connect Using AMD.
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4. A message box opens saying Initializing modem.

5. The computer connects to the panel. 

6. When you are finished uploading or downloading, select Download>Disconnect or click the Disconnect 
icon.

18.3 Programming with upload/download software
Downloading allows you to read the existing programming data or the event log from the control panel. 
Uploading allows you to send programming data, that you have set up using the UDx75 software, from the 
computer to the control panel. When you program the system using UDx75, the keypad can be reset after the 
system is powered down. This prevents text getting lost.

Before you download or upload information, do the following:

1. Ensure that the relevant control panel options are programmed correctly. There are a minimum number of 
options that you must set before you can program the control panel using the up/download software. Table 
18-1: Required settings for up/downloading lists the options and the values to enter.

2. Ensure that the up/download access code is the same in both the up/download software and the control panel. 
See chapter A-1 Introducing the CSx75 system for the correct default code.

3. If you are connecting remotely, make sure that the modem settings are correct. For more information about 
modem settings, see the UDx75 Online Help.

4. Connect to the panel via the serial port or modem.

5. Select Download>Read all to download all the data from the control panel. The computer downloads the data 
from the panel. 

6. Select Download>Send all to upload all the data to the control panel. The computer uploads the data to the 
panel. 

The data that is downloaded and the downloading speed depend on the Send All/Read All settings. The default 
number of strings sent to the keypad is 192 but it is possible to limit the number of strings sent. If the default 
number is reduced, download time decreases. For more information on setting up/download options, see the 
UDx75 Online Help.

Table 18-1: Required settings for up/downloading

Keypad menu option Value

Serial Port>Connection Type Home Automation

Serial Port>Speed 9600 Baud

Home Automation>Protocol Binary

Home Automation>Transition Broadcasts Ensure all options are set to Off. This is the default state.

Home Automation>Commands/Requests Ensure all options are set to On. This is the default state.
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18.3.1 Programming tasks
You can perform all available programming tasks using the UDx75 software. Table 18-2: UDx75 menu paths 
shows the UDx75 menu path for each task.

Table 18-2: UDx75 menu paths

Task UDx75 menu option

Adding customer notes View>Customers>Notes

Adding operators Program>Setup>Add/Change operators

Backing up the database Tools>Backup database

Changing a customer record View>Customers>Single customer

Changing a master or operator password Program>Change password

Changing operator rights Program>Setup>Add/Change operators

Changing the additional phone settings View>Control panel (Additional phone settings tab)

Changing the communicator codes Advanced>4+2 Codes

Changing the download options Program>Setup>Download options

Changing the partitions View>Control panel (Partition tab)

Changing the report settings View>Control panel (Phone numbers tab)

Changing the system 1 settings View>Control panel (System 1 tab)

Changing the system 2 settings View>Control panel (System 2 tab)

Changing the system 3 settings View>Control panel (System 3 tab)

Changing the UDx75 settings Program>Setup>Program setup

Changing the user arm/disarm codes View>Control panel (Codes tab)

Compacting the database Tools>Compact database

Connecting via the modem Download>Connect >Connect or Download>Connect >Connect using 
AMD

Connecting via the serial port Download>Connect>Direct connect

Copying a customer’s panel settings Program>Setup>Copy options

Deleting a customer record View>Customers>Single customer

Deleting the event log Download>Event log>Delete Event log

Downloading Download>Send all

Downloading and updating the device list Download>Device list>Enroll devices

Downloading the event log Download>Event log>Read entire log

Exporting a database Tools>Export database

Importing a database Tools>Import database

Loading the default settings Advanced>Default Control data

Logging in Start>Programs>UDX75>UDX75

Printing a customer record list Program>Print preview>Customer list

Printing a program log Program>Print preview>Program log

Printing a programming worksheet Program>Print preview>Programming worksheet
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Printing an operator list Program>Print preview>Operator list

Printing customer notes Program>Print preview>Notes

Printing the event log Program>Print preview>Event log

Programming the CS1700 Expanders>CS1700>1

Programming the CS208/CS216 View>Control panel (Zones tab)

Programming the CS320 Expanders>CS320>1

Programming the CS507 Expanders>CS507>1

Programming the CS534 Expanders>CS534

Programming the CS535 Expanders>CS535

Programming the keypad text Expanders>Keypad text

Programming the keypads Expanders>Keypad options>Partition 1>Keypad 1

Programming the wireless receivers Expanders>Wireless>1

Programming the zones View>Control panel (Zones tab)

Repairing the database Tools>Repair database

Restoring the database Tools>Restore database

Retrieving and viewing a customer record View>Customers>Single customer

Running diagnostics Tools>Diagnostics

Setting auto call back options Program>Setup>Auto callback

Setting customer account options View>Customers>Account options

Setting the country and language Program>Setup>Country/Language

Setting the download access Advanced>Download options

Setting the format overrides Advanced>Format overrides

Setting the outputs Advanced>Auxiliary outputs

Setting the TCP/IP settings Program>Setup>TCP/IP Settings

Setting the timed functions Advanced>Timed functions

Setting the zone type Advanced>Zone types

Setting up a customer record View>Customers>Single customer

Setting up a modem Program>Setup>Modem setup

Setting up answering machine defeat Program>Setup>AMD setup

Specifying the direct connect settings Program>Setup>Direct connect settings

Specifying the serial port settings Advanced>Serial port settings

Switching operators Program>Next operator

Uninstalling the software Start>Settings>Control Panel

Uploading Download>Read all

Viewing a customer record list View>Customers>List

Viewing an operator list Program>Setup>Add/Change operators

Table 18-2: UDx75 menu paths

Task UDx75 menu option
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Viewing the auto answer failures View>Customers>Auto answer failures

Viewing the control panel settings View>Control panel

Viewing the event log Download>Event log>Read entire log

Viewing the keypad status View>Keypad status

Table 18-2: UDx75 menu paths

Task UDx75 menu option
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Chapter 1: Appendices

1.1 Appendix 1: Reporting fixed codes in Contact ID or SIA
Table 1-1: Event codes lists the event codes sent for different reports (if enabled) when using Contact ID or 
SIA formats. The numbers in brackets following the event is the number that is reported as the zone number. If 
there are no parentheses, the zone is 0. An asterisk represents the first character from the event code of the zone 
that is bypassed or in trouble.

Table 1-1: Event codes

Report Contact ID SIA Report Contact ID SIA

Manual test 601 RX Keypad tamper 137 TA

Autotest 602 RP Keypad panic(audible) 120 PA

Open (user number) 401 OP Keypad panic (silent) 121 HA

Close (user number) 401 CL Duress 121 HA

Cancel (user number) 406 OC Keypad auxiliary 1 110 FA

Start program 627 LB Keypad auxiliary 2 100 MA

End program 628 LX RF sensor lost (zone number) 381 *T

Recent close (user number) 401 CR RF sensor restore (zone number) 381 *R

Exit error (user number) 457 EE Sensor low battery (zone number) 384 XT

Event log full 605 JL Sensor battery restore (zone number) 384 XR

Fail to communicate 354 RT Zone trouble (zone number) 380 *T

Expander trouble (device number) 333 ET Zone trouble restore (zone number) 380 *R

Expander restore (device number) 333 ER Zone tamper (zone number) 137 TA

Telephone fault 351 LT Zone tamper restore (zone number) 137 TR

Telephone restore 351 LR Zone bypass (zone number) 570 *B

Siren tamper (device number) 321 YA Bypass restore (zone number) 570 *U

Siren restore (device number) 321 YH Near Alarm (A/B Alarm) 138 BM

Aux power over current (device 
number)

312 YP Early open/late close 451 OK

Aux power restore (device number) 312 YQ Partial close 456 CF

Low battery (device number) 309 YT Zone activity fault 391 NA

Low battery restore (device number) 309 YR Zone activity restore 391 NS

Mains fail (device number) 301 AT Fail to close 454 CI

Mains restore (device number) 301 AR RF jamming 344 XQ

Box tamper (device number) 137 TA RF jamming restore 344 XH

Box tamper restore (device number) 137 TR Smoke detector clean me 393 YX
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1.2 Appendix 2: Overview of module numbers
Every keypad, expansion module and wireless receiver module has a module number. 

1.2.1 CS1700 door swipe module 

1.2.2 Keypads

Module Module number

CSx75 0

CS534 Two-way Listen-In 64

CS535 77

CS7002 78

CS7050 79

CS7501 76

Table 1-2: CS1700 module numbers

Learn-in sequence Module number   Learn-in sequence Module number

1 113   9 121

2 114   10 122

3 115   11 123

4 116   12 124

5 117   13 125

6 118   14 126

7 119   15 127

8 120

Table 1-3: Keypad module numbers

Keypad Part1 Part2 Part3 Part4 Part5 Part6 Part7 Part8

1 192 193 194 195 196 197 198 199

2 200 201 202 203 204 205 206 207

3 208 209 210 211 212 213 214 215

4 216 217 218 219 220 221 222 223

5 224 225 226 227 228 229 230 231

6 232 233 234 235 236 237 238 239

7 240 241 242 243 244 245 246 247

8 248 249 250 251 252 253 254 255
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1.3 Appendix 3: Communicator formats
One of several communicator formats can be used to transmit to the receiver connected to phone number 1. 
Consult the instructions for your central station receiver to determine which format is compatible. Table 1-4: 
Communicator formats lists the selectable communication formats. 

< 1.If you require a format other than those listed, set the override options in Communications>Format 
Override to build the appropriate format. In addition, select Format Override in Communications>Central 
Station>Phone Numbers>Phone Number n>Protocol.

< 2.The voice dialer protocol does not generate an FTC (failure to communicate).

1.4 Appendix 4: Service messages
The keypad displays service messages as a result of manual and automatic tests. Table 1-5: Service messages 
lists each message and outlines the action you should take to resolve the problem. When the keypad beeps due to 
a fault condition, press the # key to view the fault condition information.

Table 1-4: Communicator formats

# Format Description

1 Contact ID

2 SIA

3 SIA with area modifiers

4 Voice dialler with handshake and DTMF kiss-off

5 Reserved

6 4+2 with 1400/1900 double round parity

7 4+2 with 1400/1900 Checksum parity

8 4+2 with 2300/1800 double round parity

9 4+2 with 2300/1800 Checksum parity

10 Fast format 8 channel

11 Fast format 16 channel

12 Siren tone

13 Reserved

14 Reserved

15 Format over-rides (build your own format)

16 Reserved

17 200 Baud FSK (France Only)

18 200 Baud FSK Reversed (France Only)

19 XSIA

20 XSIA with area modifier 

21- 255 Reserved

Table 1-5: Service messages

Message Definition Action

Control 
Box Tamper

There has been interference with the control panel 
casing.

Ensure that the casing is mounted correctly on a flat surface and 
is not damaged. If there is no damage, close the casing securely.
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Control 
Fail to Comm.

The control panel tried to send a message to the 
central station but failed.

Ensure that the phone line is connected properly. Use a test 
phone to check that the phone service is available. Ensure that 
the central station phone number, account and protocol options 
are correct. 

Control 
Loss of Time

The control panel has had a total loss of power and 
the clock must be reset.

Reset the system clock and date. 

Control 
Low Battery

The standby battery for the control panel is low. The battery may need replacing. This may be a temporary 
condition caused by a long power failure. 

Control 
Over-Current

The control panel has detected an excessive amount 
of current being drawn from one of the outputs and 
has disabled the output as a means of protection.

Check the system for wiring faults. 
An overcurrent message can be reset only by triggering the siren 
correctly, for example, by generating a tamper on a zone that 
activates the sirens. This is a security feature to ensure that the 
overcurrent message has disappeared and the sirens can work 
properly again.

Control 
Phone Trouble

The phone line connected to the control panel is not 
working properly.

Ensure that the phone line is connected properly. Use a test 
phone to check proper service. 

Control 
Power Trouble

The mains power supply to the control panel is 
missing.

Reconnect the power supply and ensure it is working properly.

Control 
Siren Trouble

The connection to the control panel’s siren is broken. Repair the open circuit.

Expansion 
Aux. Comm. Fail

A reporting module tried to send a message to the 
central station but failed.

Ensure that the phone line is connected properly. Use a test 
phone to check that the phone service is available. Ensure that 
the central station phone number, account and protocol options 
are correct. Check that the module is connected and working. 

Expansion 
Box Tamper

There has been interference with the casing of an 
expansion module.

Ensure that the casing is not damaged and is mounted correctly 
on a flat surface. If there is no damage, close the casing 
securely.

Expansion 
Low Battery

The standby battery in an expansion module is low. The battery may need replacing. This may be a temporary 
condition caused by a long power failure.

Expansion
Over-Current

The expansion module has detected an excessive 
amount of current being drawn from one of its outputs 
and has disabled the output as a means of protection.

Check the module for wiring faults. 

Expansion
Power Trouble

The mains power supply is not connected to an 
expansion module power supply.

Reconnect the mains power supply and ensure it is working 
properly.

Expansion 
Siren Trouble

The connection to an expansion module’s siren is 
broken.  

Repair the open circuit.

Expansion
Trouble

An expansion module or keypad is not reporting to the 
control panel.

Ensure that the module is connected properly to the control 
panel.

Tamper
Zone X

There is a problem with the wiring. Check the zone and zone sensors for damage and repair any 
faults.

Zone Problem,
Press OK

There is a problem with a zone or zones. Press OK to 
identify the zone(s) and the problem condition.
One of the following messages is displayed when you 
press OK. 

CleanMe A specific smoke detector (for 
example, DP721) is dirty. The 
panel detects a degree of 
pollution in the chamber of the 
fire/smoke detectors. 

Clean the detection chamber of the smoke detector.

Table 1-5: Service messages

Message Definition Action
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Lost The system has not received 
RF sensor transmissions for a 
long period of time. Depending 
on how the system is 
programmed, this condition 
activates a service report. In 
addition, it may activate a 
tamper alarm if armed.

Ensure that the wireless zone module is receiving power and has 
not been tampered with. Repair any faults. 

Low Battery An RF sensor battery is low. Replace the battery.

Short Loss The system has not received 
RF sensor transmissions for a 
short period of time. This 
condition prevents arming.

Ensure that the wireless zone module is receiving power and has 
not been tampered with. Repair any faults.

Trouble There is a problem with the 
wiring.

Check the zone and zone sensors for damage and repair any 
faults.

Table 1-5: Service messages

Message Definition Action
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1.5 Appendix 5: Tasks summary

1.6 Appendix 6: Word library words

Table 1-6: System tasks

Task Installer Master user User No code Condition*

Adjusting the LCD contrast ¸

Answer an up/download call ¸ ¸ ¸

Arm and disarm the system 9* ¸ 9* If authority allows.

Bypass a zone 9* 9* 9* If authority allows.

Configure home automation devices ¸ ¸

Control home automation devices ¸ ¸ ¸ ¸

Engineer tamper reset ¸ 9* If enabled for master users.

Initiate an up/download call ¸ ¸ 9* If enabled for use without a 
code.

Perform a configured test ¸ ¸ ¸

Perform a service check ¸ ¸ ¸ ¸

Perform a walktest ¸

Program voice phone numbers ¸ ¸

Reset fire detector ¸ ¸ ¸ ¸

Set system date and time ¸

Set user authority level ¸

Set user codes ¸ ¸ 9* Only own code
All codes for master user.

Switch to multi-area mode ¸ ¸

View the alarm memory ¸ ¸ ¸ ¸

View the event log ¸ ¸

Table 1-7: Word library

Alarm Delay Exterior House Microwave Room Smoke Up

Area Den Fire Infrared Motion Rumpus Sound Utility

Audio Detector Front Instant North Safe South Vault

Back Dining Game Interior Nursery Sensor Stairs Warehouse

Bathroom Door Garage Junk Office Shock Storage West

Beam Down Glassbreak Kitchen Panic Shop Study Window

Bedroom Duress Guest Library Pantry Side Tamper Wing

Button East Hall Light Phone Skylight Television Wireless

Ceiling Emergency Heat Living PIR Sliding Trouble Yard

Closet Exit Holdup Master Porch Small TV Zone
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AMD B- 18- 1, B- 18- 3, B- 18- 4
Areas A- 2- 1
B
Backup reporting A- 6- 1
Binary entries A- 5- 2
C
Call back mode B- 9- 2
Central station B- 2- 8
Code

duress B- 2- 6
event C- 1- 1
installer B- 2- 6
system B- 2- 6

Command menu A- 5- 1
Communications B- 2- 7
Communicator formats C- 1- 3
Contact ID A- 2- 1, C- 1- 1
Control panel

communication B- 2- 7
inputs B- 2- 1
installing A- 4- 1
outputs B- 2- 4
reporting B- 2- 9
upload/download B- 2- 8
wiring A- 4- 17

Country code
default A- 1- 1

CS1700
badge functions B- 12- 3
cards B- 12- 4
enrolling B- 12- 2
installing B- 12- 1
X-10 functions B- 12- 4

CS175 A- 1- 1, A- 2- 1
wiring A- 4- 17

CS175M/CS275M/ CS575SM A- 4- 6
CS208/CS216 B- 6- 1

DIP switches B- 6- 1
installing B- 6- 1
specifications B- 6- 7
wiring B- 6- 3

CS208H B- 6- 4
DIP switches B- 6- 5
installing B- 6- 4
specifications B- 6- 7
wiring B- 6- 6

CS275 A- 1- 1, A- 2- 1, A- 4- 6
input and outputs A- 4- 18
wiring A- 4- 18

CS320
DIP switches B- 10- 2
enrolling B- 10- 3
installing B- 10- 1
outputs B- 10- 3
wiring B- 10- 2

CS375 A- 1- 1
wiring A- 4- 19

CS507
DIP switches B- 7- 2

installing B- 7- 1
outputs B- 7- 6
schedules B- 7- 6
users B- 7- 6
wiring B- 7- 2

CS534
control levels B- 9- 3
installing B- 9- 1
operation B- 9- 2
tones B- 9- 4
wiring B- 9- 2
X-10 devices B- 9- 6

CS535
installing B- 11- 1

CS5500
LCD keypad A- 1- 1, A- 2- 2
specifications B- 3- 7

CS575 A- 1- 1, A- 2- 1
input and outputs A- 4- 17, A- 4- 20
wiring A- 4- 19

CS575M/CS875M A- 4- 2
CS586

connecting B- 8- 1
memory transfer B- 8- 3
reading data B- 8- 3
upload/download B- 8- 3
writing data B- 8- 3

CS590 cable B- 18- 1
CS7002

installing B- 13- 2
LEDs B- 13- 3
reporting B- 13- 5
upload/download B- 13- 6
wiring B- 13- 3

CS7050
email reporting B- 15- 4
installing B- 15- 1
LEDs B- 15- 2
TCP/IP reporting B- 15- 4
wiring B- 15- 2

CS7501
installing B- 16- 1
LEDs B- 16- 2
mounting B- 16- 2
reporting B- 16- 7
upload/download B- 16- 9
wiring B- 16- 6

CS875 A- 1- 1, A- 2- 1
input and outputs A- 4- 20
wiring A- 4- 19

CSx75 versions A- 2- 1
D
DB-9 connector B- 18- 1
Default codes

country codes A- 1- 1
Defaulting modules B- 1- 1
DIP switches

CS208/CS216 B- 6- 1
CS208H B- 6- 5
CS320 B- 10- 2
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CS507 B- 7- 2
general A- 3- 2
RF433 B- 5- 2
RF868 B- 5- 4

Downloading B- 18- 2
Dual reporting A- 6- 2
Duress code B- 2- 6
E
Editing text A- 5- 3
Editors A- 5- 2
Email reporting B- 15- 4
Enrolling modules B- 1- 1
Event

codes C- 1- 1
description B- 17- 1
list B- 17- 2

Event log B- 17- 1, B- 18- 3, B- 18- 4, B- 18- 5
events B- 17- 1, B- 17- 2

Exit prompt A- 5- 3, B- 5- 7
F
Fire detectors

wiring A- 4- 13
G
GPRS reporting B- 13- 5
H
Handshake B- 11- 3
Home automation B- 2- 12
Housing

large metal A- 4- 2
polycarbonate A- 4- 4
small metal A- 4- 6

I
Input expander zones B- 6- 6
Inputs and outputs

CS175 A- 4- 17
CS275 A- 4- 18
CS575 A- 4- 17, A- 4- 20
CS875 A- 4- 20

Installer
code B- 2- 6
message A- 5- 5

Internal siren B- 2- 5
ISDN

reporting B- 16- 7
K
Keypad

installing A- 4- 8
multidrop network A- 4- 9
number B- 3- 3
partition B- 3- 3
sounder B- 2- 6
star and multidrop network A- 4- 10
star network A- 4- 9
wiring A- 4- 8

Keypad LEDs
fire A- 1- 2
power A- 1- 2
ready A- 1- 2

Keypads
copying settings B- 3- 2
maximum number of A- 2- 1
programming B- 3- 1, B- 4- 1

Keys
function keys A- 1- 2
navigation keys A- 1- 3

Keyswitch zones B- 3- 7
Kissoff B- 11- 3
L
LED keypads A- 1- 3

specifications B- 3- 6
Line hold mode B- 9- 2
M
Module numbers C- 1- 2
Multi-area mode B- 3- 2
N
Navigating menus A- 5- 1
Numeric entries A- 5- 2
O
Output events

CS320 B- 10- 4
CS507 B- 7- 5

Output expander B- 7- 1
Outputs A- 2- 1

wiring A- 4- 16
P
Partition

settings B- 2- 9
timers B- 2- 9

Partitions
maximum number of A- 2- 1

Phone
numbers A- 5- 3
prefixes A- 5- 3

Power connection A- 3- 1
Program log B- 18- 3
Programming mode A- 5- 1
Proximity card reader B- 12- 1
R
Report

formats A- 2- 1
Reporting A- 6- 1

backup A- 6- 1
control panel B- 2- 7, B- 2- 9
dual A- 6- 2
formats A- 6- 1
primary reports B- 13- 5
split A- 6- 2
voice B- 11- 2

RF receivers B- 5- 1
RF sensors B- 5- 7

deleting B- 5- 8
RF300W8 A- 2- 5
RF352I4 A- 2- 4
RF354W8 A- 2- 4
RF425I4 A- 2- 5
RF425W8 A- 2- 5
RF433

DIP switches B- 5- 2
installing B- 5- 2
LEDs B- 5- 3
specifications B- 5- 11
testing B- 5- 8
wiring B- 5- 2

RF620I4 A- 2- 5
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RF868
DIP switches B- 5- 4
installing B- 5- 3
LEDs B- 5- 5
specifications B- 5- 11
testing B- 5- 8
wiring B- 5- 4

RS232 serial port B- 18- 1
RSSI

testing B- 13- 4
RX16I4CA-pcb A- 2- 4, B- 5- 1
RX16W8CA-pcb A- 2- 4, B- 5- 1
RX32W8CA-pcb B- 5- 1
RX48I4CA-pcb B- 5- 1
RX8I4CA-pcb A- 2- 4, B- 5- 1
RX8W8CA-pcb A- 2- 4, B- 5- 1
S
Schedules B- 2- 11

CS507 B- 7- 6
Selection lists A- 5- 2
Service messages C- 1- 3
SIA A- 2- 1, C- 1- 1
SIM card

enrolling B- 13- 2
inserting B- 13- 3

Sounders A- 2- 1
EOL protection A- 4- 11
wiring A- 4- 11

Split reporting A- 6- 2
Supervision B- 5- 7
Swinger shutdown B- 2- 3
System

autotest B- 2- 8
codes B- 2- 6
settings B- 2- 10
tasks C- 1- 6

timers B- 2- 11
T
TCP/IP reporting B- 15- 4
Text editor A- 5- 3
U
UDx75 B- 2- 8, B- 15- 3, B- 18- 1, B- 18- 3
Upload/download B- 18- 1

settings B- 18- 2
Uploading B- 18- 2, B- 18- 4
User codes A- 2- 1
User interface language A- 5- 1, B- 3- 2
V
Voice messages

playing B- 11- 3
recording B- 11- 2

Voice reporting B- 11- 2
W
Wiring

control panel A- 3- 1
dual A- 4- 1
single A- 4- 1
zones A- 4- 1

Word library A- 5- 4, C- 1- 6
X
X-10 devices B- 3- 2

CS534 B- 9- 6
Z
Zone

definition B- 2- 2
settings B- 2- 2
type B- 2- 3

Zones
maximum number of A- 2- 1
modifying B- 2- 3
wiring A- 4- 1




